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ROLE OF SELF INSTRUCTIONAL   MATERIAL INDISTANCELEARNING 

 

The need to plan effective instruction is imperative for a  

Successful distance teaching repertoire. This is due to the fact that the instructional designer, 

the tutor, the author (s) and the student are often separated by distance and may never meet in 

person. This is an increasingly common scenario in distance education instruction. As much 

as possible, teaching by distance should stimulate the student’s intellectual 

Involvement and contain all the necessary learning instructional activities ties that are capable 

of guiding the student through the course objectives. Therefore, the course / self-instructional 

material are completely equipped with everything that the syllabus prescribes. 

To ensure effective instruction, a number of instructional design ideas are used and these help 

students to acquire knowledge, intellectual skills, motor skills and necessary attitudinal 

changes.  In this respect, 

Students ‘assessment and course evaluation are incorporated in the text. 

The nature of instructional activities used in distance education self- instructional materials 

depends on the domain of learning that they reinforce in the text, that is, the cognitive, 

psychomotor and affective. These are further interpreted in the acquisition of knowledge, 

intellectual skills and motor skills. Students may be encouraged to gain, apply and 

communicate (orally or in writing) the knowledge acquired. Intellectual- skills objectives may 

be met by designing instructions that make 

use of students’ prior knowledge and experiences in the discourse as the foundation on which 

newly acquired knowledge is built. 

The provision of exercises in the form of assignments, projects and tutorial feedback is 

necessary. Instructional activities that teach motor skills need to be graphically demonstrated 

and the correct practices pros vided during tutorials. Instructional activities for inculcating 

change in attitude and behavior should create interest and demonstrate need and benefits 

gained by adopting the required change. Information on the adoption and procedures for 

practice of new attitudes may then be introduced. 



 

 

 

 

Teaching and learning at a distance eliminates interactive  

Communication clues, such as pauses, intonation and gestures, associated with the face-to-

face method of teaching. This is particularly so with the exclusive use of print media. 

Instructional activities built into the instructional repertoire provide this missing 

interaction between the student and the teacher. Therefore, the use of instructional 

activities to affect better distance teaching is not optional, but mandatory. 

Our team of successful writers and authors has tried to r e d u c e  

This. Divide and to bring this Self Instructional Material as the b e s t  

teaching and communication tool. Instructional activities are varied in order to assess the 

different facets of the domains of learning. 

Distance education teaching repertoire involves extensive use of self- instructional 

materials, be they print or otherwise. These materials are designed to achieve certain pre-

determined learning outcomes, namely goals and objectives that are contained in an 

instructional plan. Since the teaching process is affected over a distance, there is need to 

ensure that students actively participate in their learning by performing specific tasks that 

help them to understand the relevant concepts.  

Therefore, a set of exercises is built into the teaching repertoire in order to link what 

students and tutors do in the framework of the course outline. 

These could be in the form of students ‘assignments, a research project 

or a science practical exercise. Examples of instructional activities in distance education 

are too numerous to list. Instructional activities, when used in this context, help to 

motivate students, guide and measure students’ performance (continuous assessment) 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

PREFACE 
 

 

We have put in lots of hard work to make this book as user-friendly as possible, but we have 

not sacrificed quality. Experts were involved in preparing the materials. However, 

concepts are explained in easy language for you. We have included many tables and 

examples for easy understanding. 

We sincerely hope this book will help you in every way you 

Expect. 

All the best for your studies from our team! 

 

 

 

 

 

 

All the best for your studies from our team! 
  



 

 

 
 
 
 
 

Unit 1 INTRODUCTION, MAYA INTERFACE 
 

 

Learning Outcome 

 

After going through this unit, you will learn: 
 

• Understanding 
 

What is AUTODESK MAYA? 
 

Feature of Maya 
 

Pipeline  
 
 
 
 
 
 
 
 

 

Time Required to Complete the unit 
 

 

The time required to study thus Unit is broken as follows 
 

1. 1
st

 Reading: It will need 2 Hrs for reading a unit 
 
2. 2

nd
 Reading with understanding: It will need 3 Hrs for reading and understanding a unit 

 
3. Self Assessment: It will need 3 Hrs for reading and understanding a unit 
 
4. Revision and Further Reading: It is continuous process  
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About Maya 

 

Introduction to the Maya interface 

 

The Maya Workspace 

 

1.5 File > Project 

 

To save Your Maya Scene 

 

Importing, exporting, and referencing. 

 

1.6 File> Import 

 

1.7 File > Export All 

 

1.8 File > Export Selection 

 

1.9 File > Create Reference 

 

1.10 Help > Maya Help 

 

1.11 Think about sets and props 



 

 

 
1.12 Summary 

 

1.13 Self Assessment Test 

 

1.14 Further Reading  
 
 
 
 
 
 

 

1.1 Introduction 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Autodesk Maya ,commonly shortened to Maya, is 3D computer graphics software that runs 

on Microsoft Windows, Mac OS and Linux, originally developed by Alias Systems 

Corporation (formerly Alias|Wavefront) and currently owned and developed by Autodesk, 

Inc. It is used to create interactive 3D applications, including video games, animated film, TV 

series, or visual effects/ MEL . 
 
 
 

 

1.2  Explain different features of Maya 
 

Autodesk® Maya® 2013 software delivers practical toolsets to help create and maintain the 

modern, open pipelines you need to address today’s challenging 3D animation, visual 



 

 

effects, game development, and post production projects. Powerful new toolsets for 

dynamic simulation, animation, and rendering offer new levels of creativity, while everyday 

productivity enhancements help you finish faster. In addition, the Open Data initiative 

introduced in Maya 2013 offers tools to help facilitate parallel workflows and better 

complexity handling. 

 

 

1.3 Difference between 2d and 3d 
 

2D is an image drawn in the X, and Y dimensions. 3D is an image drawn in the X, Y, and Z 

dimensions Concept of Computer Graphics and 3d 
 

In this chapter you will learn about the stages of production and the CGProduction pipeline. 
 

1.The Stages of Production: 
 

The CG Animation industry’s pipeline consists of three broad stages: 
 

Preproduction, Production and Post Production. 
 

In film, preproduction is the process in which the script and storyboard are 

written,costumes and sets are designed and built, actors are cast and rehearsed, a crew is 

hired, and the equipment is rented and setup.In production phase, scenes are taped or 

filmed in the most efficient order. Postproduction describes everything that happens 

afterward: the scenes are edited into story; a music score, sound effects, and additional 

dialogues are added; special visual effects may also be added. Although the work performed 

at each stage is radically different, this is useful framework for understanding the process of 

CG as well. 

 

Preproduction



 

 

Preproduction for CG animation means gathering reference materials, motion tests, layout 

drawings, model sketches, and such together to make the actual CG production as 

straightforward as possible. Because the CG artist is responsible for defining his or her 3d 

scenes from the ground up, its essential to have a perfect plan of attack for a well‐organized 

production. The more time spent planning and organizing for CG, the better. Whether you 

are working on a small job or a complex film, entering into production without a good plan 

of attack is not going to cause you trouble, but it will stunt the growth of your project. There 

are several parts in preproduction which you have to consider very well. 

 

The Script 

 

To tell a story, CG or not, you should put it in words. A story doesn’t need to contain 

dialogue for it to benefit from a script. Even abstract animations benefit from highly detailed 

explanation of timing and colors laid out in a script. The Script serves as the initial blueprint 

for the animation, a place where you layout the all important intent. 

 

The story board 

 

The story board is a further definition of the script. Even a ruff storyboard with stick figures 

on notebook paper will be useful for production. You break the script into scenes, and then 

you break those scenes into shots. Then you sketch out each shot in a panel of a story 

board. The panels are laid out in order according to the script to give a visual and linear 

explanation of the story. Storyboards are useful for planning camera angles, position of 

characters, lighting, moods, and so on. 

 

The conceptual art 

 

Conceptual are the design elements that you might need for CG production. Typically, 

characters are drawn into character sheets in three different neutral poses: from the front, 

from the side, and from the angle called ¾ views. You can also create a color art for the 

various sets, props, and characters to better visualize the colors, textures, and lighting that 

will be needed. 

 

Production 

 

Production begins when you start creating models from the boards, model sheets, and 

concept arts. You model the characters, the sets, and the props, and assign textures (colors 

and patterns). The animators take the models and animate everything according to the 



 

 

boards and scripts. The sequences are rendered in low quality for dailies and checked for 

accuracy and content. A CG production phase can involve a variety of steps. The specific 

steps are defined by the needs of the production. Most of CG techniques you will learn from 
 

this book are a part of production phase. We will pear into 3d workflow in the next lesions, 

but to make a long story for short, 3d scenes are created, lit and animated in the production 

phase. 

 

 

Post Production 

 

Once all the scenes have been setup with the props and characters and everything is 

animated, postproduction can begin. Post production for CG project is similar to 

postproduction for a film. This is where all of CG film’s elements are brought to gather and 

assembled into final form. 

 

Rendering 

 

All CG scenes need to be rendered into their final image or movie files. Rendering is the 

process by which the computer calculates how everything in the scene should look and 

display it. Rendering makes great processing demands on your computer, usually requiring 

the 
 

full attention of your PC, and it can take a good amount of time. You can render one scene is 

in production, but ordering a computer that is rendering to multitask is not advisable unless 

you are using a dual‐processor machine with plenty of memory. When everything is 

rendered properly, the final images are sorted out and assembly of the CG project begins. 

Rendering is discussed more in rendering chapter. 
 

We will take a quick look at three more post production activities: compositing, editing and 

adding sounds. Compositing 

 

CG is rendered in different layers and segments and needs to be put back together. In an 

particular scene, for example multiple character interact. Each character is rendered 

separately from the others and from the backgrounds. They are then put together in



 

 

compositing, the process of bringing to gather scene elements that ware created separately, 

to form the final scene. Maya makes this process easier with 
 

Render Layers, which you will learn in rendering chapter. Composting programs such as 

Shake and After Effects not only allow you to 
 

 

compose CG elements together, they also give you some additional control over color, 

timing and host of other additions that you can make to the scene. Professionals consider it 

an integral part of CG creation. 
 

Editing 

 

The rendered and composited CG footage is collected and edited together to conform the 

script and boards. Some scenes are cut or are move around to heighten the story. This is 

essentially the same process as in film editing, with one big difference: the amount of 

footage. 
 

Because creating CG is, on average, more time‐consuming and expensive then shooting live‐

action, scenes and shots are often tightly arranged in preproduction boards so not much 

bandwidth is wasted. The entire production is edited with great care before hand, and the 

scenes are built and animated to match the story, almost down to the frame. Consequently, 

the physical editing process consists mostly of 
 

assembling the scene into the sequence of the story. This is also why a good preproduction 

process is important. When you plan out what you want to get, you are much more likely to 

get it. 
 

Sound 

 

Sound design is important to CG because viewers like to associate visual with audio. A basic 

soundtrack can add a significant punch to a simple animated by helping provide realism, 

mood, narrative, and so on, adding a greater impact to the CG. Sound effect such as foot 

steps are added to much the action on screen; this type of sound is also known in film as 

foley sound. Music is scored and added to match the 

 

film. Quite often, the dialogue or musical score inspires a character’s actions or body 

language. Again, this is much the same procedure as in film, with one exception. In the 

event that a CG project requires a dialogue, the dialogue must be recorded and edited 



 

 

before CG production can begin. Dialogue is a part of preproduction phase as well as a 

component of post production. This is because animators need to hear the dialogue being 

spoken so they can coordinate the lip movements of the character speaking, a process 

known as lip‐sync. 

 

CG Production Pipeline 

 

Because of the nature of the CG and how scenes must be built, a specific pipeline works 

best. Modeling almost always begins the process, which then lead into texturing and then 

animation (or animation then texturing). Lighting should follow, with rendering pulling up 

the rear, as it must. Of course the process is not completely linear, you will often go back 

and forth adjusting models, lights, and textures throughout the process. This book 

presenting all the major Maya operations in the same order you will use in real world CG 

project. 

 

Modeling 

 

Modeling is usually the first step in creating CG. You most often start a CG scene by creating 

the objects you need to occupy your space. It can end up taking majority of the time in your 

process. There are many modeling techniques that Maya provides. The choices are among 
 

polygon modeling, NURBS Modeling, and the third method that combined elements of first 

two, subdivision surface modeling.Having a good idea of your whole story via a storyboard 

helps a great deal when you are figuring out how to proceed with the modeling. Knowing 

how an object is used in a scene gives you its criteria for modeling. You never want to spend 

more time on a model than needed. Creating a highly detailed model for far‐away shot will 

waste your time and expand your rendering times. 

 

 

Character Modeling 
 

Character modeling usually involves organic form such as animals, humans, aliens, and such 

as. Practically anything that is animated and portrays a character in a scene can be referred 

to as a character model. Your need to create these with animation techniques in mind, as 

well as accuracy of form. Some organic characters are built with patches of surfaces stitched 

to gather or as a single object



 

 

that is starched and pulled into shape. Character models need to look seamless because 

most character animation requires the model to deform in some 
 

way to bend and wrap at certain areas such as the joints. 
 

 

Architectural and Environment Modeling 
 

Architectural and environment modeling includes the architectural previsualization for the 

design of buildings as well as the generation of the backgrounds for sets and environments. 

Typically it involves modeling buildings or interiors as well as mountains or anything that 

you required for scenery, such as benches, chairs, and so on.You should not create 

incredibly detailed environments, especially environments 
 
that use a lot of geometry, if they are not featured in a shot. The greater the amount of 

geometry, the slower your computer will run and the longer rendering will take. You can 

create a good deal of the environment using clever textures on simple geometry. Detailed 

maps on bare surfaces are used frequently for game environments. 
 

Props Modeling 
 

Props modeling covers almost everything else needed in the scene. In theater and film 

terms, a prop is an object used by a character in the action; anything relegated to the 

scenery or background is a scenic. For example, a prop can be a purse a character is 

carrying, a leash on an animated dog, or a car a character is driving. If the car or purse were 

just sittinin the background, it would be considered a scenic. 
 

Texturing 
 

Once the models are complete, it’s a good idea to begin texturing and shading, the process 

of applying colors and textures to an object to make it renderable. When you create an 

object in Maya, for example, a simple gray default shader is automatically assigned to it that 

will let you see the object when you light and render the scene. Because the textures may 

look different after animating and lighting the scene, it’s wise to leave the final adjustments 

for later. 
 

Animation 
 

Although modeling can take the biggest part of a CG artist’s time, you can really make or 

break your scene with its animation. To animate something properly, you might need quite 

a lot of setup beyond just modeling. Depending on the kind of animating you’ll be doing, 

you might need to set up the models for however you’ll be animating them. For example, 



 

 

for character animation you will need to create and attach an armature, or skeleton, to 

manipulate to make the character move, like a puppet, and do your bidding. 
 

Lighting 
 

CG is fundamentally all about light. Manipulating how light is created and reflected is what 

you’re doing with CG. Without light we would not see anything, so it makes sense that 

simulating light is the most influential step in CG. Lighting can drastically alter the look of 

your scene; it greatly affects the believability of your models and textures and creates and 

heightens mood. Although you can set up some initial lights during the texturing of the 

scene, the serious lighting should be the last thing you do, aside from changes and tweaks. 

The 
 

type and number of lights you use in a scene greatly affect not just the look of your scene, 

but also the amount of time the scene takes to render. Virtual lights in Maya are similar to 

lights used in the real world, from a single point of light such as a bulb to directed beams 

such as spotlights. 
 

Rendering 

 

At this stage, your computer takes your scene and makes all the computations it needs to 

create raster images for your movie. Rendering time depends on how much geometry is 

used in the scene, as well as on the number of lights, the size of your textures, and the 

quality and size of your output. The more efficient your scene, the better the render times 

will be. 

 

1.4 Maya interface 

 

A tour of Maya Interface 

 

In this chapter you will learn and explore the Maya interface.

 

Fig: Maya user interface:



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

This chapter is a look at how to access functions and a fairly complete rundown of the often‐

used windows in Maya to get you familiar with their workings. 

 

The Title Bar 

 

The title bar displays the Maya version number, the name of the scene you are working on, 

and the name of any object you have selected. It also includes standard Minimize, Maximize 

and Close Buttons. 

 

The Menu Selector 

 

The menu bar lets you quickly access numerous functions in Maya via pull‐down menus. The 

contents of each pull‐down menu give you access to related tools, commands, and settings, 

and, when available, the menu lists the keyboard shortcuts for executing tools or 

commands. Because Maya has so many menus, they won’t all fit in a single‐row menu bar. 

The Maya interface solves this space problem by partitioning menus in menu sets. A menu 

set is divided up based on tools and commands related to a particular 

 

workflow. 

 

There are five menu sets available in Maya Complete: Animation, Polygons, Surfaces, 

Dynamics, and Rendering. Maya Unlimited has one additional menu set for Cloth. You can 

access these menu sets from the menu selector’s drop‐down list on the status line, as 



 

 

shown in the illustration. After you have selected a menu set, you will notice that some of 

the options in the menu bar will change according to the set you chose. 

 

Hot Keys for Accessing Menu Sets 

 

Hot Keys Menu set 

 

F2 Animation 

 

F3 Polygon 

 

F4 Surfaces 

 

F5 Dynamics 

 

F6 Rendering 

 

You can also choose a menu set by pressing the H key while you hold down the left mouse 

button in the view window. A marking menu will appear, containing each menu set, 

Regardless of the menu sets you’re using, the File, Edit, Modify, Create, Display, Window, 

and Help menu options will always appear in the menu bar. These items are not specific to 

any particular workflow. Instead, they give you access to many of the common editing 

commands found in most software packages (such as Cut, Copy, Paste, Save, and Close) and 

allow you to create new objects (the Create menu), modify these objects (the Modify 

menu), access different windows (the Window menu), and choose how objects are 

displayed in the view window (the Display menu). 

 

View Compass



 

 

The View Compass, lets you switch your view in the active panel. A panel, of course, is one 

of the working views in Maya; the workspace is shown through the panels in Maya’s UI. By 

clicking one of the compass’s axes, represented by the cyan, red, green, and blue cones, you 

can quickly change the active view to an orthographic view. Clicking the cyan cube at the 

heart of the View Compass returns you to your perspective view. 

 

Tear‐Off Menus 

 

At the top of every menu is a double line. Clicking the double line allows you to tear off the 

menu and place it as a toolbox anywhere on your screen (or screens if you have dual 

displays enabled). These tear‐off menus are also called floating menus. Creating a tear‐ off 

menu makes accessing menu commands easier, especially when you need to use the same 

command repeatedly. Let’s say, for example, that you need to create multiple polygonal 

spheres. You can tear off the Create Polygonal Primitives menu and place it at the edge of 

your screen. You can then click the Sphere command as many times as you need without 

opening the dual‐layered menu every time. 

 

Tools and Commands 

 

Tools and commands (also called actions) are two different things in Maya. As you browse 

though Maya’s menus, you’ll notice that some of the items listed include the word tool and 

others do not. The differences between a tool and a command are subtle. For example, the 

Create menu includes a tool called the CV Curve tool.When the tool is selected from the 

menu, Maya enters a mode in which that tool is active. In the case of the CV Curve tool, a 

control vertex is created each time you click your mouse button in the view window. To 

finish using the tool, you must press the ENTER (RETURN) key. 

 

A command, on the other hand, can require some sort of input before it can be selected 

from a menu. The Edit | Duplicate command is a good example. Before you can select the 

Duplicate command from the Edit menu, you first must select an object or objects that you 

wish to duplicate. After the selections have been made, you can choose the command from 

the Edit menu and it is executed. The result, of course, is a duplicate of the selected 

object(s), and that’s it the operation executed by the Duplicate command did its job and you 

can move on to your next task. Some commands don’t require any input—they simply 

create an object when they’re executed. For example, the Create | Locator command simply 

creates a locator. 



 

 

 

The Status Line 

 

The status line includes valuable tools you can use while you are working, such as selection 

masks, snapping modes, and a rendering button. We will explore some of these tools and 

buttons in the tutorial later in this chapter. We’ll use others throughout the book. Figure 2‐4 

shows arrangements of useful buttons on the status line. Probably the most widely used 

buttons on the status line are the selection modes and selection masks. The selection 

modes section gives you three different options for selecting objects in the view windows. 

From left to right, these are Select by Hierarchy, Select by Object Type, and Select by 

Component Type. Once one of these options is toggled on by clicking it on the status line, 

the selection masks section will update to display the relevant selection types for that 

mode. 

 

The Shelf 

 

The shelf, located under the status line, contains buttons for accessing your most frequently 

used commands and tools. Figure below shows the buttons and tabs located on the shelf. 

These buttons have been organized into tabs respective to specific workflows. Choosing a 

tab displays shelf items in that tab. By clicking a button on the shelf, you can execute 

commands or launch tools without having to choose them from a menu. As you become 

more experienced in Maya, you will no doubt want to customize your shelf with tools or 

commands that execute custom settings. 

 

The Toolbox 

 

The toolbox, shown in Figure, contains shortcuts to the most commonly used tools for all 

workflows. The first three tools in the toolbox are the basic selection tools. You can select 

an object in the view window by clicking the Selection tool and then clicking the object in 

the view window. To select multiple objects, you can either hold down the SHIFT key while 

clicking objects in the view window or choose the Lasso tool in the toolbox and drag a 

selection around all of the objects that you want included in your selection. When selecting 

components (sub‐objects of a shape), you can use the Paint Selection tool. This not only is 

useful for selecting multiple components at a time, but also keeps you from selecting 

components on the opposite side of the object you are



 

 

selecting from. The next four tools in the toolbox are called transform tools—the Move, 

Rotate, Scale, and Universal Manipulator tools. Figure shows a sphere that has been 

selected, and the Move tool is active. Notice that a transform manipulator appears at the 

sphere’s pivot point. Three arrows extend from the manipulator tool: one red, one green, 

and one blue. By clicking and dragging the red, green, or blue arrow, you can constrain the 

sphere’s movements to the X, Y, or Z axis, respectively. The Rotate and Scale tools have their 

own unique manipulators whose colors correspond to the same three axes. The Universal 

Manipulator displays a manipulator around the selected objects that gives you access to all 

three transform functions. 

 

The Workspace 

 

The Workspace is composed of one or more view panels used to access different parts of 

the user interface. By default, only one panel is displayed when you start up Maya. Figure 

below shows the Maya UI with three panels loaded: the Perspective view, the Hypergraph, 

and the Graph Editor. With all of these panels available, an animator can select objects in 

the Perspective view window or the Hypergraph and use the Perspective view, Graph Editor, 

and Channel Box to analyze or make edits to the animation data. 

 

The Channel Box 

 

The Channel Box, hown in Figure as below, lets you view, edit, and keyframe all of the 

keyable attributes on any node of the object that is selected. A keyable attribute is an 

attribute that a keyframe can set on to enable that attribute to be animated. You will soon 

learn that most nodes contain a lot more attributes than those displayed in the Channel 

Box. However, by default, only certain attributes are set up to be animatable. You can edit 

the values for the attributes in the Channel Box in two ways. You can click in the field 

containing the current value, type in a new value, and press ENTER (RETURN). Or you can 

click the attribute’s name in the Channel Box to highlight it, and then middle‐mouse button‐ 

drag (MMB‐drag from here on) anywhere in the view window. The value will change as if it 

were being controlled by an invisible or virtual slider. 

 

The Layer Editor 

 

Just below the Channel Box is the Layer EditorYou can use the Layer Editor to organize your 

scene by grouping objects into layers. Layering provides you with a quick and easy way to 



 

 

hide or show groups of objects by making a layer invisible or visible, or by making it 

renderable or unrenderable. What happens depends on whether the objects are grouped to 

a display layer or to a render layer. Click the Create New Layer button in the Layer Editor to 

create a new layer. Each layer is named and listed in the Layer Editor. Click the boxes to the 

left of the layer name to turn on or off the visibility of the layer (V) and to cycle through 

Selectable (the blank box), which makes the layer selectable, Template (T), in which the 

object can be seen as a wireframe and is not selectable, and Reference (R), in which the 

object can be seen as shaded and can be rendered but is not selectable. You can double‐

click a layer in this list to bring up that layer’s Properties window. This window lets you 

rename the layer and assign a color to it. When a color is assigned to a layer, the objects in 

that layer will display their wireframe in that color in the view window. This does not, 

however, have any effect on the rendered color of any object. 

 

The Time Slider and the Range Slider 

 

the Time Slider and the Range Slider, along with other controls located along the bottom of 

the Maya Workspace window. You can scrub through an animation by clicking and dragging 

the Time Slider along the timeline. To play the animation forward or in reverse, you can use 

the DVD‐like playback controls (the usual arrow buttons). You can set the total length of the 

animation by keying in the start and end times in their respective fields. The Range Slider 

sets the range of frames that will be displayed in the Time Slider. Use the Range Slider to 

limit how much of the total animation time you want to play back. This is especially helpful 

when you want to work on a small section of a longer animation. 

 

The Command Line and Script Editor Button 

 

You use the command line near the bottom of the Maya window, shown next, to type in 

Maya Embedded Language (MEL) commands. If you are more of a programmer type than an 

artist type, the command line is a real plus. You type the commands on the left side, and any 

error message or feedback is displayed at the right. The tiny box icon to the right of the 

feedback line is the Script Editor button, which lets you create and edit long MEL scripts. The 

Script Editor also shows all the errors and warnings for a particular piece of script.

 

The Help Line



 

 

The light‐gray bar across the bottom of the Maya window is the help line, shown next. If you 

move your mouse cursor around Maya’s user interface, the help line displays what each part 

of the interface does. When you use actions and tools, the help line tells you which tool you 

are using and what you should do next. 

 

The Hotbox 

 

If you hold down the SPACEBAR, the Hotbox will open The Hotbox is a group of menus that 

provides an easy‐to‐access interface that you can place anywhere on your screen. The 

Hotbox is highly customizable to meet your particular needs. You can click Hotbox Controls 

in the Hotbox and then choose Show All to show all the menus available in Maya at once. 

Because you can potentially access all of Maya’s tools and commands from the Hotbox, you 

could conceivably hide all of the other interface elements by choosing Display | UI Elements 

and disabling all of the checked items in that list. This means that you could display just the 

Workspace and nothing else. We won’t be doing that in this book, but if you are short on 

screen real estate, it might be helpful to hide your menus and anything else you don’t need 

and access them through the Hotbox instead. 

 

Set Up a Project 

 

A project is an assemblage of folders and subfolders that are set up on your hard drive to 

organize your Maya projects. It is likely that your Maya project will contain other files in 

addition to your Maya scene file, such as texture maps or cached animation data. It is 

therefore helpful for each project if you first set up a directory that contains subdirectories 

for all of the different elements the project includes. Fortunately, setting up this structure 

from Maya is easy in fact, Maya does it for you. 

 

Focus and Shade in the View Window 

 

You’ll often work with dozens, or even hundreds, of objects in a scene. Every time you want 

to adjust the view to move closer to, or focus on, one or more objects, you may find it 

cumbersome to use the Tumble, Track, or Dolly tool. Instead, you can use hot keys from the 

keyboard that let you focus on a selected object or group of objects. Focusing on objects will 

frame or fit them to the bounds of your view window. It also sets the camera’s center of 

interest at the center of the selectedobject or objects. This feature is especially helpful 



 

 

when you select the Tumble tool in the Perspective view, because this tool orbits the 

camera around this center point. 

 

The hot keys available for these focusing actions are listed and described here: 

 

HOT KEY FUNCTION 

 

F Focus on a selected object in a selected window. 

 

SHIFT‐F Focus on a selected object in all windows. 

 

A Focus on all objects in a selected window. 

 

SHIFT‐A Focus on all objects in all windows. 
 
 
 

 

Display Options 

 

So far, you have been viewing these objects in Wireframe mode. You can change the way a 

piece of geometry will display in a view window by setting the display options for that 

window. These options can be accessed via the View menu in the view window. You can also 

press a hotkey to choose a view mode, These display modes will activate your computer’s 

hardware shading engine built into your video card and let you view the objects in your 

scene as shaded; shaded and textured; and shaded, textured, and lit. 

 

HOT KEYMODE 

 

1 Rough, NURBS, and subdivision only 

 
2 Medium NURBS, and subdivision only 

 
3 Fine NURBS, and subdivision only

 

4 Wireframe



 

 

5 Smooth shade, default light 

 
6 Smooth shade with hardware texturing, default light 

 
7 Smooth shade with lighting, hardware rendering lights if you have created lights; 

otherwise objects shown in black These display options can also let you view certain types 

of geometry at different levels of detail. Both NURBS and subdivision surfaces, two of the 

three geometry types in Maya, are mathematical representations of surfaces. Spheres in 

rough, medium, fine, Wireframe, smooth shade, and texturing . 

 

Transform Objects 

 

To get you moving along faster, you should learn and use the hot keys to select the items in 

the toolbox. From now on, try to get in the habit of using the hot keys to access these tools, 

as shown below. 

 

HOT KEY 

 

TOOL 

 

Select tool 

 

W Move tool 

 
E Rotate tool 

 
R Scale tool 

 
T Manipulator tool 

 
Y Last used tool 

 
X Snap to Grid 

 

V Snap to Point 
 
 
 

 

Create a Group Node (NULL NODE) 

 

A group node is simply a transform node with no shape object associated with it. Often, 

objects are grouped together for organizational purposes—to keep similar things grouped 



 

 

together. In our planetary project, we will use grouping to give us an extra transform node 

with an extra pivot point. Short cut key is CTRL + G. 

 

Create a Hierarchy 

 

Object1 is a main object so that is called as root object, another object called object2 is 

parented to object1 and that is called child object so we can say that both objects are 

connected in Hierarchy manner. Root objects moves then child objects move and child 

objects move independently but when child moves the root object will not move. If we take 

an example of our solar system, the sun will be the root object, earth will be the child of the 

sun, and the moon will be the child of the earth to monitor this hierarchical relationship, we 

will view the hierarchy in the Hypergraph. 

 

The Outliner 

 

The Outliner, shown in Figure as per below, is another way of displaying all of the objects in 

a scene. The objects listed here show the hierarchies in a way that’s similar to that of a 

common Explorer (Windows) view used to browse file directory structures. To access the 

Outliner, choose Window | Outliner. To unfold a hierarchy, click the plus sign (+) icon to the 

left of the object’s name. If you want to view all of the branches and sub‐branches of a 

hierarchy, hold down the SHIFT key and click the plus sign. 

 

The Attribute Editor 

 

The Attribute Editor, shown in Figure as per below, displays all of the connected nodes and 

their material attributes for a selected object. Each tab represents arespective node and its 

attributes.One great aspect of the Attribute Editor is that it contains sliders, instead of text 

fields, that you can use to edit attributes—so you can see the effects of you rchanges. 

However, because it displays all



 

 

of the available attributes on any onenode, this may be more than you need to work with 

for your current process. For material editing, however, using the Attribute Editor is 

recommended. Short cut key is CTRL + A 

 

The Script Editor 

 

You access the Script Editor (see Figure below) by clicking the icon in the bottom‐ right 

corner of the screen at the end of the Command line or by choosing Window General 

Editors Script Editor. Since almost everything in Maya is built on MEL, every command you 

initiate generates some sort of MEL script or MEL argument. A history of these commands is 

available in the Script Editor. 

 

Customizing the Interface 

 

You’ve probably noticed that we’ve run into the same tools more than once as we’ve gone 

through the aspects of the user interface so far. Simply put, for everything you need to do in 

Maya, there are not only a few ways to do so, but at least a couple of ways to access the 

tools to do so.Most of Maya’s commands and tools can be found in at least two places. This 

may be confusing at first, but you’ll discover that in the long run it is most advantageous.It 

allows for the greatest flexibility in individual work flow and in part accounts for Maya are 

being easily customized.Once you are confident with your Maya know‐how, you’ll develop 

your own ideas about how to use all the other user interface methods to customize your 

work flow. You’ll want to return to this section when you’re ready to do some serious 

customization. To customize Maya, you use the Preferences window (choose Window 

Settings/Preferences) By now, you should have a good idea of how to navigate the basic 

Maya interface.While we haven’t shown you everything, you should have an idea of how to 

select nodes, edit their attributes, change the layout of the Workspace, use some hot keys, 

and access windows from the Window menu. Throughout the remainder of the book, we 

will explore all of these elements of the user interface in greater detail. 

 

1.5 File > Project 
 

To save Your Maya Scene 
 

Importing, exporting, and referencing. 
 



 

 

 
 

 

1.6 File > ImportSelect File > Import , to import the data from a file into the scene. 

In Import Option dialog box select the file type you are importing from the drop‐down list. If 

you aren’t sure what ty pe of file you are importing, you can select Best Guess. 
 

Depending on the file type you select, various file type specific options may be displayed. 
 

1.7 File > Export All 
 

n Export Option dialog  box select the file type from the drop down list. Default 
 

file type is mayaBinary. 
 

1.8 File > Export Selection 
 

1.9 File > Create Reference 
 

to reference the objects, animation etc. into a scene. In the Create Reference dialog  box set 
the options as per required when 
 

creating a file reference. 
 

1.10  Help > Maya Help 
 

The Maya Help is HTML‐based, desig ned by module, fully searchable and displayed in your 

computer web browser. The Maya Help is topic based and displays the major functionality 

categories for Maya. The Maya Help can assist you in finding reference information about 

particular topics, how to perform specific tasks, and MEL command references. Select Help 

> Maya Help to launch the Maya Help. 
 

1.11  Think about sets and props



 

 

1.12 Summary 
 

In this chapter we covered intro of Autodesk Maya and workflow. 
 

1.13 Self Assessment Test 
 

Broad Questions ‐ 
 

1. What is Attribute Editor? 
 
2. What is Hot Box? 
 

Short Notes 
 

1 Outlinear 
 
2 Shelf 
 
 
3 Story board 
 
4 Channel Box 
 
5 View Compass 
 
 
 
 

 

1.14 Further Reading 
 

1. Introducing Autodesk Maya 2013 Dariush Derakhshani 
 
2. Learning Autodesk Maya 2009 Foundation: Official Autodesk Training 
...Autodesk Maya Press, Marc‐André Guindon



 

 

 
 
 
 

 

UNIT 2 NAVIGATING AND CHANGING THE 
INTERFACE, PRIMITIVES 
 
 
 

 

Learning Outcome 
 

After going through this unit, you will learn: 
 

• Poly primitive 
 
• Nurbs Primitive 
 
• Transformation  
 
 
 
 
 
 
 
 
 

Time Required to Complete the unit 
 

 

The time required to study thus Unit is broken as follows 
 

1. 1
st

 Reading: It will need 2 Hrs for reading a unit 
 

2. 2
nd

 Reading with understanding: It will need 3 Hrs for reading and understanding a unit 
 
3. Self Assessment: It will need 3 Hrs for reading and understanding a unit 
 
4. Revision and Further Reading: It is continuous process  
 
 
 
 
 
 
 

 

Content Map 
 
 
 

 

2.1 Camera Tools 
 

2.2 View menu 
 

2.3 Window menu 



 

 

 

2.4 Display Menu 
 

2.5 View Ports Display 
 

2.6 Primitives 
 

Explain in brief all Four Primitive types 
 

2.7 NURBS Primitives, Polygon Primitives 
 

2.8 Subdiv Primitives, Volume Primitives 
 

2.9 Define and Differentiate NURBS and Polygons 
 

NURBS Primitives > 
 

Polygon primitives > 
 

Subdiv Primitives > 
 

2.10 Transforming objects and components 
 

2.11 NURBS & Polygon Objects Component and SubDiv Components 
 

2.12 Moving, rotating, and scaling objects 
 

2.13 The Tool Box : Select, Move, Rotate and Scale 
 

2.14 The Pivot Point



 

 

2.15 Duplication options 

2.16 The Channel Box 

2.17 Explain Construction history 

2.18 Edit > Delete by Type > History 

2.19 Selecting objects 

2.20 Selection modes and masks 

2.21 Using quick select sets 

2.22 Hiding and templating 

2.23 Layers – The Layer Panel 

2.24 Summary 

2.25 Self Assessment test 

2.26 Further Reading 

  

  
 
 
 
 
 

 

2.1 Camera Tools 
 

Dolly Tool 

 

The Dolly Tool gets its name from filmmaking where a camera, mounted on a wheeled tripod, 

is moved towards or away from the scene. In Maya, dolly allows you to view the items in your 

scene ei ther close up or from further back. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

To dolly the perspective view 

 

Enlarge the scene view to a single perspective view. 

 

Do one of the following: 

 

Press the Alt key and drag the mouse to the ri ght while holding down the right button on 

your mouse. To dolly the camera outwards from the subject in the scene you can perform the 

same key and mouse combinations as des cribed above but drag the mouse to the left. Dolly 

works in both the perspective and orthographic views. 

 

Tip: If you make an error when adjusting your camera view of the scene, you can reset the 
camera to its default home setti ng. To 
 

reset the camera view for a particular orthographic or perspective view: From the panel 
menu, select View > Default Home . 

 

Tumble Tool 

 

The Tumble Tool allows you to tumble or rotate the camera's view around a particular center 

of interest to achieve ei ther a higher or lower vantage point, or a different side angle.



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To tumble the perspective view 

 

Press the Alt key and drag the mouse either left or right, or up or down, while holding down 

the left button on your mouse. Tumbling the view revolves the camera around the center of 

the scene view, in whichever direction you drag (left, right, up or down). The Tumble Tool 

does not work in the orthographic views. 

 

Track Tool 

 

The Track Tool allows you to move the camera up, down, or sideways in relation to the 
scene.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To track the perspective view 

 

Press the Alt key and drag the mouse in any dire ction, while ho lding down the middle 

button on your mouse. The Tracking Tool works for both orthographic and perspective 

views. 

 



 

 

Note: Even though the objects appear to move across the screen when operating any of the 

camera tools, it is t he viewing camera that is actually moved in relation to the scene, not 

the objects. 

 

2.2  View Menu 

 

View > Select Camera 

 

Select the view’s related camera. It is us eful, if you want to edit the look‐at and camera up 
nodes related with the camera. 

 

View > Previous View 

 

Select Previous View or press [ to go back in the view history 

 

View > Next View 

 

Select Next View or press ] to go back in the view history 

 

View > Default Home 

 

To reset the active view panel 

 

View > Look At Selection 

 

To point the camera at the selected objects but don’t move the camera. 

 

View > Frame All 

 

Select Frame All or press a to show all the objects in an active view panels.



 

 

View > Frame Selection 

 

Select Frame Selection or press f to show selected objects in an active view 

 

panels. 

 

View > Predefined Bookmarks 

 

Bookmark is a way to mark a view for fu ture use, allowing you to keep a variety of camera 

views for a scene. There are four Predefined Bookmarks: Perspective, Front, Top and side. 

You can change the view in any of these Predefined Bookmarks. 

 

View > Bookmarks > Edit Bookmarks 

 

Bookmark the current view and create additional bookmarks of your own. You can also 

create a shelf button for a Bookmark by click Add to Shelf. 

 

View > Bookmarks 

 

Return to a Bookmarked view. 

 

View > Image Plane > Import Image 

 

To import a file to use an image plane and access the Image Plane’s attributes. 

 

2.3 Window Menu 
 

Window Menu provides access to various editors, panels and windows. Some of them are: 
 

Outliner 
 

The Outliner shows a hierarchical list of all objects in the scene in outline form. 
 

To show the Outliner select Windows > Outliner. 
 

Menus of outliner: 
 

Display 
 

DAG Objects Only: Only show transformable nodes. 
 

Shapes: Show shape nodes.  
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Attributes (Channels): Allow the display of attr ibutes on nodes. Use the round plus and 
minus buttons to show a node’s attributes. 
 

Set Members: Allow the display of members under the sets. 
 

Connected: Only show attributes that are connected another node, keyed, or connected by 

set driven key, a constraint, a motion path, or an expression. 

 

Reveal Selected: Expands the outline to show the currently selected node(s). 
 

Channel Names: Select what attribute names to show when Attributes (Channels) is on. 

Nice names are more readable. Long and Short names are the actual names of attributes, 

which you can use in expressions and MEL. 

 

Sort Order: Select Scene Hierarchy to show the hierarchy. Select Alphabetical Within Type 

to show flat alphabetical lists of each node type.



 

 

Select Set Members: Selects the members of the highlighted set. 
 

Show 
 

Objects: Select which object types to show in the Outliner. Select Clear Below to turn off all 
filters. 
 

Attributes : Select which attribute types to show in the Outliner. 
 

Hidden: Hidden attributes. 
 

Keyable : Keyable attributes. 
 

Scale, Rotate, Translate: Scale, Rotate, or Translate attributes. 
 

Driven by Anim Curve: Attributes with an animation curve. This includes attributes animated 

with keys, set driven keys, constraints, and motion paths. 

 

Driven by Expression: These are the attributes controlled by expressions. 
 

User Defined: User‐defined attributes. 
 

Invert Shown : Reverse the filters so visible objects are hidden and hidden objects are 
visible. 
 

Show All: Turns off all filters in the Show menu. 
 

Show Selected Type(s): Shows only object types of the same type as the current selection. 

This option lets you cr eate a filter that limits the types of objects and attributes displayed in 

the Outliner to the same type of object or attribute as the current selection. 

 

For example, if you select an object’s Translate X, Y, and Z attributes in the Outliner and 

then select Show Sele cted Type(s), then all non‐translation attributes will be f iltered and 

only translation attributes will appear in the Outliner. The Show Selected Type(s) f ilter will 

remain active unt il you select another Show menu option (such as Show All). 

 

Create Entry: Lets you save the current Show menu filter with a name. Create Entry is only 

available when the objects and attributes displayed in the Outliner have been filtered by the 

Show Selected Type(s) menu option. 

 

Delete Entry : Lets you delete a saved Show menu filter. 
 

Show Auxiliary Nodes : Shows node types that the Outliner normally does not show because 
they are rarely needed. 
 

Auxiliary Nodes: Lets you set what nodes are considered “auxiliary”. 
 



 

 

Attribute Editor Lists attributes on the selected object. Press Ctrl + a to open and close the 

attribute editor. Tabs across the top of th e Attribute Editor let you select nodes connected 

to the shown node. 

 

While the Channel Box provides a more compact view of keyable attributes, the Attribute 

Editor gives you full graphical controls to edit attributes rather than just text boxes. You can 

set an option in Window > Settings/Preferences > Preferences to have the Attribute Editor 

open in a window instead of the side panel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Menus in the attribute window/panel 
 

List 
 

Use this menu to load attributes into the Attribute Editor and to define which items display 
in the Selected/Object menu. 
 

Selected/Object 
 

The Selected menu lists objects currently selected in the scene while the Object menu 

displays all the objects in the scene of a selected type.



 

 

Focus 
 

This menu displays all no des that have been selected in the scene while the Attribute Editor 

is open. The most recently selected node is at the top of the list. 

 

Attributes 
 

Use this menu to add, edit, and delete extra attributes for an object or node. These appear 

under the Extra Attributes section. You can also add, edit, and delete attributes using the 

Modify menu. 

 

Context menu 
 

Output connection node 
 

If you set a key for the attribute or connect a texture to it, the resulting output connection 

node name displays as the first menu item. To load the attributes for this node into the 

Attribute Editor, select it. 

 

Create New Expression 
 

Select this option to create a new expression for the attribute. 
 

Set Key 
 

Select this option to set a key for the attribute. This option disappears from the menu if you 

have already connected a texture to the attribute. 

 

Set Driven Key 
 

Select this option to link the attribute values. 
 

Break Connection 
 

Select this option to break the connection between the attribute and a key or texture. 
 

Create New Texture 
 

Select this option to connect a texture to the attribute. 
 

Color Chooser 
 

This option displays for color attributes onl y. Select it to open the Color Chooser. 
 

Lock/Unlock Attribute 
 



 

 

Select the Lock option to lock an attribute value so that it cannot be changed. Use Unlock 
Attribute to unlock the value. 
 

Ignore/Don’t Ignore when Rendering This option displays only for attributes that are 
connected to keys or textures. 
 

Select the ‘Ignore when Rendering, option to ignore the connection when rendering. If the 

attribute has a map butt on, the button changes to indicate that the connection is ignored. 

Select the Don’t Ignore when Rendering option to render with the set connection. For 

details, see Rendering. 

 

Attribute Editor > Attributes > Add Attributes… 
 

New tab 
 

Attribute Name: Type the name of the attribute you are adding. 
 

Make Attribute Keyable: Turn this option on to make this attribute keyable. 
 

For information about keyable attributes, see Animation. 
 

Data Type : Select the data type for the attribute: 
 

Vector: Creates a vector attribute cons isting of three floating point values. 
 

Float: Creates a floating point attribute. 
 

Integer : Creates an integer attribute. 
 

Boolean : Creates an attribute consisting of an on/off turn. 
 

String : Creates a string attribute that accepts alphanumeric entries as data entry, such as a 
filename.



 

 

Enum : Creates an attribute that accepts selections from an “enumerated” or drop‐down 
list. 
 

Attribute Type 
 

Select a type: 
 

Scalar : Creates a per object attribute that you can set to a single value that applies to every 
particle in the object. A vector scalar is 
 

considered a single value with three numbers. If you select Scalar, you can specify Minimum, 

Maximum, and Default values for a Float or Integer attribute. 

 

Per Particle (Array): Creates a per particle attribute. You can set this type of attribute to 
different values for each particle. If you 
 

select Per Particle (Array), you can also create a counterpart initial state attribute by turning 
on Add Initial State Attribute. 
 

Add Initial State Attribute : Turn on to create a corresponding initial state attribute for t he 
added attribute. Without this 
 

corresponding attribute, you can’t save a particle object’s current attribute values for initial 
state usage. You must write a creation 
 

expression if you decide to initialize the custom attribute’s value upon rewinding the 

animation. If you know you’re going to write a creation expression for a custom a ttribute, 

you can set Add Initial State Attribute to off when you add the attribute. Otherwise, set Add 

Initial State Attribute to on wheneve r you add a custom per particle attribute. 

 

Numeric Attribute Properties: For scalar attri butes, Minimum and Maximum set the lowest 

and highest val ues you can enter for the attribute in the Attribute Editor or Channel Bo x. 

Default sets the default value for the attribute. 

 

Enum Names: When you're adding a new Enum attribute, you need to define the list of 

acceptable strings. There are two default strings, “Green” and “Blue”, in the Enum Names 

list that you can change. To change, select Green or Blue and then enter the new string in 

the New Name text box. To add a new string, click the blank entry below the last list item 

and type the string in the New Name text box. 

 

Note: Keywords must not be used as the Enum names. 
 

Window > View Arrangement, Saved Layouts Let you select a layout and layout/content s 
presets. These are the same as the 
 

layouts/presets available us ing the quick layout buttons or the Panel s menu in a panel. 



 

 

 

Quick Layout Buttons 
 

The quick layout buttons let you switch to one of a few common panel layouts quickly. 
 

Window > Save Current Layout 
 

This command will save the Maya’s current layout of panels. The saved layout will be 
available in saved layouts menu. 
 

Window > Frame All in All Views, Frame Selection in All Views Tracks and dollies all view 

panels to show all objects or the selected objects. To show all objects or the selected objects 

in a specific view panel, use the 

 

panel’s View menu. 
 

Window > Settings/Preferences > Preferences 
 

Shows the Maya Preferences window. The Preferences dialog box sets preferences for many 

functional element s of Maya, detailed in the following sections: 

 

• Interface preferences: 
 
o UI Elements preferences o Help preferences 

 
• Display preferences 
 

o Kinematics preferences 
 

o Animation (Display) preferences o Manipulators preferences 

o NURBS preferences o Polygons preferences



 

 

o Subdivs preferences 
 
• Settings preferences 
 
o Animation (Settings) preferences o Cameras preferences 

 
o Dynamics preferences 
 
o Files/Projects preferences o Modeling preferences 

 
o Rendering preferences o Selection preferences o Snapping preferences o Sound 

preferences 

 
o Timeline preferences o Undo preferences 

 
o Save Actions 
 
• Modules preferences 
 
• Application preferences 
 

Preferences > Interface > Menu set 
 

This determines which menu set displays in the main Maya menu bar on start‐up. The 

default is Animation Preferences > Setting >Time 

 

Sets the working time unit for animation. T he Time Slider displays time values in the unit 

chosen. You can specify the time unit as frames or as clock values. \ 

 

Frame selections include: 
 

• 15 fps 
 
• Film (24 fps) 
 
• PAL (25 fps) 
 
• NTSC (30 fps) 
 
• Show (48 fps) 
 
• PAL Field (50 fps) 
 
• NTSC Field (60 fps) 
 
• 2, 3, 4, 5, 6, 8, 10, 12, 16, 20, 40, 75, 80, 100, 120 , 125, 150, 200, 240, 250, 300, 375, 400, 

500, 600, 750, 1000, 1200, 1500, 2000, 3000, and 6000 frames per second. 



 

 

 
• Clock values include: 
 

o milliseconds o seconds 

 
o minutes o hours Preferences > Undo 

 
Undo: Select On if you want to be able to undo operations. This is the default.



 

 

Queue: Select Infinite to perform an unlimited number of undo operations. This option can 

use a lot of memory. Select Finite to limit the number of undo operations you can perform 

(specified in the Queue Size box). The default is Finite. 

 

Queue Size: If Finite is the selected Queue se tting, specify here the number of undo 

operations you can perform. The default is 50. Window > Settings/Preferences > Hotkey 

editor 

 

Lets you assign predefined commands, MEL scripts, or marking menus to keys and key 

combinations. Categories and Commands Maya includes a large number of usef ul pre‐

defined hotkey commands. You can 

 

use these commands instead of writing your own MEL script. Click a category in the 

Categories list to see the list of available pre‐ defined Commands in the category. Click a 

command in the Commands list to see its current hotkey(s) or assign it to 

 

a new key. 
 

Current hotkeys 
 

List box 
 

Shows all hotkeys that ac tive the selected command. 
 

Remove 
 

Select a hotkey and click Remove to unassign the hotkey. 
 

List All 
 

Opens a window listing every assigned hotkey and its command. 
 

Restore Defaults 
 

Returns all hotkey assignments to their “factory defaults”. 
 

Assign New Hotkey 
 

Key 
 



 

 

Type a keyboard symbol in the text box, or use the pull‐down list next to the text box to 

select ot her keys. If you type an upper‐case letter in the text box, Maya requi res you to 

type the letter with the shift key to activate the hotkey. Modifier 

 

Select a modifier to add to the key. 
 

Direction 
 

Select when the command activa tes: when you press the key down, or when you let the key 

back up (release). Add to Recent Commands List 

 

Select whether Maya should add the command to the Recent Commands list when you 

activate the hotkey. Edit area 

 

New: Create a new user‐defined command which you can then assign to a hotkey. 
 

Edit: Edit the selected user‐defined command in the Commands list. 
 

Delete: Delete the selected user‐defined command in the Commands list. 
 

Name: The name of the se lected command. 
 

Description: A description of the command’s purpose and effect. Category: The category in 
which the command appears. 
 

Command: The script that runs when t he command is activated. 
 

Accept: Click to save the command you are creating or editing. This button is only available 

after you click New or Edit to create or edit a command. 

 

Cancel: Click to cancel editing a command. This button is only available after you click New 
or Edit to create or edit a command. 
 

Search: Lets you search for text in the name or script of all defined commands. Use asterisks 
as wildcards.



 

 

Following are some unmapped keys: 
 

KL NOT UY9 ) ! @# 
 

$%^&*( F7 \;_|: 
 

" ? Home End 
 
 
 
 

Note: Hotkeys/Shortcuts in Maya are case sensitive. i.e. you can assign ‘z’ and ‘Z’ to two 

different commands. 

 

Window > Settings/Preferences > Shelf Editor 
 

The shelf editor provides a dialog bo x with which you can create and edit shelves. Shelves 

Click the Shelves tab to display existing shelves. From her e you can create, delete, and 

rename shelves and change their order. Shelf Contents 

 

Click the Shelf Contents tab to display the contents of a specific shelf. From here you can 

move and delete shelf items, change an item’s label and tooltip, as well as change its icon 

and icon name. 

 

Edit Commands 
 

Click the Edit Commands tab to view and edit the MEL code associated with a tool or action. 

 

Display Menu is a part of common menuset from where y ou can control the Visual 
elements of the Maya. 
 

Display > Grid 
 

Shows or hides the grid in all view panels. 
 

When the grid is visible, you can turn it off in an individual panel using the panel’s 
 

Show > Grid item. 
 

Gird Option dialog  gives following option 
 

Size 
 

You can change the size and length of the grid, set the number of subdivision lines, and the 
increment for the grid lines. 



 

 

 

• Length and width: Sets the number of units for the length and width of the grid. The 
default is 12 units. 
 
• Grid lines every: Displays a grid line every n units. The default is 5. 
 
• Subdivisions: Specifies the number of divisi ons between major grid lines. Setting the 

Subdivisions option to a value greater than 1 specifies that each main grid interval is subdivi 

ded by the amount spec ified. The default is 5. 

 
 
 
 
 

 

• Axes: Specifies a color for the X and Z axes on the grid. The default is dark grey. 
 
• Grid lines & numbers: Specifies a color for the grid lines and the grid line numbers. The 
default is light grey. 
 
• Subdivision lines: Specifies a color for the subdivision lines. The default is light grey. 
 

2.4 Display Menu 
 

You can turn on and off the display of grid elements, including axes, thicker lines for axes, 

grid lines, subdivisi on lines, and grid line numbers. 

 

• Axes: Turns on or off the display of the axes. The default is on. 
 
• Thicker line for axes : Turns on or off the display of thicker lines for the axes. The 
default is on. 
 
• Grid Lines : Turns on or off the display of t he grid lines. The default is on.



 

 

• Subdivision lines: Turns on or off the display of the subdivision lines. The default is 
on. 
 
• Perspective grid numbers: In the Perspective view, you can set the grid line 

numbers to display on the axes, along the edge of the grid, or just hide them. 

 
• Orthographic grid numbers: In the Orthographic views (top, side, front), you can 

set the grid line numbers to display on the axes, along the edge of the grid, or just hide 

them. 

 

The items in this menu control the visibility of various user interface elements, including the 

Status Line, the Shelf, the Time Slider, and so on. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• Hide UI Elements: Hide all UI parts so only the panels and menus are visible. 
 
• Show UI Elements : Show all UI parts. 
 
• Restore UI Elements: Restores the visibility of UI parts to their state before you selected 

Hide UI Elements. If certain pa rts were hidden before you selected Hide UI Elements, they 

will still be hidden. 

 

Display > Hide, Show 
 



 

 

Use Display > Hide to hide items you aren’t working on and reduce visual clutter. This is 

handy if you want to remove an object from the view, but do not want to delete it or move 

it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To redisplay items, use the Display > Show submenu, which includes the same 
 

selections as Display > Hide. 
 

The Hide/Show menu items are: 
 

Hide/Show Selection : Hides/Shows selected object(s).



 

 

Hide Unselected Objects/Show Last Hidden : Hides all unselected objects. To make them 

visible again use Display > Show > Show Last Hidden 

 

Hide Unselected CVs/All Surface CVs : To control the display of CVs, select the CVs that you 

want to remain visibl e, and then use Display > Hide > Hide Unselected CVs to hide all the 

other CVs on that surfac e. This affects the display of CVs in component sele ction mode, as 

well as CVs displayed in object selection mode by the use of Display > NURBS Components > 

CVs. To make hidden CVs visible again use Display > Show > All Surface CVs. 

 

All: Hides/Shows all objects, whether they are selected or not. 
 

Hide/Show Geometry: Displays a menu that lets y ou select the type of geometry you want 
to hide/show. 
 

Hide/Show Kinematics: Displays a menu that lets you select the type of kinematics you want 
to hide/show. 
 

Hide/Show Deformers : Displays a menu that lets you select the type of deformers you want 
to hide/show. 
 

Hide/Show Cloth: Hides/Shows cloth objects (Available only if you have Maya Unlimited). 
 

Lights: Hides/Shows lights. 
 

Cameras: Hides/Shows cameras. 
 

Texture Placements: Hides/Shows texture placements. 
 

Construction planes: Hides/Shows construction planes. 
 

Fluids, Hair Systems, Follicles, Fur : Hides/Shows fluids, hair systems, follicles, or fur. 
 

Animation Markers: Hides/Shows animation markers. 
 

Light Manipulators : Hides/Shows light manipulators. 
 

Camera Manipulators: Hides/Shows camera manipulators. 
 

Display > Wireframe Color 
 

Lets you set the wireframe color of the selected objects. You can leave the color selection 
window open and keep selecting 
 

and applying colors. 
 

Display > Object Display 
 

The items in this submenu control the display and select ability of the selected 



 

 

 

objects. 
 

Template / Untemplate : Makes an object unselectable, for use as a reference in your scene. 

Templated objects appear slightly dimmed. You cannot select or snap to templated objects. 

 

Bounding Box / No Bounding Box: Draws a box around the total space occupied by each 
object. 
 

Geometry / No Geometry : Shows or hides the actual geometry of the object (for example, 

the surface or polygon mesh). This lets you turn on the display of components (such as CVs) 

but turn off the actual object itself. 

 

Ignore Hardware Shader / Use Hardware Shader : Lets you ignore hardware shaders on 

multiple polygon or NURBS ob jects. The objects then appear with their untextured default 

shaders. Use Ha rdware Shader lets you show the hardware shaders for multiple polygon or 

NURBS objects. 

 

Fast Interaction: Improves performance by displaying fewer geometric entities (such as 

polygons), especially when moving the camera (for example, tumbling the scene view). 

 

2.5 View Port Display 
 

When you have scene with lots of objects, materials, lights etc., scene becomes heavy and 

machines speed also become slow. To solve this problem you can switch to the following 

view panels display. 

 

Low Quality Display 
 

Select the specific NURBS object and press 1. 
 

Medium Quality Display



 

 

Select the specific NURBS object and press 2 . 
 

Better Quality Display 
 

Select the specific NURBS object and press 3. 
 

Wireframe Display 
 

Press 4 to view all the objects of scene in wireframe. 
 

Shaded Display 
 

Press 5 to view the shade of the objects. 
 

Texture Display 
 

Press 6 to view the Texture given to the objects. 
 

Light Display 
 

Create a new Light and Press 7 to view the Light effect in the scene. 
 

2.6 Primitives 
 

Primitives are simple 3D objects created in the shape of common geometric forms, which 
can be moulded or expanded to add 
 

more detail. It Includes spheres, cubes, cylinders, planes, cones and toruses. 
 

Type of Primitives: 
 

1) NURBS Primitives: Create  various geometric primitives shapes using NURBS surfaces or 
curves. 
 
2) Polygon Primitives: Create polygon‐based geometric primitives. 
 
3) Subdiv Primitives: Create various geometric shapes using unique Subdivision primitives 

with the characteristics of both polygons and NURBS. 

 
4) Volume Primitives: It is use in combination with lights and Volume Fog to produce foggy 
atmospheric volume effects.  
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 

 

2.7 NURBS Primitives, Polygon Primitives 
 

NURBS 
 

NURBS (Non‐Uniform Rational B‐Splines) are one of the geometry types you can use to 

create 3D curves and surfaces in Maya. NURBS are useful for constructing many types of 

organic 3D forms because of the smooth and minimal nature of the curves they use to 

construct surfaces. NURBS surface types are widely used in the fields of animation, games, 

scientific visualization, and industrial design. NURBS can be converted into 

 

Polygons. 
 

Polygons 
 

Polygons are straight‐nsided shapes (3 or more sides); defined by vertices and the edges. 

The interior region of the polygon is called the face. Vertices, edges, and faces are the basic 

components of polygons. You select and modify polygons using these basic components. 

 

Polygon Primitives 
 

Polygon Primitives can be created from Create Menu. 
 

Create > Polygon Primitives



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

NURBS Primitives 
 

NURBS Primitives can be created from Create Menu. 
 

Create > NURBS Primitives  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Interactive Creation 



 

 

 

With Interactive Creation you can position and scale primitiv es as you create them using 

your mouse, without having to use transformation tools and is by default on. Th is option 

stays on until you turn it off Exit on Completion This option interacts with Interactive Creat 

ion. When Exit on Co mpletion is turned on, you must select a primitive type again in order 

to create another primitive. When this option is turned off, you can interactively create 

multip le primitives of the same type, until you select another tool. 

 

To create a polygon Primitive, choose shape from the create menu like: 
 

Create > Polygon Primitive > Sphere 
 

and follow the onscreen instructions to create the primit ive interactively. You can also click 

on option box to open the create sphere option dialog box where you can specify the 

following options: 

 

1. Radius: Specifies the distance from the center of the sphere in all directions. 
 
2. Divisions: The values you enter in these options change the primitive by adding or taking 
away faces of the polygonal surfaces. 
 
3. Axis: By default, a primitive is created along the Y axis. You can change a primitive’s 

default orientat ion before you create it by changing the Axis option. 

 
4. Create Uvs: These will create UV coordinat e (texture coordinates) for the Primitive.



 

 

Similarly you can draw other polygon prim itives. The unique options for each are given 
below: 
 

Cube 
 

1. Width: Specifies the width of the cube. 
 
2. Height: Specifies the height of the cube. 
 
3. Depth : Specifies the depth of the cube. Cylinder 

 
1. Radius: Specifies the distance from the center of the cylinder. 
 
2. Height: Specifies the Height of the Cylinder. Cone 

 
1. Radius: Specifies the distance from the center of the Cone. 
 
2. Height: Specifies the Height of the Cone. Plane 

 
1. Width: Specifies the distance along X‐axis. 
 
2. Height: Specifies the distance along Y‐axis. Torus 

 
1. Radius: Specifies the distance from th e center of the torus in all directions. 

 
2. Section Radius: Specifies the size of the sections that make up a torus. Change this value 

to increase or decrease the radius of these sections. 

 
3. Twist: The Twist option value specifie s the twist angle of the torus. Change this value to 

adjust the distance around the torus in all directions. Prism 

 

A prism is a polyhedron with tw o polygonal faces lying in parallel planes and with the other 

faces parallelogram s. It has following options: 

 

1. Length: Enter values or use the slider to specify the length of the prism (the distance 
between the two polygonal faces). 
 
2. Side Length : Enter values or use the slider to specify the side length of the prism’s 
polygonal caps. 
 
3. Number of Sides: Enter the number of sides for the ends of the prism. 
 

The above example is a triangular prism (3 sides). The size and volume of the prism 

increases with the number of sides if the edge length and 

 

length/height are kept constant. 



 

 

 

Pyramid 
 

A pyramid is a polyhedron with a polygon base and triangles with a common vertex for 
faces. It has following options: 
 

1. Side Length : Enter values or use the slider to specify the side length of all faces. 
 
2. Number of Sides in Base : Select the number of si des for the base of the pyramid (3, 4, or 

5). Pipe 

 

The options are very similar to the options for the cylinder polygonal shape, with the 

addition of Thickness (which spec ifies the thickness of the wall). 

 

1. Radius: Specifies the distance from the center of the pipe in all directions. 
 
2. Height: Specifies the height of the pipe.



 

 

3. Thickness : Specifies the thickness of the pipe walls. Helix 

 
A helix is a curve in three dimensional space that lies on a cylinder, so that its angle to a 
plane perpendicular to the axis is constant. 
 
1. Coils: Specifies the number of coils. 
 
2. Height: Specifies the height of the helix. 
 
3. Width: Specifies the width of the helix. 
 
4. Radius: Specifies the radius of the helix coils. 
 
5. Direction: Specifies the direction of the helix’s twist: clockwise or counterclockwise. 
 

Soccer Ball 
 

The soccer ball is a truncated icosahedron: thirty‐two faces, alternating hexagons and 
pentagons. 
 

1. Radius: Enter values or use the slider to specify the radius of the soccer ball. 
 
2. Side Length : Enter values or use the slider to specify the side length of the soccer ball. 

Platonic Solids 

 

You can create many different types of polygonal platonic solids. Platonic solids are shapes 

where all sides are equal, all angles are the same, and all faces are 

 

identical. These are: 
 

• Tetrahedron : four triangular faces 
 
• Octahedron: eight triangular faces 
 
• Dodecahedron : twelve pentagonal faces 
 
• Icosahedron : twenty triangular faces 
 

You can switch between these types by selecting Solid Type in the Attribute Editor or in the 
option box for Platonic Solids. 
 

1. Radius: Enter values or use the slider to specify the radius of the platonic solid. 
 
2. Side Length : Enter values or use the slider to specify the side length of the platonic solid. 
 
3. Platonic type: You can switch between platoni c solid types in the options for these 

shapes. To create NURBS primitives using create menu: 



 

 

 

Select Create > NURBS Primitives, then follow the onscreen instructions to create the 

primitive in teractively. You can also select the primitive’s option box from the list of primitiv 

es. For example, Sphere > , Cube > , Cone > , Cylinder > , and so on. 

 

Sphere 
 

1. Pivot: By default, the Pivot is set to Object, and the primitive is created at the origin. 

Specifically, it’s rotate and scale pivots are at the origin. If you set Pivot to User Defined, you 

can enter values in the Pivot Point X, Y, and Z boxes to position the pivots (and the 

primitive). 

 
2. Axis: Select X, Y, or Z to specify a preset axis direction of the object. Select Free to enable 

t he X, Y and Z Axis Definition boxes. Enter new 

 

values to select your own axis direct ion. Select Active View to create the object 

perpendicular to the current orthographic view. The Active View option has no effect when 

the current modeling view is a camera or perspective view. 

 

3. Start and End Sweep Angles: These options let you create a partial sphere by specifying a 

degree of rotati on. Degree values can range from 0 

 

to 360 degrees. The following example shows the top view of a sphere with an End Sweep 
Angle of 180 degrees. 
 

4. Radius: Sets the width and depth of the primitive. 
 
5. Surface Degree: A Linear surface has a fa ceted appearance; a Cubic surface is rounded.



 

 

6. Use Tolerance : You can use this option to improve the precision of the primitive’s shape. 

If set to Global toler ance, the Positional tolerance value in the Settings part of the 

Preferences window is used. Lower values increase surface precision. If set to Local, you can 

enter a value in the 

 

options window to override the Positional tolerance value in the Preferences window. If set 

to None, tolerance is ignored and the sphere is 

 

created with the specified number of sections and spans. 
 

7. Number of Sections: Sets the number of surf ace curves created on the sphere in one 

direction. Surface curves, also called isoparms, show the 

 

outline of the surface shape. The more sections (and spans) a surface has, the more 
precisely it shows surface deformations. 
 

8. Number of Spans: Sets the number of surface curves created on the sphere in the 

direction that crosses the Section direction. A value less 

 

than 4 gives a crude sphere. 
 

Cube 
 

A cube has six sides, each selectable. Yo u can select a side of the cube in the view, or click 

its heading in the Outliner. Options unique to cubes follow: 

 

1. Width, Length, Height: Sets the cube dimensions. 
 
2. U/V patches : Sets the number of U and V Patches between the edges that make up the 

cube. This value changes the number of spans and 

 

sections. 
 

Cylinder 
 

You can create a cylinder with or without end caps. The options unique to cylinders pertain 

to end caps. You can creat e caps for either, both, or no ends of the cylinder. You can also 

create caps as separate transform nodes so you can manipulate them independently of the 

cylinder. 

 

Cone 
 

You can create a cone with or without a cap on its base. Its other options are similar to 
those of other NURBS primitives. 



 

 

 

Plane 
 

A plane is a flat surface made up of a specified number of patches. Its options are similar to 
other NURBS primitives. 
 

Torus 
 

A torus is a 3D ring. It has options similar to other NURBS primitives. 
 

Circle 
 

A circle is a curve, not a surface. Its options are similar to a sphere. 
 

Square 
 

A square is a group of four curves, not a su rface. Its options are similar to other NURBS 
primitives. 
 

Transforming objects and components Transformations change an object’s position, size, 

and orientation without changing its shape. Transformations are rela tive to an object’s (or 

component’s) pivot point, and take place along/around eith er the world axes, object axes, 

or 

 

local axes. 
 

World space, Object space and Local space 
 

3D positions and transformation exist with coordinate systems called spaces. 
 

World space is the coordinate system for the entire scene. Its origin is at the center of the 

scene. The gr id in the view panel window shows world space axes.



 

 

Object space is the coordinate system from an object’s point of view. The origin of object 

space is at the object’s pivot point, and its axes are rotated with the object. 

 

Local space is similar to object space, howev er it uses the origin and axes of the object’s 

parent node in the hierarchy of objects. Th is is useful when you haven’t transformed the 

object itself, but it is part of a group that is transformed. 

 

2.8 Subdiv Primitives, Volume Primitives 
 

You can create Subdiv Primitives by clicking Create > Subdiv Primitives. 
 

2.9 Define and Differentiate NURBS and Polygons 
 

NURBS are smooth and rounded and are controlled by area nodes, but polygons are made 
of flat faces from strait edges. 
 

Polygons are used to model mechanical object and NURBS are used to model organic stuff. 
 

2.10 Transforming objects and components 
 

Transformation tools 
 

The upper half of the Tool Box contains the tools for transforming objects (selec tion, move, 

rotate, scale) within Maya. When you move your mouse cursor over any transformation tool 

icon you see the name of the tool appear next to the mouse cursor. 

 

The tool's name also appears in the Help Line at the bottom of the Maya window. The Help 

Line has an additional purpose: it displays summary instructions as you use tools that 

require several steps. 

 

Selection and de‐sel ection of objects 
 

Before you can transform an object, you must ensure it is selected. You can select objects by 

clicking them direct ly, or by dragging a rectangular bounding box or a boundary around 

some portion of the object to i ndicate what you want selected. To deselect an object, you 

simply click somewhere off of the selected object. 

 

To transform an object 
 

To Move 
 

Select the Move Tool or press w . Use the position manipulator to change the position of the 
selected objects. 
 

To Rotate 



 

 

 

Select the Rotate Tool or press e. Use the rotation manipulator to rotate the selected 

objects. The selection rotate s around the pivot of the key object. 

 

To Scale 
 

Select the Scale Tool or press r . Use the scale manipulator to scale of the selected objects. 

The selection scales from the pivot of the key object. 

 

To Move, Rotate and Scale 
 

Select the object and t hen select Universal Manipulator tool or press ctrl + t which 

combines the function of Move tool, Rotate tool and Scale tool. 

 

Note: Always Off the Caps Lock while using Maya Shortcut Keys. 
 

For example, 
 

• To use the Move Tool to adj ust the position of a cylinder Create a polygon cylinder 

 
Select the Move Tool from the Toolbox. 
 
A move manipulator icon appears over the primitive cylinder in the scene view. 
 

The Move Tool Manipulator has handles that point in the direction of the three fundamental 

axis directions of 3D space: X, Y, Z. The handles are 

 

colored red, green, and blue based on their function related to the X, Y, Z axes and control 

the direction of the movement along an axis.



 

 

When you click a specific handle, it indicates that the move is constrained to that particular 
axis direction. 
 

In the side view, drag the green Y manipulator handle to move the primitive cylinder 

upwards in the Y dire ction. Move it upwards enough so 

 

that the bottom of the cylinder is aligned with the X axis (the thick dark line of the grid) 
 

• To use the Rotate Tool to adjust the position of a cylinder Display all four views by 

positioning the mouse cursor in the view and tapping the spacebar of your keyboar d. The 

four view panel appears. Position the mouse cursor in the t op view and tap the spacebar 

once. The top view appears in the workspace. With the cylinder selected, choose the rotate 

tool from the Tool Box. A rotate manipulator icon appears over the primitive cylinder in the 

scene view. The Rotate Tool Manipulator consists of three rings (handles), plus a virtual 

sphere enclosed by the rings. The colors of the handles correspond to the X, Y, and Z axes. 

The handles are color ed red, green, and blue based on their function related to the X, Y, Z 

axes and control the direction of the rotation around an axis. In the top vi ew, drag the red X 

manipulator ring to rotate the primitive cylinder as shown in the image below. You are 

rotating the cylinder on X axis. 

 

TRANSFORMING COMPONENT 
 

Choose Display > Component Display > Rotate Pivots and Display > Component Display > 
Scale Pivots. 
 

To keep the pivot in place while working with components When you transform 

components, Maya creates a temporary pivot at the center 

 

of the selected components. Because the pivot is alwa ys at the center of the selection, 

selecting or deselecting additional components moves the pivot. You can lock the pivot in 

place so it won't move as components are added to or removed from the selection. 

 

Press the Insert key to show the pivot point manipulator. 
 

Move the pivot point. 
 

Click the circle at the top of the pivot poi nt manipulator to lock or unlock the pivot point for 

component transformations. When the ci rcle is filled, the pivot is locked. 

 
 

 



 

 

2.11 NURBS & Polygon Objects Component and SubDiv 
Components 
 

Components of NURBS Objects: 
 

1. Isoparms: Isoparms are the lines that sy mbolize cross section in U and V directions. It can 

be inserted, removed, used to make curves and snapped to. 

 
2. Control Vertex: A point that does not exist on the surface but used to controls the shape 
of a NURBS cu rve or surface. 
 
3. Hull: A line that connects CVs. Hull is useful to show the CVs in a crowded scene and also 
to select an ent ire row of CVs at once. 
 
4. Surface Patch: A rectangular portion of a surface bounded by adjacent edit point 
isoparametric curves 
 
 
 
 

Components of Polygon Objects 
 
 
 
 

1. Edge: A straight line between the two or dered vertices. Press F10 for edge selection 
mode. 
 
2. Vertex: A corner shared by two or more polygonal faces. Three or more connected 

vertices make a face. Press F9 for vertex selection mode. 

 
3. Face: Three or more connected edges made face. A face with three sides is a triangle, 

with four sides is a quad, and with more than four sides is a n‐gon. 

 

Press F11 for face selection mode. 
 

4. UV: Coordinate systems for 2D surfaces required to display or render a texture on a mesh. 
Press F12 for UV selection mode.



 

 

2.12 Moving, rotating, and scaling objects 
 

To Move 
 

Select the Move Tool or press w . Use the position manipulator to change the position of the 
selected objects. 
 

To Rotate 
 

Select the Rotate Tool or press e. Use the rotation manipulator to rotate the selected 

objects. The selection rotate s around the pivot of the key object. 

 

To Scale 
 

Select the Scale Tool or press r . Use the scale manipulator to scale of the selected objects. 

The selection scales from the pivot of the key object. 

 

To Move, Rotate and Scale 
 

Select the object and t hen select Universal Manipulator tool or press ctrl + t which 

combines the function of Move tool, Rotate tool and Scale tool. 

 
 

 

2.13 The Tool Box : Select, Move, Rotate and Scale 
 

Transformation tools 
 

The upper half of the Tool Box contains the tools for transforming objects (selec tion, move, 

rotate, scale) within Maya. When you move your mouse cursor over any transformation tool 

icon you see the name of the tool appear next to the mouse cursor. 

 

The tool's name also appears in the Help Line at the bottom of the Maya window. The Help 

Line has an additional purpose: it displays summary instructions as you use tools that 

require several steps. 

 

2.14 The Pivot Point 
 

The pivot point 
 

Pivot points control how objects rotate and scale, and also represent the exact locations of 

objects in space. All transform ations to an object are relative to the pivot point. 

 

You can change the pivot point of an object or the selected components by pressing Insert 

or Home and using the pivot point manipulator. 



 

 

 

2.15 Duplication options 
 

Duplicate creates a copy of the selected object in your scene. 
 

Duplicate Special: Duplicate Special creates one or more copies of the selected object in 

your scene optionally with transformations applied to each duplicate it creates. 
 

The option available with Duplicate Special command are: 
 

1. Geometry type : It provides you with two options: a. Copy: Makes a copy of the duplicated 

object 

b. Instance: Instanced objects are light weight reference of the original object. Instanced 

object s are connected to the original object that means if you make any change to the 

original object,duplicate copy also changes. 

 
2. Group Under: Group under lets you group the duplicated object under 
 

one of these: 
 

a. Parent 
 
b. World 
 
c. New Group 
 

3. Smart Transform: If on, Smart transform applies the same transformation, which you 

apply to the duplicate object without changing the selection to the subsequent dup licates 

of the selected duplicate.



 

 

4. Move, Scale And Rotate: Defines the offset, angle or size variation for the duplicated copy 
or instance. 
 
5. Number of copies: You can specify the number of copies to create with each duplicate 

special command. Minimum is 1(default) and maximum is 1000. 
 
6. Duplicate Input Graph: Turn this option on to force the duplication of all nodes whose 

connections are leading up to the selected object. 
 

2.16 The Channel Box 
 

The Channel Box is an edit ing panel that provides y ou access to an object's transformation 

information an d much more. It provides information on three distinct areas for any type of 

object: The transform node, shape node, and input node. 

 

Nodes are where information about object types is kept track of within Maya. Nodes are 

comprised of attributes. Attributes refer to informati on related to what the node is 

designed to accomplish. In th is case, information about the primitive cylinder's Y axis 

rotation is referre d to as the Rotate Y attribute. When you moved and rotated the cylinder 

primitive using the Move Tool, you 

 

were doing this by your own visual judgment. This will usually be sufficient for many of your 
creative applications. 
 

If you need to control the attribute of an object with more accuracy you can do this by 

entering the precise values into the appropriate attribute field of the Channel Box. 

 

To move and rotate the base using the Channel Box With the cylinder selected, view the 

Transformation attributes in t he Channel Box. Specifically, view the values for Translate Y, 

and Rotate X. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 
 

 

In the Channel Box, adjust the attribute values so t hey match the above image by clicking in 

the field and ent ering the correct numerical values. 

 

This accurately positions the cylinder in your Maya scene. Maya named the cylinder prim 

itive when it was first created. Rename the cylinde r to something more meaningful to your 

project. To rename the cylinder primitive using the Channel Box 

 

Naming Objects: In the Channel Box, click in t he field with the name pCylinder1. Rename 

the primitive object by typing a new name Wood as shown in the right side figure and then 

press Enter. 

 
 

 

2.17 Explain Construction history 
 

In Maya most of your actions creates nodes in the construction history of the objects you 

work on. At each point in your work, the current scene is the result of all the nodes you’ve 

created so far. For example if you create a curve‐edged shape of bottle and apply revolve to 

the curve a new revolve node is created. The new node has the shape of the curve as an 

input. It has attributes that control how it creates the surface fr om the curve. And it has t 

he resulting surface as its output. 

 

This chain of nodes, from the curve to the revolve node to the surface, is called the surface’s 

construction history. The most important thing about construction history is that you can 

change it. You can reshape the curve, or change the attributes on the revolve node, and the 

resulting surface updates automatically.



 

 

2.18 Edit > Delete by Type > History 
 

Removes construction history from the select ion, “baking” it in its current state. 
 

2.19 Selecting objects 
 

Select the objects by clicking them directly, or by dragging a rectangular bounding box or a 

boundary around some porti on of the object to indicate what you want selected. 
 

When you select the multiple objects, the last selected object is drawn in a different color 

from other selected objects. This is known as the key object. When you transform the 

multiple objects, the tr ansformation uses the key object’s pivot point. 
 

2.20 Selection modes and masks 
 

Select the objects by clicking them directly, or by dragging a rectangular bounding box or a 

boundary around some porti on of the object to indicate what you want selected. 

 

When you select the multiple objects, the last selected object is drawn in a different color 

from other selected objects. This is known as the key object. When you transform the 

multiple objects, the tr ansformation uses the key object’s pivot point. 

 

2.21 Using quick select sets 
 

Using Quick Select Sets 
 

Quick select sets are useful to quickly select commonly used sets of objects/components 
and by saving a complex selection, you can 
 

re‐use it later without having to reselect each object. Select the objects or components, 
from Create > Sets > Quick Select Set. Type 
 

a name for the set. 
 

2.22 Hiding and templating 
 

Hiding the Objects 
 

To hide the selected obects, Select Display > Hide > Hide Selection. To Redisplay the last 

objects you hide, Select Display > Show > Show Last Hidden. 
 

Select Display > Show > All to show all hidden objects. 
 

To change the display of all panels, use the items in the Display > Hide and 
 

Display > Show submenus. 



 

 

 

To change the display of one panel, use the items in the panel’s Show menu. 
 

To show a specific hidden object, sele ct the object’s node in one of the editors and select 
Display > Show > Show Selection . 
 

Select the object’s node from Outliner or Hypergraph, to select a hidden object. Select 

Display > Object Display > No Geometry , to hide the actual geometry of an object while 

leaving other components visible. 
 

Select Display > Object Display > Bounding Box to show only an object’s bounding box. 
 
 

 

Templating the Objects 
 

Template is the action of making an object unselectable. The object is still visible, but 

changes to a gray color to indicate that it cannot be selected or changed. In other software 

packages it is known as freeze or ghost. It is very much useful, when you have a large scene 

with lots of objects, templating the display of some of the objects in your scene allows you 

to more easily select only the objects you want. 
 

Select the objects you want to template and select Display > Object Display > Template. 
 

To make a template object selectable again, from Hypergraph or Outliner select the 

templated node and then, from the main Maya window, select Display > Object Display > 

Untemplate. 
 

To select the templated object, from Hyper graph or Outliner se lect the templated node OR 

click “Select by hierarchy and co mbinations” icon in the Status Line (toolbar) and set the 

selection mask to Template. 
 
 
 

 

2.23 Layers – The Layer Panel



 

 

Layer editor is window that helps you organize large‐scale pieces of the scene so you can 

show, hide, or edit them all at once. It is generally located below the channel box. 

 

The Render Layer editor is available from Window > Rendering Editors > Render Layer Editor 

, and the Display Layer editor is available from Window > General Editors > Display Layer 

 

Layers menu 
 

Create Empty Layer: Creates a new display layer, depending on the selection in the drop‐

down list, with a default name, for example layer1. 

 

Select Objects in Selected Layers: Selects the objects contained in the selected layer(s). 
 

Remove Selected Objects from Selected Layers : Removes all objects from the selected 

layer(s) and assigns them to the default layer. The selected layer(s) becomes empty so you 

can assign other objects. 

 

Membership : Opens the Relationship Editor fo r removing or adding objects to layers. 
 

Attributes : Opens the Attribute Editor for t he selected layer(s). 
 

There are some attributes in the Attribute Editor not available through the Edit Layer 
window. 
 

Delete Selected Layers : Deletes the selected layer(s), but not the objects in the layer. 
 

Delete Unused Layers: Delete layers if they have no content. 
 

Set All Layers\Set Selected Layer s\Set Only Selected Layers 
 

You can set all layers or selected layer characteristics. When you set selected layer 

characteristics, you can specify w hether unselected layers will be affected or not. 

 

You can set the followi ng characteristics: 
 

• Visible/Invisible 
 
• Normal/Template/Reference 
 
• Full Detail/Bounding Box 
 
• Shaded/Unshaded 
 
• Textured/Untextured 
 
• Playback On/Playback Off 
 

The above layer settings menu items are also available when you right‐click a Display layer. 



 

 

 

Sort Layers Alphabetically: Sorts layers by name. 
 

Sort Layers Chronologically: Sorts layers by time of creation. 
 

2.24 Summary 
 

In this chapter we complete the Navigation and Primitive , Transforming. 
 

2.25 Self Assessment test 

 

Broad Questions – 

 

1 What are Transformation and explain it? 
 
2 Explain Polygon primitive? 
 
 
 
 
 

 

Short notes
 
 

1. Channel box 
 
2. Pivot point 
 
3. Layers



 

 

4. Nurbs primitive 
 
5. Constructions history 
 
 
 
 
 

 

2.26 Further Reading 
 

1. Introducing Autodesk Maya 2013 Dariush Derakhshani 
 
2. Learning Autodesk Maya 2009 Foundation: Official Autodesk Training 
...Autodesk Maya Press, Marc‐André Guindon



 

 

UNIT 3 GROUPING, NURBS MODELING 
 
 
 
 
 
 
 

 

Learning Outcome 
 

After going through this unit, you will learn: 
 

• Nurbs Modeling 

 

• Grouping & Parenting 

 

• Align and Snapping Object 
 

• Advantages of Digital Audio 

 

• Curve  
 
 
 
 
 

 

Time Required to Complete the unit 
 

 

The time required to study thus Unit is broken as follows 
 

1. 1
st

 Reading: It will need 2 Hrs for reading a unit 
 

2. 2
nd

 Reading with understanding: It will need 3 Hrs for reading and understanding a unit 
 
3. Self Assessment: It will need 3 Hrs for reading and understanding a unit 
 
4. Revision and Further Reading: It is continuous process  
 
 

 

Content Map 
 
 
 

 

3.1. Parenting 

 

3.2. Grouping vs. Parenting 

 

3.3. Edit 

 

3.4. Aligning and snapping objects 



 

 

 

3.5. Modify 

 

3.6. Nurbs modeling 

 

3.7. Creating NURBS Curves 

 

Create 

 

Edit Curves 

 

3.8. Summary 

 

3.9. Self Assessment test 

 

3.10. Further Reading 
 
 
 
 

 

3.1 PARENTING 
 

Parenting is the term used when placing a node beneath another in a hierarchy so it 
becomes the child of the node above it (its parent) in the hierarchy.



 

 

3.2 Grouping vs. Parenting 
 

When you need to move, scale or rotate multiple objects as one unit it is easier if they have 

been grouped together so that they transform as one unit. 

 

Many primitive objects in Maya are grouped objects. For example, the NURBS cube 

primitive is comprised of 6 flat squares or planes that have been grouped together as one 

unit. When the plane objects are grouped together they create a hierarchy. 

 

A hierarchy is a collection of nodes or objects that are connected together to form a unit for 

some purpose. Hierarchies are useful for describing how the objects within them share 

similar characteristics or attributes; move, scale, rotate for example. 

 

By parenting the objects, you can move, rotate, or scale the cap and the body as a single 
entity by selecting only the body. 
 

3.3 EDIT 

 

Edit Commands 
Click the Edit Commands tab to view and edit the MEL code associated with a tool or action. 
 

3.4  Aligning and Snapping Objects 
 

 

Align Objects:  Align objects Aligns two or more object in 3D space. You can specify Align 
Mode, Align Ax is in the option window. 

 

Align Tool: Align tool lets you align two or more object. The selected Objects align to the last 
selected object (Highlighted as green). To align the objects,  
Select Modify > Align Tool then select al l the objects you want to align and in the end Shift‐
Select the object with respect to which you want to align other objects. Click on the icons 
provided by the Align Tool to align the objects.  
Select Align tool and then select all the object and in the last select the object to which you 
want objects to align. Click the icon to align the objects. The icons show the bounding boxes 
of the objects will align.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

Snap Together Tool: Snap together tool allows you to visually pick the points on two objects 
to snap together. Click a point on one object, then click a point on the second object. You 
can drag the selected points to edit them. Then press Enter to snap the points together. 
 
 

 

3.5 MODIFY 
 

Modify > 
Snap Align Objects >  
Point to Point: This tool allows you to align two objects at a point. The point can be a vertex, 
CV, Edit point etc. You have to select one point on each surface in order to use this 
command. 

 

2 Points to 2 Points: This tool allows you to ali gn two objects at two points. The point can 
be a vertex, CV, Edit point et c. You have to select two points on each surface in order to use 
this command. 

 

3 Points to 3 Points : This tool allows you to align two objects at three points. You have to 
select three points on each su rface in order to use this command. 
 
 

 

3.6 Nurbs Modeling 
 

The NURBS toolset is Maya’s oldest and is an industry staple in building models for high‐end 
film productions and industrial 
 

design. While NURBS are very technical in nature, taking the time to understand how they 
work is worthwhile because you 
 

can benefit by using them in certain modeling scenarios. 

 

Non‐Uniform Rational B‐Splines is a mathematical term that sounds complicated. To 
understand NURBS, you should know 
 

that a NURBS object is a mathematical description of a curve or surface. Any point on a 
NURBS curve or surface has an exact 
 

coordinate value, in contrast to a polygonal surface, where only the locations of the vertices 
can be returned.



 

 

When comparing NURBS to polygons, a good analogy to consider is the difference between 

vector‐based graphics used in Adobe Illustrator and Flash and pixel‐based images used in 

Adobe Photoshop and many digital video and photography applications. Because vector 

lines are drawn on your screen based on a mathematical description, they always remain 

smooth, no matter how close you zoom in on them or how big the window is in which they 

are played back. Pixel based images, on the other hand, are made up of finite rectangles, 

and called pixels. While these may not be visible when you’re viewing an image at its normal 

resolution, the image starts to break up as you zoom in and see that the image is made up 

of thousands, or even millions, of rectangular pixels. 

 
 
 

Since a NURBS surface is mathematically described, it can be rendered to appear infinitely 

smooth, no matter how close up the camera gets. Figure given below shows a NURBS 

sphere (left) and a polygonal sphere (right). Look at the edges of the spheres and notice that 

the polygonal sphere is made up of segments and is not smooth like the NURBS sphere. 

 

Fig: close up of NURBS sphere VS Polygonal sphere  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3.7 Creating Nurbs Curves 
 

Anatomy of NURBS Curves and Surfaces Both NURBS curves and surfaces have similar 

components that control how they are edited. Understanding how these components relate 

to each other and how they are used to calculate curves and surfaces will provide you with a 

good foundation for transforming your simple surfaces into more complex shapes while 

maintaining a clean geometry that is easy to edit. 

 

We’ll first examine curves, since they have similar, but fewer, components than surfaces. 

You’ll then learn how these components relate to surfaces and how some other 

components are unique to surfaces. 



 

 

 

Components of a NURBS Curve 
 

Figure shows a NURBS curve displaying its components, described next: Fig: Anatomy of 
NURBS Curve  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Edit points (EPs) when a curve is drawn in Maya; the software joins together polynomial 

curve segments, called spans. The points where these segments join are called edit points 

(sometimes called knots). An edit point lies on a curve and is represented by a small 
 

× that you can select and move to edit the shape of the curve. Edit points can be added to a 

curve by using the Insert Knot command (Edit Curves 

 

| Insert Knot). 
 

Control vertices (CVs) CVs control how the curve is “pulled” or “weighted” between edit 

points. CVs basically define the shape of a curve or surface. The number of CVs between edit 

points depends on the degree of the curve. (See “Surface or Curve Degree” later in this 

chapter.) CVs often lie above or below a curve, in space, and are the components most 

commonly edited to control the shape of the curve. CVs cannot be inserted directly into the 

curve but rather are added when an edit point is inserted. 

 
 

 

Curve points One of the many great aspects of NURBS technology is that, because curves 

are mathematically calculated, any curve point along a curve can be chosen and adjusted. 

Once a curve point is selected, knots can be inserted or the curve can be detached



 

 

(Edit Curves | Detach Curve).The shape of the curve can be edited from any curve point by 

using the Curve Editing Tool (Edit Curve | Curve Editing Tool). 

 
 

 

Hulls Hulls are straight lines that connect the CVs together. Choosing a hull selects all of the 

CVs in a curve. You can display and edit curve components by using the right‐click marking 

menu, shown in Figure as per below, which displays the available components for a NURBS 

curve. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

If you want to view a component but not select it, you can display it by choosing an option from 

the Display menu. For example, to see the hulls of your object, select the object and then 

choose Display | NURBS | Hulls. The hulls will be displayed for that object. 
 
 
 

 

NURBS MODLEING TECHNIQUE 
 

Nurbs Modeling Techniques 
 

Fish Model 
 

First of all you have to find some reference images through internet  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 

In Side‐View create several Nurbs‐Curves; get the shape as good as possible...just scale the 

curves .Then create the loft, now you have to tweak some CV's to create the belly, andsome 

other details. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Now project a Nurbs‐Circle onto the Main Body, duplicate it several times to get the rough 
shape of the eye 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

And loft again. We have also created a half‐Sphere in the middle...that's the eyeball 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The same technique, we've used for the body, we'll now use for the back fins, just create a 

small Nurbs‐Circle, duplicate it, copy, move...just take a look at the image, and see, 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Loft again you need to tweak some of the circles, created before. But thanks to 
construction‐History that should be no problem 
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Perform this for the rest of the fins...all of them were attached to the main‐body using 
fillets of all kinds 



 

 

 
 

 

To create the things between, just duplicate some of the rear‐fin curves, and in side‐ view draw 

the outline‐curve. Take care, that all the curves touch each other. Use the snap to point Shortcut 

to do this. I've colored the curves you need to perform a Birail 2 surface 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use the Birail2‐Tool to create the "skin". Afterwards tweak some CV's to get the "fluffy" 
shape...with every tool you like 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Use these techniques to create the missing ones....and you're finished  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

3.8 Summary 
 

In this chapter, you learned some of the basic principals behind NURBS modeling. We have covered 

curve creation and editing as well as some of the more common surface‐generating commands 

available in Maya. 

 
 
 

 

3.9 Self Assessment test 

 

Broad Question 

 

1. What NURBS CURVE? 
 
2. What is Hull ? 
 

Short Notes 

 

1) Align 
 
2) Grouping 
 
3) Edit Curve 
 
4) Snapping 
 
5) Curve Point



 

 

 
 

 

3.10 Further Reading 

 

1. Introducing Autodesk Maya 2013 Dariush Derakhshani 
 
2. Learning Autodesk Maya 2009 Foundation: Official Autodesk Training 
...Autodesk Maya Press, Marc‐André Guindon 
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ROLE OF SELF INSTRUCTIONAL   MATERIAL INDISTANCELEARNING 

 

The need to plan effective instruction is imperative for a  

Successful distance teaching repertoire. This is due to the fact that the instructional designer, 

the tutor, the author (s) and the student are often separated by distance and may never meet in 

person. This is an increasingly common scenario in distance education instruction. As much 

as possible, teaching by distance should stimulate the student’s intellectual 

Involvement and contain all the necessary learning instructional activities ties that are capable 

of guiding the student through the course objectives. Therefore, the course / self-instructional 

material are completely equipped with everything that the syllabus prescribes. 

To ensure effective instruction, a number of instructional design ideas are used and these help 

students to acquire knowledge, intellectual skills, motor skills and necessary attitudinal 

changes.  In this respect, 

Students ‘assessment and course evaluation are incorporated in the text. 

The nature of instructional activities used in distance education self- instructional materials 

depends on the domain of learning that they reinforce in the text, that is, the cognitive, 

psychomotor and affective. These are further interpreted in the acquisition of knowledge, 

intellectual skills and motor skills. Students may be encouraged to gain, apply and 

communicate (orally or in writing) the knowledge acquired. Intellectual- skills objectives may 

be met by designing instructions that make 

use of students’ prior knowledge and experiences in the discourse as the foundation on which 

newly acquired knowledge is built. 

The provision of exercises in the form of assignments, projects and tutorial feedback is 

necessary. Instructional activities that teach motor skills need to be graphically demonstrated 

and the correct practices pros vided during tutorials. Instructional activities for inculcating 

change in attitude and behavior should create interest and demonstrate need and benefits 

gained by adopting the required change. Information on the adoption and procedures for 

practice of new attitudes may then be introduced. 



 

 

 

 

Teaching and learning at a distance eliminates interactive  

Communication clues, such as pauses, intonation and gestures, associated with the face-to-

face method of teaching. This is particularly so with the exclusive use of print media. 

Instructional activities built into the instructional repertoire provide this missing 

interaction between the student and the teacher. Therefore, the use of instructional 

activities to affect better distance teaching is not optional, but mandatory. 

Our team of successful writers and authors has tried to r e d u c e  

This. Divide and to bring this Self Instructional Material as the b e s t  

teaching and communication tool. Instructional activities are varied in order to assess the 

different facets of the domains of learning. 

Distance education teaching repertoire involves extensive use of self- instructional 

materials, be they print or otherwise. These materials are designed to achieve certain pre-

determined learning outcomes, namely goals and objectives that are contained in an 

instructional plan. Since the teaching process is affected over a distance, there is need to 

ensure that students actively participate in their learning by performing specific tasks that 

help them to understand the relevant concepts.  

Therefore, a set of exercises is built into the teaching repertoire in order to link what 

students and tutors do in the framework of the course outline. 

These could be in the form of students ‘assignments, a research project 

or a science practical exercise. Examples of instructional activities in distance education 

are too numerous to list. Instructional activities, when used in this context, help to 

motivate students, guide and measure students’ performance (continuous assessment) 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

PREFACE 
 

 

We have put in lots of hard work to make this book as user-friendly as possible, but we have 

not sacrificed quality. Experts were involved in preparing the materials. However, 

concepts are explained in easy language for you. We have included many tables and 

examples for easy understanding. 

We sincerely hope this book will help you in every way you 

Expect. 

All the best for your studies from our team! 

 

 

 

 

 

 

All the best for your studies from our team! 
  



 

 

  



 

 

 
 
 
 

UNIT 4  NURBS SURFACES, POLYGON MODELING 
 
 
 
 
 
 
 
 

 

Learning Outcome 
 

After going through this unit, you will learn: 
 

• Nurbs Surface 
 
 
• Polygon Modeling  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Time Required to Complete the unit 
 

 

The time required to study thus Unit is broken as follows 
 

1. 1
st

 Reading: It will need 2 Hrs for reading a unit 
 

2. 2
nd

 Reading with understanding: It will need 3 Hrs for reading and understanding a unit 
 
3. Self Assessment: It will need 3 Hrs for reading and understanding a unit 
 
4. Revision and Further Reading: It is continuous process  
 
 
 
 

 



 

 

Content Map 
 
 
 

 

4.1 Surfaces 

 

4.2 TEXT 

 

4.3 Edit NURBS 

 

4.4 Polygon modeling 

 

4.5 Explain Polygons and its Components. 

 

Modeling Polygons 

 

Edit Mesh 

 

Mesh 

 

4.6 Proxy 

 

4.7 Summary 



 

 

 
4.8 Assessment 

 

4.9 Further Reading  
 
 
 
 
 
 
 
 
 

4.1 Surface 

 

NURBS Surface 
 

NURBS surfaces contain some of the same components as NURBS curves. Both CVs and hulls 

perform the same functions that they do for curves and can be chosen and edited in the 

same way. However, surfaces also have some unique components, as shown in Figure 

below. These unique components are discussed next. 
 

Fig: Components of NURBS Surface  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1. Isoparms Isoparms lie on the NURBS surface and extend across the entire surface at a 

constant parametric value. Just as edit points represent the ends of curve spans, isoparms 

represent the boundaries between surface patches—the regions on a surface enclosed by 

isoparms. Isoparms can be selected and added to a surface, but unlike their curve 

counterparts, they cannot be edited directly. 
 
2. Surface point A surface point is any point or parameter on a surface. This is similar to a 
curve point. 
 
3. Surface patch A surface patch is the region between the enclosed isoparms. 
 

Surface or Curve Degree 
 



 

 

The degree of a surface or a curve refers to the exponent used in the underlying polynomial 

equation hat defines the geometry. What this means to the Maya user is that degree 

equates to the number of control vertices that are needed to define one span of a NURBS 

curve or surface. The number of control vertices needed to define one span will always 

equal the degree of the curve + 1. Therefore, a one‐degree (linear) curve has two control 

vertices—one at the beginning and one at the end. A one‐degree curve is always a straight 

line. Maya allows NURBS objects to have one, two, three, five, or seven degrees of 

curvature. In Maya, a degree of three is the default and is most often used. 
 

Curve Direction 
 

The direction of a curve is initially determined by the order in which you draw it, which is 

called the curve’s U direction—the first point at which you draw is considered the beginning 

of the curve and the last point is the end point. If you don’t know which direction an existing 

curve is going, you can select it and display the components by pressing F8 (or you can 

enable the Select by Component Type button on the status line) and making sure the Points 

Selection Mask is activated on the status line. Or you can right‐click the object and choose 

Control Vertex. The beginning of the curve will be marked with a small box, and the second 

CV will be marked with a U to communicate that the curve is moving in the U direction. This 

is illustrated in Figure as per below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Parameterization of Curves and Surfaces



 

 

Parameterization describes how the numeric values are assigned to each point on a NURBS 

surface or curve. Each of these points has a numerical value known as a parameter that 

describes the point’s location. On a curve, this parameter gives a point’s location in the 

curve’s U direction. A surface has two parameters, one in U and the other in V. Any point on 

a surface can be queried or described using this coordinate system. 

 

Methods of Parameterization 
 

The parameterization, or how a parameter value is calculated across the curve, is 

determined by one of two methods: the uniform method or the chord‐length method, both 

shown in Figure as per below. 

 

When drawing a curve, the method of parameterization can be set in Knot Spacing 

attributes of the CV (or EP) Curve tool’s settings window (choose Create | CV Curve Tool). 
 
 
 
 
 
 
 
 
 
 
 

 

Fig: Two and Four Span Curve uses Uniform parameterization and Bottom curve is uses 
Chord length parameterization 
 

With uniform parameterization, integral parameter values are assigned at each edit point. 

To demonstrate, let’s consider a curve with four spans, in which the edit points are not 

evenly spaced. In the uniform parameterized curve. Using uniform parameterization, you 

can match parameterization between two curves just by figuring the total number of spans. 

However, determining parameters based on the length of the curves is not so 

straightforward Using chord‐length parameterization, the parameter values are assigned to 

the edit points based on the distance of a straight line, expressed in Maya units, extended 

between the edit points. While this method gives the curves irregular parameter values at 

their edit points, the values do reflect information that is relative to a point’s position along 

the curve. 

 
 

 

Parameter Range 
 



 

 

A uniformly parameterized curve of surface always has a value of 0 at the first edit point. 

Exactly how the rest of the parameters are divided up over the length of the surface 

depends on the Parameter Range. Draw a three‐span curve. In the Attribute Editor, look at 

the Min Max Value attributes. You should see that the Min value is set to 0 and the Max 

value is set to 3, as shown fig below. When the values are assigned this way, you can deduce 

that the parameter range is set from 0 to the number of spans. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

You can choose to set the parameter range to 0 to 1 as well. This has no effect on any 

modeling operations. This is available for many reasons. One reason is that texture 

coordinates are laid out on a grid that has a range from 0 to 1. Some workflows or rendering 

engines may only be able to properly apply textures to a surface that has a parameter range 

from 0 to 1. Another use for setting the parameter range from 0 to 1 is for use with particle 

effects. Many times a NURBS surface is used to guide particles. When the effects artist 

wants to run particles along a surface, from one end to the other, they would probably 

rather not deal with keeping track of how many spans the surfaces has. Instead, the 

surface’s parameter range can be reset to 0 to 1 using the Rebuild Surface command (Edit 

NURBS |Rebuild Surface). 

 

Maintaining Parameterization While Modeling
 

Much of the NURBS modeling process involves the constant rebuilding of curves and 

surfaces so that they maintain normal parameterization and have a matching number of 

spans for creating clean, orderly surfaces. To generate the cleanest surface, the parameters 

of the source curves must match.



 

 

Figure below, shows two surfaces that were generated by lofting two curves together. The 

curves used to generate the surface on the left were created with the same number of 

spans (four) and, as a result, they had matching parameterization. The structure of the 

lofted surface is clean and predictable. You can tell this by looking at the even flow of 

isoparms that were created by connecting the edit points 

 

on the original curves. As a modeler, you can predict exactly where these isoparms are going 

to intersect each curve. Just because two pieces of geometry have the same number of 

spans does not 

 

necessarily guarantee that they have matching parameterization. This mainly becomes an 

issue when an operation is applied to a surface. Whenever a surface is attached or detached 

or an isoparms is inserted, the parameterization of the geometry is affected. When this 

occurs, the surfaces must be rebuilt immediately in order to reparameterize that value 

across the geometry. 

 

Fig: The surface on the left was generated from two curves that had the same number of 

spans. The surface on the right was generated by two curves that had a different number 

of spans. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Advantages and Disadvantages of NURBS Modeling 
 

NURBS modeling works well for building any smooth, curving surface—such as the body of a 

car or a human body. Because of its ability to represent complex shapes, NURBS is the 

preferred toolset used among most industrial designers. In fact, chances are that the chassis 

of your computer and monitor were designed using NURBS modeling. However, the biggest 

drawback to using NURBS has to do with the fact that to build a complex object, you must 



 

 

create and link together multiple individual surfaces. Working with multiple surfaces can 

mean more time spent having to texture each surface individually and manage the seams 

between surfaces so that they match at render time. 

 
 

 

Advantages of NURBS 
 

Following is a discussion of some of the benefits of NURBS modeling. 
 
 
 
 

Few Control Points Using NURBS, you can create and edit smooth curving objects with few 

control points. These results in less data needed to calculate these surfaces, which 

translates into smaller file sizes and more efficient use of your computer’s RAM. In a 

network environment, smaller files transfer faster and do not clog the pipeline. This was a 

big factor back in the early years of 3D animation pipelines, when cost of RAM was at a 

premium. Nowadays, this aspect of NURBS is taken for granted, but is still important to 

consider. 

 

Resolution Independence 
 

The mathematical nature of NURBS surfaces enables smooth surfaces to remain smooth no 

matter how close the camera zooms in. However, when a NURBS surface is rendered, it is 

tessellated, which means that it is converted into polygonal faces, based on the user‐

defined tessellation attributes of the NURBS object. This means that while the object is 

being cut up into triangles, the user still has the power to assign how smooth or coarse the 

object will render. Having this kind of control can really help optimize a scene’s rendering 

time. If the object is far away from the camera, it can be rendered with a low tessellation 

setting. The same piece of geometry can also be used in a close‐up shot by increasing the 

tessellation setting. With a polygonal object, however, two separate models would have to 

be built to optimize the overall polygon count of the scene: one low‐resolution model for 

when the object is in the background, and a high‐resolution model that will work for close‐

up shots.



 

 

Definition: tessellation the process of creating a faceted surface. When a NURBS surface is 

tessellated, it is converted into polygonal faces that define the original shape. 

 
 

 

Texture Coordinates By its rectangular nature, any point on a NURBS surface can be defined 

by a coordinate in the U and V directions. Texture maps, such as bitmapped files that you 

might create in an image editing application like Photoshop, are also rectangular in nature, 

and their pixels are defined by coordinates in the X and Y directions. Because of this 

congruent relationship, 

 

is able to fit a texture map to a surface by matching these corresponding coordinate 

systems, allowing the texture to fit exactly on a surface and match its curvature, no matter 

how many twists or turns the surface makes. With a polygon model, an entire process of 

laying out the UVs is necessary before any texturing can be done on an object. 

 
 

 

Conversion‐Ability Maya allows you to convert any geometry type to another by using the 

Convert command. Converting a NURBS model to polygons can produce the cleanest 

geometry, and it requires the least amount of cleanup due to the inherent orderliness and 

square‐patch nature of NURBS. A conversion from NURBS to a polygon is illustrated in 

Figure as per below. Notice that each square surface patch on the NURBS object is 

converted to a square polygonal face on the polygonal object. It is even possible to specify 

how many polygonal faces should be created for every one surface patch on the NURBS 

surface so that the resulting polygonal object will appear smooth. Many modelers prefer to 

build the initial surfaces with NURBS and then convert them to polygons or subdivision 

surfaces to 

 

add more rigid detail. 
 

Fig: A NURBS surface converted to Polygonal  
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 

 

Disadvantages of NURBS 
 

While you can easily model just about anything using NURBS, most of the disadvantages 

with NURBS stem from the fact that more complex NURBS models are often made from 

multiple individual surfaces. As a result, you have to deal with the problems described next. 

Seams Probably the biggest problem with models built from NURBS has to do with the 

seams that can show between surfaces. When using trimmed surfaces. The solution is to try 

to match the tessellation between adjacent surfaces manually. However, this usually results 

in heavy tessellation, which means a lot of polygons and hence longer render times. 

Branching In modeling, branching refers to the parts of models that extend, or branch off, 

from the main surface or a group of surfaces. In these cases, the grid like structure of the 

topology is broken and the five‐point junctions that we saw in Chapter 4 are introduced. 

Since a NURBS surface can only contain a quad layout, the NURBS surface must be broken 

up into individual pieces and arranged to handle the change in the structure. 

 
 

 

Texture Mapping Across Multiple Surfaces When you’re creating very detailed models using 

NURBS, you will often end up with multiple surfaces. While this is not necessarily a bad 

thing, it can make managing the scene a lot more difficult, especially when it comes to 

having to apply texture maps across these mismatched surfaces. And, while we mentioned 

having texture coordinates inherent to the model as an advantage of NURBS, it also has 

limitations, because the UVs cannot be edited separately from the mesh.

 
 
 
 
 

 

4.2 TEXT



 

 

Set the menu set to polygons.  
 
 
 
 
 
 
 
 

 

Step one - To create the text, go to create>text... Click on the box to open the options.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Step two - First enter the text in the text field. 

 

Step three - To change the font, click on the arrow next to font and click "select...". 

 

Step four - Type: this is the type of geometry you'll be outputting. Trim will output a NURB 

surface, Poly will output polygons, and Curves output NURBS curves. 
 

If you select Poly, it's best to output the type to quads and the tessellation method to general 

or count.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 
 
 

 

Step five - Click create to create your text. 



 

 

Step six - To give your text a 3D look, select all the polygonal geometry and go to edit 

mesh>extrude. Don't de-select anything; go to the move tool and move the text forwards. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Now you are ready to use the text for your project.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 
 

4.3 EDIT NURBS 
 
 
 

 

Curves 
 

The NURBS modeling process usually begins with the creation of curves that match a profile 

or cross section of the object that you are modeling. Once you establish the curves, you 

execute commands that use the curves as inputs to generate surfaces. In this section, we 

will explore many of the curve editing tools and commands and then learn to generate 

surfaces from them using some of Maya’s surface commands. 

 

Curves are often the starting points for models. While they are never rendered, you will 

probably need to work with them to some degree while building most of your objects. You 

might use them to trace a bitmap that you use for reference or as the input to some other 

operation that generates surfaces. Or you might derive a curve from a surface to duplicate 

and manipulate it to generate a second surface. When you work with curves, most of the 

operations that you use involve attaching and detaching curves. A good working knowledge 

of curves will help you to build them efficiently, which will lead to organized surfaces that 

you generate from them.



 

 

Creating Curves with the Curve Tools 
 

While we’ve already been using curves in the last few exercises, we examine curves a bit 

closer here. Maya has two different methods for creating curves—one that creates them 

with CVs and another that creates them with edit points (EPs). Regardless of what tool you 

use, keep in mind that you want to describe your curve by using the least number of points 

possible. This makes it easy to edit the curves later and build efficient surfaces. 

 
 

 

CV Curve Tool 
 

Choose Create | CV Curve from the main menu in the menu bar or from the Hotbox. You 

can also select this tool from the shelf under the Curves tab. The default settings are set to 

draw a third‐degree curve with uniform parameterization. click at least four times to place 

four CVs in the view window. On the fourth click, you will notice that a smooth curve 

segment is generated. You can continue to click and place as many CVs as you want. When 

you are ready to complete the curve, press ENTER. 
 
 
 
 
 
 
 
 
 
 
 

 

EP Curve Tool 
 

Choose Create | EP Curve _. In the settings window that appears, click the Reset Tool button 

to set the tool to its default settings. Click once in the view window to set the first point. 

Click again in another place to set the second point. A curve will appear. Because the EP 

curve is completing an entire span every time a point is placed, you need to set only two 

points to complete the curve. Press ENTER (RETURN) to finish the curve. 

 

Curves on Surfaces 
 

In addition to drawing curves on the planes in the view window, you can also draw them 

directly on a surface, extract them from existing curves or isoparms, create them by 



 

 

projecting another curve in the scene, or create them from the line of intersection between 

two intersecting surfaces. 

 

Drawing on a Live Surface 
 

Make Live 
 

A curve can be drawn on any NURBS surface by first making the surface live. To do this, first 

select the surface on which you want to draw. Choose Modify | Make Live, or click the Make 

Live button on the status line. Once the surface is live, you can use any of the curve tools to 

draw on it. 

 

Duplicating Surface Curves 
 

Duplicate Surface Curves 
 

Any curve on a surface or surface isoparm can be duplicated and then edited on its own. To 

duplicate curve on a surface or isoparm, first select it and then choose Edit Curves | 

Duplicate Surface curves. While the curve is still connected to the surface through history, it 

becomes a separate object and can be edited accordingly. 

 

Projecting a Curve 
 

Project Curve on Surface 
 

Any curve in a scene can be projected onto a surface and a new curve created. To project a 

curve, select a curve and a surface and choose 

 

Edit NURBS | Project Curve on Surface. In this tool’s options window, you can specify 

whether the curve should be projected from the active view or along the normal of the 

surface. 

 

Creating Curves Along Intersecting Surfaces 
 

Intersect Surfaces



 

 

A curve on a surface is created along the line of intersection between any two intersecting 

surfaces by selecting the surfaces and choosing Edit NURBS | Intersect Surfaces. 

 

Creating Curves on Surfaces Using Other Tool’s Options 
 

Tools such as the Circular Fillet tool have an option that allows you to create a curve on a 

surface when the fillet operation is performed. 

 

Attaching and Detaching Curves 
 

Attaching and detaching are probably the most common operations you’ll use when 

working with curves. To attach curves, you connect or blend any two curves into a single 

curve. The Attach Curves command attaches two curves together. You can use two methods 

of attaching: connecting and blending. With the Connect option set, the end of one curve is 

moved to match the end of the other curve and the curves are attached. 

 

Attach Curves 
 

Draw two curves with either the CV Curve tool or the EP Curve tool. Choose Edit Curves | 

Attach Curves to bring up the Attach Curves Options window. Choose Edit | Reset Settings 

to restore the tool to its default settings. Then uncheck Keep Originals. Click Apply to attach 

the curves. The two curves will be attached at the two closest end points and will be 

blended with a bias of .5, so that each curve is moving the same amount to attach. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Detach Curves 
 

Detaching a curve involves choosing a point on a curve that marks the spot where the 

curve will be detached into two separate pieces. The only option available in the Detach 

Curves Options window is one to keep the original curve. To detach the curve, select it, 

RMB‐click it, and choose Curve Point. Choose Edit Curves | Detach Curves. The curve 

detaches at the selected curve’s point. The result is two separate curves. While this 



 

 

process is basic, selecting points (or isoparms), attaching, and detaching are integral parts 

of NURBS modeling. 
 
 
 
 
 
 
 
 
 
 
 

 

Cutting and Filleting Curves 
 

When a high degree of precision is needed in creating curves, the attach and detach method 

may not give you the control you need for creating rounded blends between curves. In 

these situations, a fillet can provide the precision you need. 

 

Curve Fillet 
 

To use the Fillet Curve command (Edit Curves | Fillet Curve), you first select two intersecting 

curves. Two different construction methods can be used, Circular and Freeform; The Circular 

option builds a circular‐ shaped fillet according to the size indicated via the Radius setting. 

When the Freeform option is selected, the point at which the fillet begins on each curve can 

be set by editing the Curve Parameter attributes on the fillet Curve node once the fillet has 

been created. 



 

 

 

 

Surfaces 
 

While curves play an important role in the modeling process, the surfaces generated from 

the curves are rendered to create the actual object. Surface generation in Maya begins with 

one or a series of source curves. These curves are used as the inputobjects for one of the 

surface generating tools. These surface‐generating tools, or modeling operations, then use 

their specific algorithms to generate a surface based on the attribute settings of the tool. 

 

Revolve 
 

The Revolve command is perhaps one of the simplest of the surface commands in Maya 

because it needs only one curve to be able to calculate the surface. Any round, symmetrical 

surface is a perfect candidate for the Revolve command. 
 
 
 
 
 
 
 
 
 
 
 

 

Extrude 
 

Another quick way to generate a surface with few input curves is to use the Extrude 

command. This is a different operation than the Edit Mesh | Extrude command. With this 

command, a profile curve can be extruded by any amount along its normal, or it can be 

extruded along a given path. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Loft 
 



 

 

If a 3D modeler had to choose one surface‐generating tool that he or she could not live 

without, it would be the Loft command. You select any number of curves to be used as cross 

sections and then use the Loft command to create a surface between them. The resulting 

surface will pass through each of the curves in the order they were chosen. 
 
 
 
 
 
 
 
 
 
 
 

 

Birail 
 

Birailing works by blending one or more “profile” curves along two “rail” curves. Because 

birailing allows you to define all four sides of a surface, as well as any shape along that 

surface, it is capable of generating the most complex shapes with the fewest number of 

input curves. Maya has three different birail tools available in the Surfaces | Birail menu: 

Birail 1 Tool, Birail 2 Tool, and Birail 3+ Tool. While all of these operations require exactly 

two rail curves, the difference between them is the number of curves that are used as 

profiles. Its simplest implementation, the Birail 1 tool, works by sweeping just one profile 

curve along two rail curves. The following tutorial demonstrates a great workflow for using 

the birail tools to create very complex surfaces.



 

 

 
 
 
 
 
 
 

 

Fig: Birail 1 tool operation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Birail 2 tool operation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Birail 3+ tool Operation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 

 

4.4 POLY MODELING 
 

Polygons are the building blocks of 3D modeling. Polygons are the smallest renderable units 

that make up a 3D model. a single polygon can be broken down into smaller components. At 

its most basic level, a polygon is a triangular‐shaped face defined by three vertices that are 

connected by three edges. Any 3D model that you render inside of Maya is made up of 

polygons. Polygon Anatomy 

 

There are three different types of components in a polygonal object: a vertex, an edge, and 
a face. Figure as per below, shows the 
 

components of a polygon, which are listed here:  
 

Fig: components of a polygon



 

 

 
 
 

 

Vertex: A point in space. The vertex is the most basic component of a polygonal model. 

When Maya stores polygonal data it assigns each vertex in a model a unique identification 

number and gives that point’s location in 3D space. This information allows the software to 

reconstruct the model when a file is opened by connecting each vertex to another one with 

an edge. By editing the position of a vertex, you are changing the shape of the face that it 

creates. 
 

Edge: The polygonal components that connect two vertices. The area between at least three 

connected vertices creates a face. Face: A minimum of three vertices enclosed by three 

edges. Although you can create a face with any number of vertices, the faces will be broken 

up into triangles at render time. A triangular face is called a tri, a four‐sided face is called a 

quad, and a face with more than four sides is called an n‐gon. The collection of connected 

faces in a model is called a polygonal surface or a polygonal mesh. UVs: Every vertex in a 3D 

model can be assigned a coordinate in 2D space. Once the UVs are assigned, they can be 

edited in the UV Texture Editor to control the placement of a texture map on the 3D model. 
 

Normal Every polygonal face has a front and a back side. A surface normal indicates the 

direction of the front of the face. You can display the normal of a 
 

polygonal object by selecting the mesh and choosing Display | Polygon | Face Normals. The 

direction of the normal can be changed by selecting a mesh and choosing Normals | 

Reverse. 

 
 

 

4.5 Explain Polygons and its Components. 
 

As with many things in Maya, there are always different ways to perform one task. By 

default, there are two different ways to access the components of a piece of geometry. One 

way is through the Selection Mask located on the status line and the other is through a 

marking menu. This process of switching into component mode and making selections is 

crucial to navigating your way through the Maya UI and is used in just about any workflow 

along the production pipeline, not just modeling. 
 

Using the Selection Masks to Select Components 
 

Anything we select in object mode will allow us to make edits to the object transform 

nodes. We can exclude any types of objects from a selection by clicking on one of the object 



 

 

type buttons. For example, if we wanted to select only curves, we could disable all of the 

buttons except for the curve type. This is helpful for excluding unwanted types of objects in 

your selection. An object that is selected while in object mode is indicated by a green 

highlight in the view windows. Fig: selection mask is set to object mode 
 
 
 
 
 
 
 
 

 

To change into component mode, click the button to the right of the object mode button. 

The buttons in this section of the status line will change to look as they do here: 
 

Fig: selection mask is set to component mode 
 
 
 
 
 

You can toggle between object and component mode by pressing the F8 key on your 
keyboard. 
 

Using the Marking Menu to Select Components 
 

Undoubtedly one of the most powerful aspects of Maya is its well designed user interface. 

Navigating through such a large program would take time if you were left to using only the 

dropdown menus from the menu bar. To give the user a better experience while working, 

the Maya engineers implemented marking menus. A marking menu is one that appears at 

your mouse cursor by pressing a certain key or mouse button in the workspace. The 

advantage of this type of interface is that you don’t have to go looking elsewhere in the 

interface to switch to other tools or 
 

selection modes. This way your eyes and attention will remain focused on your task. The 

fastest method for selecting an object’s components is to use a marking menu. In the view 

window, position your mouse cursor over the cube and RMB‐ click and hold. A marking 

menu containing all of the polygonal components will appear right at the spot where you 

are clicking. Figure below shows the marking menu displaying the polygonal components. 

You can choose one of the component modes by continuing to hold down the mouse and 

dragging over the desired



 

 

component type, Vertex, Face, Edge, or UV. When you have completed your edits to 

components, you can select object mode from the Component Editor. The display of your 

components will disappear and your object will return to its green highlighted color 

indicating that you are in object mode. While using the marking menu to select the 

components may seem basic, it is essential that you become comfortable with the process 

before moving on. Really, no matter what kind of task you are doing, be it animating, 

rigging, or working with particles, the process of activating the marking menu with an RMB‐

click will provide you with tools, commands, or modes that will make you more productive. 

 

 

Fig: By right mouse button clicking and holding over a polygon object, a marking menu 

appears that contains the different component selection available. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Advantages of Polygon Modeling 
 

Polygon modeling has several advantages over NURBS modeling. 
 

Modeling Detailed or Branched Models Is Easy Because polygon models are based on the 

connection of independent faces, it is possible to have polygons with any number of sides 

and meeting any number of adjacent faces at the corners (vertices). While abusing this 

advantage can lead to a very sloppy model, being able to break a grid like structure to create 

branching structures, which occur in areas such as fingers emerging from a hand, can be 

accomplished quickly and easily while maintaining a single surface. In comparison, it is 

impossible to create branching structures using a single NURBS surface. Instead, you are 



 

 

forced to use a multi patch (multiple individual NURBS surfaces) modeling technique, and 

then 
 

you must manage the continuity between each patch to make the structures appear to be a 

single surface. This is a time‐consuming effort that is of no issue when modeling with 

polygons. 
 

UV Texture Coordinates Are Editable In a polygonal model; the artist has full control over 

where each vertex will be located in the UV (texture space). Maya contains an entire 

interface for this type of editing in the UV Texture Editor, which is discussed in Chapter 
 

18. By having this kind of control, the artist can optimize texture maps and fix stretching or 

distortions. It is not possible to edit the UV of a NURBS surface without changing the layout 

of the surface itself in 3D space. 
 

Hard Edges and Corners Are Easily Accommodated Due to the nature of polygons being 

made up of finite straight segments; it is very easy to create sharp edges and other rigid 

details. This makes polygonal modeling extremely useful for modeling architectural 

elements such as buildings and environments. 
 

Simple Toolsets Are Available While you might use several dozen commands and tools 

when modeling with NURBS, you can create detailed polygonal models using very few tools. 

This makes it much easier for someone new to 3D modeling to become productive in a short 

amount of time. It’s also helpful to even the most experienced modeler since fewer 

processes need to happen to complete a task. 
 

Models Are Transferable Between Different Software Polygonal models are recognized by 

almost any 3D animation program or rendering engine, so, unlike NURBS models, you can 

transfer models between programs easily. 
 

Disadvantages of Polygon Modeling 
 

The following are some disadvantages of polygonal modeling. Data Size of a Smooth Polygon 

Object Is Comparably Large To represent a 
 

smooth, curvy object, without noticing any faceting in the silhouette of the model, it could 

take many faces. This will result in slower interaction compared to that of NURBS models. 

The tail of a dinosaur may need several hundred or thousands of faces to define its



 

 

shape and render smoothly. A similar structure in NURBS may only require a small fraction 

of that data. Because of the number of vertices needed to create a smooth detailed object, 

the data size can be significantly larger than that of a similar NURBS model. Your computer 

may run into problems loading or rendering a scene if sufficient memory is not available. 

Also, sending large files over a computer network can clog a pipeline. 
 

Adding Detail to Smooth Objects Can Be Difficult A common polygonal modeling workflow 

has he modeler work on a low‐resolution version of the model and then smooth, or 

subdivide, that model to view the final result. When the model is smoothed, the position of 

the vertices is interpolated to result in a much smoother form. The problem is that 

whenever detail is added to the model, the smoothed version will appear flat in that area, 

so the modeler must shuffle the position of the vertices around to obtain the smooth shape 

they once had. This makes it difficult to model high‐precision. 
 

Tips for Polygon Modeling 
 

To avoid any problems with your model, keep in mind the following tips as you work. 
 

Keep Polygon Faces As Quads (Four Sided) First of all, it’s much easier to view your models 

with one less edge through each face. If your aim is to create an organic, smooth surface 

later by using the Smooth command or by converting the surface into a subdivision surface, 

it’s a good idea to use quad faces as much as possible from the beginning. Quad faces 

smooth and convert to subdivision surfaces without problems. Figure shown below shows 

both quad and tri faces being converted to subdivision surfaces. You should be aware that a 

polygonal model 
 

with non manifold geometry won’t convert to a subdivision surface model. This may also be 

of concern if you plan to render subdivision surfaces in Mental Ray. 

 

 

Heads Up Display 
 

The HUD for poly count, shown next, displays the number of polygonal vertices, edges, 
faces, and UVs for the entire scene (second 
 

column), a selected object (third column), and selected components (fourth column). The 
HUD appears as an overlay in your view 
 

windows. The HUD is helpful in managing your polygonal models as you work. To turn it on, 
choose Display | Heads Up Display | 
 

Poly Count. It is always helpful to know how many polygons are amounting in your scene. 
Many productions specify a limit on the 
 



 

 

number of faces that can be used for each model.Also, being able to account for the number 
of components selected is a real help 
 

when components overlap. Without being able to look up this information in the HUD, you 
may think you only have one vertex 
 

selected when you very well may have two or three.  
 

Fig: poly count 
 
 
 
 
 
 
 
 

 

Custom Polygon Display 
 

Choose Display | Polygons | Custom Polygon Display from the main menu bar to open the 

Custom Polygon Display Options window, shown in Figure 3‐8. This window lets you set how 

a selected polygonal object will be displayed in the view windows. While you can turn on 

the display of the normals and vertices just as you can by choosing Display | Polygon 

Components, this window gives you access to a whole lot more. 
 

Some of the most useful options here control how various edges are displayed. When you 

are dealing with multiple polygonal surfaces, it can sometimes be difficult to determine 

where one surface ends and the other begins. Turning on the Highlight Border Edges option 

will thicken the edges along the borders of polygonal surfaces. How thick they appear is 

controlled via the Edge Width setting. 



 

 

 
 
 

 

4.5 Explain Polygons and its Components. 
 
 

 

Tool sets of Polygonal Modeling 
 

Here we will see the tools of basic Polygon Modeling. First we will cover the Edit Mesh 
Menu set. Edit Mesh Menu as shows in fig. 
 

below. 
 

Edit Mesh Menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Extrude 
 

The Extrude command will create new polygonal components based on an existing 

selection. It is one of the most used commands in polygonal modeling. 
 
 
 
 
 
 
 
 
 
 

 

Fig: Extrude after selecting Poly Face, Edge and Vertex 
 

 

Bridge 
 



 

 

Bridge is useful when you need to connect two sets of edges together with a piece of mesh. 

After applying bridge command, you can edit the attributes for the bridging mesh by 

selecting the mesh and editing the polyBridgeEdge node in the Attribute Editor. 
 
 
 
 

 

\ 
 
 
 
 
 
 

 

Append to Polygon Tool 
 

When this tool is selected, then the border edges highlighted and appear thicker. You have 
to select at least two border edges. 
 

Selection orders will affect on you generated polygon.  
 
 
 
 
 
 
 
 
 
 
 

 

Cut faces Tool



 

 

The tool can split polygons across multiple polygon meshes in one operation. Drag a line in a 

view window to define the cutting plane. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig: cut face tool applied on when selected whole object and on selected faces 

 

Split Polygon Tool 

 

You can split the mesh using this tool. You can add division as per you want and your need. 

You can correct the n‐sided polygon or tries to Quad topology using this tool. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Insert Edge Loop Tool 

 

This is the tool from which you can insert an edge loop across a full edge ring on a polygonal 

mesh and to insert a partial edge loop across a polygonal mesh and also to insert a 

multidirectional edge loop. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Offset Edge Loop Tool 



 

 

 

Using this tool, you can create edge loops that are offset from an original edge. Depending 

on the orientation of the edge loop on the mesh, drag your mouse in either a side to side, or 

back and forth motion to position the preview locators. Release the mouse button when 

you have positioned the edge loop preview locators in the desired location. 
 
 
 
 
 
 
 
 
 
 

 

Add Divisions 

 

Splits selected polygon components (edges or faces) into smaller components. Add Divisions 

is useful when you need to add detail to an existing polygon mesh in either a global or 

localized manner. 

 
 
 
 
 
 
 
 
 

 

Transform Component



 

 

Using this command, you can move, rotate or scale your polygonal component. Maya 

creates a transformation node (polyMoveComponentType) and automatically switches to 

the Show Manipulator tool, allowing you to edit the node. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Flip Triangle Edge 

 

Using this command, you can flip the triangle edges it means orientation of the edges will be 

change. This can often make a significant difference in the shape of low‐polygon count 

models. You cannot flip edges that are texture borders in UV space. You cannot flip border 

edges, including hole borders. You cannot flip edges with zero length. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Poke Face 

 

The Poke Face feature subdivides a polygon face in such a fashion that a new vertex is 

added to the center of the selected face. Poke Face is useful when you need to add details 

such as bumps or indentations to a polygon face. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Wedge Face 

 



 

 

With this command, you can pull out an arc of new polygons from existing faces with adding 
subdivisions.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Duplicate Face 

 

Using this command you can create a new separate copy of any selected faces. The 

duplicated faces become parts of the original mesh which otherwise remains unaffected. 

 
 
 
 
 
 
 
 
 
 
 
 

 

Detach component



 

 

Detach Component separates any selected vertex that is shared by multiple faces into 

multiple vertices depending on the number of faces the vertex shares. 

 

Merge 

 

The Merge command welds together any selected components within a distance 

determined by the Tolerance attribute. This command is especially useful for cleaning up 

geometry once two polygonal surfaces are combined with the Combine command. 

 

Merge to Center 

 

Merge to Center merges any selected vertices so they become shared and positions the 

resulting shared vertex at the center of the original selection. 

 

Merge Edge Tool 

 

You can merge edges to create a shared edge between them by selecting the two border 
edges. 

 

Delete edge/vertex 

 

To delete polygonal components efficiently, it is recommended that you use the Delete 

Edge/ Vertex command. For example, if a series of edges is selected and then deleted using 

the BACKSPACE (DELETE) key, the edges are removed but the vertices that once connected 

them remain. Using the Delete Edge/Vertex command removes the “stray” vertices and 

ensures a cleaner mesh. 

 

Chamfer Vertex 

 

Using this command, you can create a planner polygon with the place of selected vertex. 

 

Bevel 

 

This is the command; you can create beveled polygons along the currently selected edges. 

 

The Combine command (Mesh | Combine) combines multiple shapes into one. Be aware 

that combining does not merge any components together. Combine is often used with the 

Merge command. 

 

Separate 

 



 

 

Using this command, you can disconnect or separate your previously combined objects if 
history is not deleted. 

 

Extract 

 

Using this command, you can detach the selected faces from the poly mesh. The extracted 

faces become a separate component within the existing mesh. 

 

Booleans 

 

Booleans let you combine polygon meshes to create a new shape. 

 

Union: Combines the volume of the meshes. 

 

Difference: Subtracts the first mesh from the second. 

 

Intersection: Leaves only the shared volume of the meshes. 

 

Smooth 

 

It will smooth selected faces or selected poly mesh that means it will add subdivisions to the 

faces or poly mesh and make them smooth. 

 

Fill Hole 

 

The Fill Hole feature lets you fill in a region of a polygon mesh where polygons do not exist 

provided the region is bounded by three or more polygon edges. Fill Hole creates a polygon 

with three or more sides to fill in the selected region.

 

Create Polygon Tool



 

 

With this tool, you can create a polygon with placing vertices directly on the scene window. 

To create a polygon you have click at least three times in a scene. To return a value, means 

for completing tool you have to press Enter. 

 

Sculpt Geometry Tool 

 

Lets you specify the settings for the Sculpt Geometry Tool in the Tool Settings editor. There 

are attributes unique to the Sculpt Geometry Tool in the Sculpt Parameters sections. The 

Attribute editor shows the properties of the sculpt geometry tool where you have decide 

which operation do you want to do with the geometry. In the Attribute window, you can 

change the brush size, brush type, brush opacity in brush tab. You can also get sculpt 

parameters like operations: push, pull, smooth and erase. You can get max displacement 

value to displace the geometry. 

 

Mirror Geometry 

 

Using this command, you can create symmetrical polygon meshes. Just you have to define in 

which direction you want to do the operation. 

 

4.6 Polygon Proxy 
 
 

Subdiv Proxy smooths the selected polygon mesh by adding polygons and keeps the original 

non‐smoothed mesh as a proxy. A node connection is made between the proxy and 

smoothed version of the mesh so that changes to the proxy's shape or topology update the 

smoothed version of the mesh. 

 

Removes the smooth mesh created by Proxy > Subdiv Proxy (with Mirror Behavior set to 

Full) and combines the two halves of the proxy mesh (the original mesh and the mirrored 

mesh) into a single mesh (similar to using Mesh > Mirror Geometry on the original mesh). 

 

The Proxy > Crease Tool is the same feature as Edit Mesh > Crease Tool. They exist in two 

locations to more easily facilitate user workflows. For more information see Edit Mesh > 

Crease Tool. 

 

Toggles the display of the subdiv proxy object between normal polygon display and the 
smooth subdiv proxy version. 

 



 

 

Switching between the subdiv proxy and the normal polygon display modes is useful when 

you’re modeling polygon surfaces and want to quickly switch between either mode to 

preview your work. 

 

Displays both the proxy mesh and subdiv mesh simultaneously. You can also control this 
display mode using the ~ hotkey 
 
 
 

 

4.7 Summary 

 

In this Chapter we covered about Nurbs Surface and Proxy 
 
 
 
 

 

4.8 self Assessment test 

 

Broad questions 

 

1. What is NURBS surface? 
 
2. Explain PolyProxy? 
 

 

Short notes 

 

1. Extrude 
 
2. revolve 
 
3. Polygon Anatomy 
 
4. Normal



 

 

4.9 Further Reading 
 

1. Introducing Autodesk Maya 2013 Dariush Derakhshani 
 
2. Learning Autodesk Maya 2009 Foundation: Official Autodesk Training 
...Autodesk Maya Press, Marc‐André Guindon



 

 

UNIT 5  HUMAN AND ANIMAL ANATOMY, 
SUBDIV MODELING 
 
 
 
 
 
 
 

 

Learning Outcome 
 

After going through this unit, you will learn: 
 

• Anatomy 
 
• Sudiv modeling  
 
 
 
 
 
 
 
 
 

Time Required to Complete the unit 
 

 

The time required to study thus Unit is broken as follows 
 

1. 1
st

 Reading: It will need 2 Hrs for reading a unit 
 

2. 2
nd

 Reading with understanding: It will need 3 Hrs for reading and understanding a unit 
 
3. Self Assessment: It will need 3 Hrs for reading and understanding a unit 
 
4. Revision and Further Reading: It is continuous process  
 
 
 
 

 

Content Map 
 
 
 

 

5.1Anatomy 

 

5.2Basic Sub Division Modeling Workflow 

 

5.3Subdiv surface components 

 

1.1 Creasing Subdiv Surfaces 



 

 

 

1.2 Soft Modification Tool 

 

1.3 Sculpting Subdivs 

 

1.4 Summary 

 

1.5 Assessment 

 

1.6 Further Reading



 

 

5.1 Anatomy 
 

HUMAN ANATOMY 
 

In this chapter we will study the whole Human Anatomy structure. We will the Muscles 

structure of the Arms, Shoulders, Chest, Back, Legs, Buttocks and Abdomens. 
 
 

Here gives all illustrated images of muscles structure. 
 

Arms 
 

Fig: whole arm muscles structure 
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5.2 Basic Sub Division Modeling Workflow 
 

Polygon offers a sculptural modeling technique, but they require a significant addition of 

detail to create smooth, organic models. NURBS offer smooth surfaces, but they require the 

adoption of an alien modeling paradigm that involves concepts such as stitching, 

parameterizing, and trimming. Subdivision surfaces offer a compromise between the 

smoothness of NURBS and the sculptural quality of polygons by providing a paradigm that 

combines some of the best features of both modeling types. Subdivision surfaces are 

typically used toward the end of the modeling production process in order to add 

smoothness and detail to models that would otherwise be too computationally expensive to 

deal with earlier in the production pipeline. This chapter will follow that workflow, modeling 

Machismo’s head in polygons before converting it to subdivision surfaces for smoothing and 

detail work. 

 

5.3 Subdiv surface components 
 

A subdivision surfaces (subD) is a hybrid surface combining many of the advantages of both 

NURBS and polygons. Like NURBS, subDs represent a large number of polygons that can be 

increased or decreased depending on the needs of the artist. A relatively small number of 

knots (control points) control a surface, which is tessellated into levels of smoothness that 

are appropriate for anything from interactive display on the computer monitor to high‐

resolution models for rendering to High Definition Video (HD) or film. Unlike NURBS, which 

are limited to manipulating four‐sided patches into models, subDs also support polygonal 

topologies and modeling methods. Indeed, as you will see, it is most advantageous to begin 

modeling in polygons and switch to subDs for detailing. In fact, at the most basic editing 

level of a subD object (level 0), polygon vertices share the placement of the subD surface. 

 

The greatest advantage of subDs is their hierarchical nature. Subdivision surfaces can create 

increasing levels of detail and you can switch between the display of higher and lower levels 

of detail while modeling. Also, changes made to the model at a lower level of detail 

propagate up to the higher detail levels. Furthermore, this varying level of detail can be 

localized so that surface detail and complexity can be added only where needed. With 



 

 

NURBS, modeling detail requires that the number of U and V spans be increased across the 

entire patch or object. This approach increases the computational weight of the model and 

is largely undesirable. Even polygons require a high degree of modeling to add localized 

detail without increasing the entire object’s resolution. Figure given below shows the 

relative surface resolution needed for each modeling paradigm. Notice how the subD 

surface in the middle has detail added only where needed. 

 

Artists typically approach a model first by creating a low‐resolution polygon version and 

then converting it over to subDs. After the conversion, the mesh becomes quite smooth; 

creasing is often used to retain intended harder edges. 

 

Subdivision surfaces can be deceptive, however, in that they can promote bad modeling 

practices. You know that a primarily quad‐ based modeling effort is the best practice when 

modeling with polys. Triangles work, but n‐sided polys should be avoided because they 

smooth strangely. Subdivision surfaces smooth n‐sided polys fine, but the n‐sided polygons 

are not supported by mental ray for Maya; those objects containing polygons other than 

four sides will not render and may crash the renderer. 

 

Subdivision surfaces can be edited in two modes: standard mode and polygon proxy mode. 

Standard mode allows you to edit the subdivision components of the model and view it as a 

true subdivision surface. In this mode, you can use the standard subdivision modeling tools 

and refine components into levels. At any point, you can switch the model into polygon 

proxy mode, which allows you to edit the general hull of the object as if it were a low‐

resolution polygon model. Also in this proxy mode, you can use any of the polygon modeling 

tools. 

 
 
 

 

5.4  Creasing Subdiv Surfaces 
 

Full Crease Edge/Vertex modifies the appearance of a subdivision surface by applying an 

edge shaped feature along the selected region of the mesh. 

 

Applying a crease is useful when you want a sharp edge or transition on a surface. You can 

also apply a partial crease, or uncrease previously creased regions of the surface. The 



 

 

feature produced by a full crease appears more pronounced on the surface than a partial 

crease



 

 

A full crease is a hard or sharp edge created at the selected edges, or a sharp point created 

at the selected vertex. The surface moves very close or exactly to the edge or vertex to form 

the crease. 

 

A partial crease moves the surface closer to the selected edges or vertices without ever 

reaching them. Partial creasing is useful when you want a softer edge effect, such as at the 

edge of a character’s lips. 

 

5.5 The Soft Modification Tool is a deformer with adjustable falloff attributes 

that lets you manipulate 3D geometry much like an artist would push or pull on a piece of 

modeling clay to change its form. This enables you to smoothly deform high density surface 

meshes without having to adjust each vertex manually. Color feedback lets you visualize the 

area of influence around the deformer and across the surface mesh. 

 

By default, the amount of deformation is greatest at the center of the manipulator, and 

gradually falls off further away from the center. However, you can control the falloff of the 

deformation to create various types of effects. 

 

The Soft Modification Tool is located in the Tool Box. You can also access the tool within the 

Animation menu set by selecting Create Deformers > Soft Modification. 

 

You can use the Soft Modification Tool on NURBS surfaces, polygonal surfaces, subdivision 

surfaces, curves, particles or any object with components. 

 

5.6 Sculpt Subdivision 
 

 

The Sculpt Geometry Tool lets you manually sculpt NURBS, polygons, or subdivision surfaces 

quickly with the stroke of a brush. You simply paint the surface mesh using the Sculpt 

Geometry Tool to push or pull CVs (NURBS) or vertices (polygons and subdivision surfaces) 

to achieve the shape you want 

 
 
 

 

5.7  Summary 
 



 

 

In this Chapter covered Subdivision and anatomy . 
 
 
 

 

5.12 Self Assessment Test 
 

1. Explain Anatomy 
 
2. Explain Subdivision Modeling 
 

Short notes 
 

1. Sculpt Subdivision 
 
2. Crease 
 
3. Soft Modify tool 
 
4. Subdivision 
 
5. Partitial Crease 
 
 

 

5.13 Further Reading 

 

1. Introducing Autodesk Maya 2013 Dariush Derakhshani 
 
2. Learning Autodesk Maya 2009 Foundation: Official Autodesk Training 
...Autodesk Maya Press, Marc‐André Guindon 
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ROLE OF SELF INSTRUCTIONAL   MATERIAL INDISTANCELEARNING 

 

The need to plan effective instruction is imperative for a  

Successful distance teaching repertoire. This is due to the fact that the instructional designer, 

the tutor, the author (s) and the student are often separated by distance and may never meet in 

person. This is an increasingly common scenario in distance education instruction. As much 

as possible, teaching by distance should stimulate the student’s intellectual 

Involvement and contain all the necessary learning instructional activities ties that are capable 

of guiding the student through the course objectives. Therefore, the course / self-instructional 

material are completely equipped with everything that the syllabus prescribes. 

To ensure effective instruction, a number of instructional design ideas are used and these help 

students to acquire knowledge, intellectual skills, motor skills and necessary attitudinal 

changes.  In this respect, 

Students ‘assessment and course evaluation are incorporated in the text. 

The nature of instructional activities used in distance education self- instructional materials 

depends on the domain of learning that they reinforce in the text, that is, the cognitive, 

psychomotor and affective. These are further interpreted in the acquisition of knowledge, 

intellectual skills and motor skills. Students may be encouraged to gain, apply and 

communicate (orally or in writing) the knowledge acquired. Intellectual- skills objectives may 

be met by designing instructions that make 

use of students’ prior knowledge and experiences in the discourse as the foundation on which 

newly acquired knowledge is built. 

The provision of exercises in the form of assignments, projects and tutorial feedback is 

necessary. Instructional activities that teach motor skills need to be graphically demonstrated 

and the correct practices pros vided during tutorials. Instructional activities for inculcating 

change in attitude and behavior should create interest and demonstrate need and benefits 

gained by adopting the required change. Information on the adoption and procedures for 

practice of new attitudes may then be introduced. 



 

 

 

 

Teaching and learning at a distance eliminates interactive  

Communication clues, such as pauses, intonation and gestures, associated with the face-to-

face method of teaching. This is particularly so with the exclusive use of print media. 

Instructional activities built into the instructional repertoire provide this missing 

interaction between the student and the teacher. Therefore, the use of instructional 

activities to affect better distance teaching is not optional, but mandatory. 

Our team of successful writers and authors has tried to r e d u c e  

This. Divide and to bring this Self Instructional Material as the b e s t  

teaching and communication tool. Instructional activities are varied in order to assess the 

different facets of the domains of learning. 

Distance education teaching repertoire involves extensive use of self- instructional 

materials, be they print or otherwise. These materials are designed to achieve certain pre-

determined learning outcomes, namely goals and objectives that are contained in an 

instructional plan. Since the teaching process is affected over a distance, there is need to 

ensure that students actively participate in their learning by performing specific tasks that 

help them to understand the relevant concepts.  

Therefore, a set of exercises is built into the teaching repertoire in order to link what 

students and tutors do in the framework of the course outline. 

These could be in the form of students ‘assignments, a research project 

or a science practical exercise. Examples of instructional activities in distance education 

are too numerous to list. Instructional activities, when used in this context, help to 

motivate students, guide and measure students’ performance (continuous assessment) 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

PREFACE 
 

 

We have put in lots of hard work to make this book as user-friendly as possible, but we have 

not sacrificed quality. Experts were involved in preparing the materials. However, 

concepts are explained in easy language for you. We have included many tables and 

examples for easy understanding. 

We sincerely hope this book will help you in every way you 

Expect. 

All the best for your studies from our team! 

 

 

 

 

 

 

All the best for your studies from our team! 
  



 

 

  



 

 

 
 

 

Unit 6 TEXTURING 
 
 
 

 

Learning Outcome 
 

After going through this unit, you will learn: 
 

• Hypershade 

 

• Ray tracing 

 

• IPR rendering  
 
 
 
 
 
 
 
 
 

Time Required to Complete the unit 
 

 

The time required to study thus Unit is broken as follows 
 

1. 1
st

 Reading: It will need 2 Hrs for reading a unit 
 

2. 2
nd

 Reading with understanding: It will need 3 Hrs for reading and understanding a unit 
 
3. Self Assessment: It will need 3 Hrs for reading and understanding a unit 
 
4. Revision and Further Reading: It is continuous process  
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6.1Shaders, materials, and mapping 
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6.1 Shaders,Material and Mapping 
 

 

A material is a collection of attributes that define color, shininess, and other surface 
characteristics. 
 

 

The basic workflow of building a material is to start with a rendering node, such as a basic 

material, and edit its attributes. Other nodes, such as textures, can be connected to these 

attributes by dragging and dropping them onto a material and choosing the desired 

connection. Placement nodes are then edited to direct how a texture is positioned on a 

surface. For more advanced materials, additional utility nodes are connected to tweak the 

attributes of the other nodes in the network. As you’ll see, even a relatively simple exercise 

in the Material Editor can lead to a few dozen separate nodes and connections. The network 

of connected nodes that feeds into a material is called a shading network. Therefore, a 

completed material is often called a shader.



 

 

To assign a material to an object 
 
 

1 Before you create a new material, right‐click the sphere and select Material 
Attributes. 
 
 
The default material attributes appear in the Attribute Editor. The default material assigned 

to the sphere (and all other surfaces) is a type f material called Lambert. The material 

displays the surface with gray shading. You should not edit the default shading material. 

 
2 Right‐click the sphere and select Assign New Material > Blinn to create a new 

material for the sphere. The new material’s attributes appear in the Attribute Editor. 

 

A Blinn material gives a surface a shinier look than a Lambert material. Blinn is a good choice 

for creating a variety of surface appearances. Knowing which material type to use for a 

particular surface comes with practice. Fortunately, you can change the material type later 

on, so you do not need to make a decision now. You will learn more about material types 

later in the lesson.Getting Started with Maya 463 9 | Rendering Lesson 2 > Assigning a 

shading material 
 
 
 
 
 
 
 

 

3 In the Attribute Editor, click the gray box to the right of Color to open the Color Chooser. 
 
4 In the Color Chooser, click inside the color wheel (hexagon) and drag the pointer to an 

orange‐colored area, as illustrated. The sphere becomes the same color you select in the 

Color Chooser. Also drag up the slider to the left of the hexagon to get a brighter shade. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 
 

 

5 Click Accept to close the Color Chooser. If you compare the color in the Color attribute 

box with the sphere’s color in the scene view, you’ll notice a difference. The color you 

assigned is only one aspect of surface appearance. The appearance also depends on how 

the surface reacts with light. The main attributes that control the reaction to light are under 

the Common Material Attributes heading. As an example of these attributes, you will 

change the Diffuse setting. 

 
6 In the Attribute Editor, drag the Diffuse slider to its right to increase the color brightness 

as viewed in the scene view.This will help create the illusion of a bright orange. 

 
 

 

6.2 Hypershade 
 

The Hypershade window (Window | Rendering Editors | Hypershade) is shown in Figure 

given below. This is where you build and edit materials for all the objects in your scene. Like 

the Hypergraph, the Hypershade displays a dependency graph of the different materials in 

your scene. In fact, these materials display the exact same nodes, and you could do all the 

same editing and connecting by using the Hypergraph and other menu commands. The main 

difference between the two is that, when dealing with material‐ related nodes (also known 

as rendering nodes), the Hypershade displays its node icons, known as swatches in Maya, in 

more detail. This means that a file texture node’s icon displays a thumbnail version of the 

actual texture. A material node’s swatch will display



 

 

everything from the falloff of the specularity to the peaks and troughs of its bumps.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Hypershade Sections 
 

The Hypershade is divided into three main sections: the Create Bar, the top tabs section, 

and the bottom tabs section. In the Create Bar, you can create any of the rendering nodes 

by clicking them. Click and hold the Choose Node Type arrow to view the different types of 

rendering nodes. You may choose the Create Maya Node (the default), Create Mental Ray 

Nodes, or Create All Nodes. Once a selection is made, the relevant nodes will appear in the 

Create Bar. Items in the Create Bar are also available by right‐clicking in the other sections of 

the Hypershade window, so to create more space to work, you may want to hide the Create 

Bar. To do so, click the Create Bar On/Off button in the toolbar, shown in Figure above. The 

top tabs section contains all of the rendering nodes in the current scene; they are organized 

by category: Materials, Textures, Utilities, Lights, Cameras, Bake Sets, and Projects. Here’s 

how this works. If, for example, you click a Blinn material in the Create Bar, a new Blinn 

material icon will appear in the Materials tab. Likewise, any texture that is created will be 

displayed in the Textures tab. This feature organizes the different kinds of nodes in your 

scene. The third section of the Hypershade, the bottom tabs section, is where you can view, 

select, and edit the connections of the rendering nodes. To view a node in the work area, 

you can MMB drag the node’s icon from one of the top tabs down into the work area. To 

view its connections, you can use one of the three connection buttons in the Hypershade 

toolbar. This will expand that node to show its input connections, output connections, or 

both, in the work area. To clear this space, use the Clear Work Area button in the toolbar. 

Selecting one of the rendering nodes from the scene library tabs and clicking one of the 



 

 

display connections buttons will automatically clear the work area and display the 

connections for the selected node. These two sections of the Hypershade can be hidden by 

using the three buttons in the upper left corner of the Hypershade toolbar. Clicking the first 

button hides the lower tabs and expands the space for the upper tabs. Clicking the second 

button hides the upper tabs and shows only the lower section, and clicking the third (the 

default view) displays both tab sections. To move around in the Hypershade window, you 

use the same pan and zoom controls used in most of the other windows in Maya. 

 

 

6.3 RAYTRACING 
 

Within Maya there are multiple ways to add shadows to lights. Raytrace shadows can take 

longer to render, but the results are incredible. Raytrace shadows take into account the 

distance from the light and the size of the light. As a large light moves closer to an object, 

the shadow projected becomes softer. 

 

Raytracing is a rendering technique used to create photorealistic reflections and refractions 

on reflective surfaces, and to produce shadows. Raytracing is a high‐quality alternative to 

reflection mapping, although it requires more computation 

 

time. Raytracing accurately renders the properties like: 
 

1. Direct Illumination 
 
2. Shadows 
 
3. Specular Reflections 
 
4. Transparency Effects 
 

The raytracing algorithm calculates the co lor for each pixel by emitting rays from the 

camera into the scene. When a ray hits an object, its color is evaluated and then a 

secondary ray is projected (bounced) if the object is reflective or refractive. Maya calculates 

raytracing only when it is turned on in the raytracing quality section in render options.



 

 

6.4 Working with the Hypershade NODE 
 

Let’s practice working with the Hypershade by creating a Blinn material and connecting a 
texture to the Color attribute: 
 

The Create Bar should be turned on and displaying its Create Maya Nodes option; click the 

Choose Node Type arrow and select Create Maya Nodes from the resulting menu, if 

necessary. 
 

Click the sphere icon labeled Blinn. A Blinn material will be added to your scene and will 

appear in both the Materials tab and in the Work Area tab. If this is the first Blinn material 

you have created in the scene, it will be named blinn1. The next time 
 

you create a Blinn material, it will be named blinn2. Scroll down in the Create Bar and find 
the Textures section. Unfold this section 
 

to see the texture nodes. Click the Grid icon (see Figure below). A Grid texture node is 
added to the scene and appears on the 
 

Textures tab and the Work Area tab. Depending on where your Blinn material was 
positioned in the Workspace, your 
 

Grid texture node might overlap it. If this is the case, simply select one of the nodes in the 
work area and drag it out of the way so 
 

that all the nodes are visible. The work area should look like that shown in Figure below. In 
addition, notice that a 2D placement 
 

node has also been created and connected to the Grid texture node. This controls how that 
texture fits into the texture space. 
 

Fig: 2d Placement node, Grid texture node and Blinn node into work area  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

We want to have this Grid texture control the Color attribute of the Blinn material. We can 

make this connection directly in the Hypershade by dragging and dropping the Grid node’s 

icon onto the material node’s icon. In the work area, select the Grid 
 

texture node and MMB‐drag it onto the Blinn material node. When you release the mouse 

button, a marking menu appears with a list of attributes that the Grid texture can be 

mapped to by default. Since we want to map this to the Color attribute, 
 

choose Color from the list. A connection is made, and the material node icon is updated to 
display the Grid texture on the material. 
 

Your work area should look like the fig given below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Lastly, we assign the material to an object in the scene. Create a NURBS sphere(Create | NURBS 

Primitives | Sphere). You can assign the material to the object simply by MMB dragging the 

material swatch onto the object in the view window or the Outliner. Another way would be to 

select the object, right‐click a material in the Hypergraph, and choose Assign Material to 

Selection from the marking menu. To view the texture on the object in a view window, make 

sure you turn on hardware texturing by pressing the 6 key. 
 

Using the Attribute Editor for Editing Materials 
 

The Attribute Editor (shown in Figure given below) also plays an important role when you 

are working with materials. While connections can easily be made in the Hypershade 

window alone, the actual editing of attribute values is done in the Attribute Editor. 

Connections to other textures can also be made in the Attribute Editor. In fact, this tool 

offers access to more of the possible connections than the marking menu that is displayed 

when a node is dragged onto a material in the Hypershade.



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To get the most out of material editing, it is best to use the Hypershade and Attribute Editor 

together. Generally, you use the Hypershade to view connections and select particular 

nodes. Once selected, that node’s attributes are displayed in the Attribute Editor, where 

they can be edited. Connections to textures are probably best made through the Attribute 

Editor, and then additional utilities and optimizations can be made back in the Hypershade. 
 
 

 

Let’s try using the Attribute Editor to make connections to textures. We are going to 

continue working with the material we created earlier. If you no longer have that scene 

available, follow below Steps in the preceding section to create a Blinn material with a Grid 

texture connected to the Color attribute. Open the Attribute Editor, either by pressing CTRL‐

A, clicking the Show Attribute Editor button in the status line, or double‐clicking a material 

node in the Hypershade. 
 

Click the different nodes in the Workspace and notice how the Attribute Editor loads the 

specific attributes for the selected node. The Blinn material node attributes describe the 

basic surface characteristics, the checker texture attributes contain values that edit the 

colors in that Grid pattern, and the placement node attributes have values for translations, 

rotation, and other spatial attributes. Let’s change the color of the Grid pattern. Select the 

Grid texture node in the Hypershade. In the Attribute Editor, click the color swatch in the 

Line Color attribute. The Color Chooser, shown here, will open. Use the Color Chooser to 

change the white to red. Click the Accept button to close the Color Chooser. 
 



 

 

In the Attribute Editor, you can use the slider to the right of the color swatch to change the 

brightness value of the red. Change the Filler Color attribute to blue. 
 
 

 

Now we’ll change the tiling of the Grid pattern. Select the 2D placement node (named 

place2dTexture1) in the Hypershade to view its attributes in the Attribute Editor. Change 

the value of Repeat UV to 10 for both U and V, as shown in Figurebelow. The Grid pattern 

on the Grid node icon in the Hypershade window will change to show more tiles. Moving 

downstream, the Blinn material node also updates to show the new Grid pattern mapped to 

it. 



 

 

Next, we’ll edit the Bump attribute of the Blinn material node by connecting a texture to it. 

Select the blinn1 material in the Hypershade window to display its attributes in the Attribute 

Editor, Find Bump Mapping in the Attribute Editor (under Common Material Attributes). 

Click the checker button at the right to add a connection to this attribute. This will bring up 

the Create Render Node window. 
 

The Create Render Node window, shown next, is really the same as the Create Render Node 

menu in the Hypershade window. Make sure that 2D Texture creation setting is set to 

Normal at the top of this window. Then select the Grid texture. You’ll notice that in the 

Hypershade, a new Grid texture node is connected to a bump2d node, which is in turn 

connected to the Bump attribute of the Blinn material node. A bump map creates raised and 

indented areas in a surface when it is rendered. Lighter grayscale values raise the surface, 

while darker values create indentations. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Rendering Nodes and Their Attributes 
 

In the last section, you saw some of the basic rendering nodes. Rendering nodes can be 
divided into five basic categories: materials, 
 

textures, utilities, lights, and cameras. The Blinn and Lambert materials are examples of 
material nodes, the  checker node is an 
 

example of a texture node, and the placement node is a type of utility node. While we have 
already used these nodes, connected 
 

them, and edited ,their attributes, we have only touched the surface. In the next few 
sections we will dig deeper and examine some 
 

of the individual attributes of the material, texture, and utility nodes. 
 
 

 

Material Nodes 
 



 

 

Material nodes are responsible for controlling the characteristics of a surface. The main 
material nodes in Maya are Anisotropic, 
 

Blinn, Lambert, Phong, Phong E, and Ramp Shader. While the texture nodes might display a 
pattern hinting at the material that a 
 

surface could be made of, the material node is primarily responsible for communicating this 
effect. Even without a texture 
 

containing pictorial details, the type of material node and the settings of its attributes will 
largely tell you the material is made of 
 

plastic, metal, glass, rock, or other material. The way material interacts with its environment 
the objects, colors, and lights that 
 

surround it provides most of the visual clues about its substance. 
 

Take a moment to analyze the surface characteristics of a mirror. What color is a mirror? It 
is actually black, but it does not give off 
 

any of its own color. Instead, its surface is almost completely reflective, so it just reflects 
what is around it. To create a material 
 

attribute for a mirror surface, you would turn down the diffuse value all the way, so that the 
color of the object is not reflected back 
 

into the camera. 
 

All the materials in Maya share the same set of attributes. These are known as the common 
material attributes. Where these 
 

materials differ is in the way they calculate their specular and reflection attributes, if they 
have any. The Lambert material does not 
 

have any specular attributes. It is best used for matte surfaces, such as chalk or certain types 
of paper or fabric. 
 

Common Material Attributes 
 

The common material attributes for all of Maya’s materials are as follows: 
 

Color The color of the material. Assigning an RGB or HSV (Hue, Saturation, Value) value 
using the Color Chooser sets this attribute. 
 

Its brightness value can be controlled with the slider. 
 

Transparency Controls the transparency/opacity of the surface. A value of 0 (black) renders 

the image 100 percent opaque. A value of 1 (white) renders the object totally transparent. A 

color value can also be used; it will act as a color filter 
 

over objects behind it. 
 



 

 

Ambient Color Sets the color of the darkened or black areas. Think of it as bringing up the 
black contrast levels of an image in



 

 

Photoshop. When used together with ambient lights, the color and brightness of the lights 

control the amount of ambient color specified in this attribute, which will contribute to the 

final render. 
 

Incandescence Controls the self‐illumination, or luminance, of the object. This attribute 

creates the illusion that the object is emitting light. The material will illuminate the color set 

using the Color Chooser with the brightness amount set with the slider. Note, however, that 

this will not cause the object to illuminate any objects around it. 

 
 
 

Bump Mapping Alters the surface normals to create the illusion of raised areas and 

indentations on a surface. This attribute uses an 8‐bit grayscale image to assign 

transparency values: 0 (black) is the lowest or deepest, while 1 (white) appears to be 
 

raised or highest. 
 

Diffuse Sometimes called falloff, this attribute controls the amount of light reflected back 

from the surface. At a value of 1, the surface will reflect back 100 percent of the color 

specified in the color channel. The default value is 0.8. 
 

Translucence Controls the amount of light that can pass through an object. Think of the way 

light travels through wax, leaves, and certain plastics and rubbers. At a setting of 0.0 (the 

default), no light shows through. At 1.0, all light shows through. 
 

Translucence Depth Controls the amount of decay that will occur as the light moves through 

the object. When the value is set to 0, no decay occurs and the light emitted through the 

other side will be just as bright. In most cases, the light will lose some of its brightness and 

decay before it reaches the other side of the object. 
 

Translucence Focus Sets the amount of blurring on the surface of backlit objects. The light 

scattering on a thin surface, such as a leaf or skin, will cause this effect. At 0.0, light is 

scattered in all directions. 

 
 
 

Specular Shading Attributes 
 

As mentioned, specularity controls the reflectivity of a surface. Even a surface that doesn’t 

necessarily reflect objects around it will reflect the light sources that illuminate it. This is 

known as the specular reflection. The specular attributes differ slightly depending on the 

material you are using. Usually some type of control can be used for the size of the highlight 



 

 

and another control for how it falls off; this is illustrated in Figure given below. Some 

materials, such as the Phong material, use composite algorithms to calculate the specular 

shading; others, such as Phong E, Blinn, and Anisotropic, break up the specular attributes 

into several attributes for finer control. The Anisotropic material even lets you control the 

shape of the specular reflections. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The reflectivity of an object determines how much of the environment or other objects will 

be reflected from the surface. The color of the reflection is determined by the reflected 

Color attribute. For a surface to reflect objects around it, raytracing 
 

must be turned on in the Render Settings window. Because raytracing is very processor‐
intensive, it can take a long time to render. 
 

Consequently, reflections sometimes faked by applying an environmental reflection map to 
the reflected Color attribute. 
 

Texture Nodes 
 

Texture nodes contain the picture or pattern that will be mapped onto a material. In Maya, 

you can use a procedural texture or a file texture. 
 

Procedural Textures 
 

Procedural textures are completely computer generated from mathematical equations. 

Checker, bulge, fractal noise, and cloth are all examples of procedural textures. Each has its 

own specific parameters to achieve its unique results. One of the biggest advantages of 

using procedural texture maps is that they are resolution‐ independent. Whereas 

bitmapped file textures start to soften and break apart as you zoom closer, procedural 

textures remain infinitely sharp no matter how close you get.

 

 

A subset of procedural textures is called 3D textures. Because a procedural texture is not 
limited to 2D pixel information, the



 

 

computer is able to calculate the depth of a texture. Marble or any kind of rock is a good 
example from the real world. The 
 

patterns in marble are continuous through its mineral layers, changing slightly from slice to 

slice. A 3D texture in Maya behaves the same way. This texture is especially useful if the 

surface is semitransparent. 

 
 
 

File Textures 
 

File texture nodes contain a bitmapped image that is imported into the scene. This image 

can be loaded through the Image Name attribute in the file texture node’s Attribute Editor. 

Further adjustments can be made to this image in the Color Balance section of the file 

texture’s Attribute Editor. Color Gain and Color Offset control the brightness and contrast of 

the texture’s RGB channels, and Alpha Gain and Offset control the levels of the file texture’s 

alpha channel. 
 

Placement Nodes 
 

A placement node is a type of utility node. These nodes are automatically created with and 

connected to a texture node. They can also be created through the Create tility menu. 

Placement nodes control how a texture is mapped to a surface. Two 
 

basic kinds of placement nodes can be used: 2D and 3D. To understand the difference 

between these nodes and how to use them, we first need to talk about how a texture is 

mapped to a surface. 
 

2D Placement Node 
 

Whenever you are dealing with a 2D texture—whether it’s a procedural or a bitmap image 

you will use at least the 2D placement node. This node controls how the texture map is 

placed within the UV space from 0 to 1. Let’s take a look at some of 
 

the attributes of the 2D placement node and the ways they affect how the texture is 

mapped. The first three attributes listed in the Attribute Editor deal with how the texture 

frame is laid out. The rest of the attributes deal with how the texture behaves 
 

within that frame. 
 
 

 

Coverage Controls the amount of surface the texture covers. A value of 0.5 for the U value 

covers 50 percent of the surface in the U direction. This value can be interactively changed 



 

 

in the view window by clicking the Interactive Placement button in the 2D placement node’s 

Attribute Editor and MMB‐dragging the edge of the 2D placement frame on the surface in 

the view window. 
 

Translate Frame Sets the position of the covered area. This value can be interactively edited 

in the view window using the placement tool: MMB‐drag in the middle of the frame and 

position the texture in the desired position. 
 

Rotate Frame Orients the covered area. To rotate the frame interactively with the 

placement tool, MMB‐drag one of the corners of the frame. Mirror U and V Mirrors the tiles 

next to one another to hide possible tiling artifacts, such as seams. This attribute requires 

that the Repeat values be set to more than 1. 
 

Wrap U and V Sets whether a map is repeated in U and V over the entire surface. 
 

RepeatUV Specifies how many copies of the texture map are mapped within the coverage 
area along either the U or V direction. 
 

This is sometimes called tiling. 
 

Offset Offsets the pattern of the texture map. 
 

RotateUV Rotates the texture itself. Realize that this differs from Rotate Frame in that the 

actual transforms of the frame remain. It is just the texture map within that frame that 

rotates. Noise UV Randomly displaces the colors of the texture. This can be helpful in 

breaking up recognizable repetitions or patterns. 
 

3D Textures and 3D Placement Nodes: 
 

As mentioned, the 3D placement node is used mainly to position a texture or projection 

node in 3D space. While you have already seen how it is used to position a projection node 

that is projecting a 2D texture, you’ve not yet seen it used for a 3D texture. A 3D texture is a 

special kind of procedural texture map. Instead of being a flat surface, the 3D texture has 

depth to it. This means that you could map a 3D texture to a sphere and not worry about it 

stretching anywhere. All points in the surface in 3D space are evenly mapped. The 

place3dTexture node positions the 3D texture. This illustration shows a 3D marble texture 

applied to a head. The box around the head is the placement node used to position the 

texture. The 3D placement node is really not much more than a basic transform node. In this 

situation, the placement node is positioned in world space. The transform tools are used to 



 

 

move, rotate, and scale the texture. Since the placement of a 3D texture is based on the 

place3dTexture node’s world space coordinates, realize



 

 

that any object with a projection or texture that is mapped with a 3D placement node will 

“move through” the 3D texture space when the object is transformed in any way. 

 
 
 

One way to avoid this would be to group the place3dTexture node to the object to which it 

is being mapped. However, while this will work fine for rigid objects such as spaceships or 

cars, you’ll have problems if the mapped geometry deforms. Therefore, when using 3D 

textures that need to stay put, it is a good idea to “bake” them onto a material. This can be 

done by selecting the material node and the surface it is mapped onto and choosing Edit | 

Convert to File Texture in the Hypershade. This will save a texture map corresponding to 

how the material is mapped to the surface and will create a duplicate of the material with 

the texture nodes mapped as normal textures. 

 

 

6.5 IPR RENDER 
 

 

There are a few limitations to using IPR for fast visual feedback as you adjust shading and 

lighting. Besides being unable to provide production‐quality anti‐aliasing, IPR cannot display 

several other advanced display characteristics, for example, true surface reflections 

(raytracing) and 3D motion blur. If an advanced display characteristic seems to be missing 

from an IPR‐rendered frame, try rendering the frame with the software renderer. 

 

If you change the camera view, turn Depth Map Shadows on or off, or reposition shadows, 

IPR does not update the rendered image automatically. You must refresh the image. From 

the Render View window, select IPR > Refresh IPR Image. 

 

6.6 Material 
 

 

A material type (also referred to as a shading model) defines how a particular shading 

material on a surface simulates a natural reaction to light. Blinn, Phong, and Lambert are a 

few examples of material types available in Maya. Each of these material types provide 

distinct shading characteristics based on the mathematical algorithms that define them. 

 

From the settings you’ve made so far, you may decide you want to give the orange a 

different look than possible with the Blinn material. You will now change to a different 



 

 

material for comparison.Getting Started with Maya 466 9 | Rendering Lesson 2 > Assigning 

textures 

 

To set the material type 
 

 

1 Next to the Type attribute near the top of the Attribute Editor, pull down the menu 
and select Phong E. 
 

 

Phong and Phong E are variations of the Lambert material type, with specular highlights 

added. The main difference between materials is the way each handles specularity. By 

switching between the material types, you can compare which material gives you the 

specularity you need. 

 

Your settings for the Color and Diffuse attributes are maintained because they are common 

to all material types. The Specular Shading and all other attribute settings do not convert 

when you change the material, so it’s best to choose your material before you make many 

changes. 

 

2 In the Specular Shading section, you can leave Roughness and Highlight Size at the 

default settings. The default highlight settings give the orange a waxy look. 

 

These attributes are similar to the Blinn attributes, Eccentricity and Specular Roll Off. Unlike 

the Blinn counterparts, these highlights do not appear in the scene view. You can see the 

highlights only in a rendered image and in the Material Sample. 

 

3 he Phong E material type has a Whiteness attribute not available with Blinn. Change 

Whiteness to a light gray to accentuate the highlights. 

 

This change is subtle, so drag the slider back and forth while watching the effect in the 
Material Sample or in an IPR region. 
 

Look for the entire highlighted area to become whiter. Again, a strong highlight will create a 
waxy look.



 

 

6.7 Summary 
 
 

By now, you should have a pretty good idea of how to create and edit materials and be 

somewhat comfortable with using the Hypershade to make connections between nodes. 

 

6.9 Assessment 

 

1. Explain Hypershade 
 
2. Explain IPR render 
 

Short notes 
 

1. Raytracing 
 
2. Lambert 
 
3. Material 
 
4. Shading 
 
5. 2d texture and 3d texture 
 

6.10 Further Reading 
 

1. Introducing Autodesk Maya 2013 Dariush Derakhshani 
 
2. Learning Autodesk Maya 2009 Foundation: Official Autodesk Training .Autodesk 
Maya Press, Marc‐André Guindon



 

 

Unit 7 EDITING UVS 
 
 
 
 
 
 

 

Learning Outcome 
 

After going through this unit, you will learn: 
 

• UV 

 

• UV Texture Editor 
 
• Create UVs  
 
 
 
 
 
 
 

 

Time Required to Complete the unit 
 

 

The time required to study thus Unit is broken as follows 
 

1. 1
st

 Reading: It will need 2 Hrs for reading a unit 
 
2. 2

nd
 Reading with understanding: It will need 3 Hrs for reading and understanding a unit 

 
3. Self Assessment: It will need 3 Hrs for reading and understanding a unit 
 
4. Revision and Further Reading: It is continuous process  
 
 
 
 

 

Content Map 
 
 

 

7.1 UVs 
 

7.2 Mapping 
 

7.3 UV Texture Editor 
 

7.4 Create UVs 



 

 

7.5 Summary 
 

7.6 Self Assessment Test 
 

7.7 Further Reading  
 
 
 
 
 

 

7.1 UVs 
 

UV texture space is another coordinate system in 3D and it is used for mapping textures on 

surfaces and UVs are points that provide the information needed to apply textures to the 

surface. Subdivision surfaces and polygons require specific arrangement of the UVs so that 

textures look correct when applied to the surface material. Typically, you arrange UVs after you 

have completed your modeling and before you assign textures to the model. UVs act as marker 

points that control which points (pixels) on the texture map correspond to which points 

(vertices) on the mesh. You can see the texture space coordinates in UV Texture Editor. 

 

 

7.2 Mapping 
 

UV mapping is a process whereby you creat e, edit, and otherwise arrange the UVs that appear 

as a flattened, two‐dimensional representation of the surface mesh, over top of the two‐

dimensional image to be used as a texture as it appears in the UV Texture Editor. UV mapping is 

a critical skill to master for accurate and realistic textures on polygonal surfaces. In Maya, UV 

texture coordinates (UVs) can be created for polygon 

 

surface meshes using the following UV mapping techniques: 

 

1. Automatic UV mapping 

 
2. Planar UV mapping 

 
3. Cylindrical UV mapping 

 
4. Spherical UV mapping 

 
5. User‐defined UV mapping



 

 

6. Camera UV mapping 

 

Automatic UV mapping 

 

Automatic mapping creates several UV map pieces or shells in texture space by attempting to find 

the best UV placement by simultaneously proj ecting from multiple planes. 

 

Planar UV mapping 

 

Planar mapping projects UVs onto a mesh through a plane. This type of mapping is best suited 

for planer objects. 

 

Cylindrical UV mapping 

 

Cylindrical mapping creates UVs for an object based on a cylindrical projection shape that gets 

wrapped around the mesh. This type of mapping is best suited for cylindrical objects. 

 

Spherical UV mapping 

 

Spherical mapping create UVs using a projection that is based on a spherical shape wrapped 

around the mesh. This type of mapping is best suited for spherical objects. 

 

User‐defined UV mapping 

 

User‐defined UV mapping is same as the automatic mapping. The only difference is that in user‐

defined y ou can map UV texture coordinates by specifying user‐defined planes for UV 

projection using the Load Projection option. 

 

Camera UV mapping 

 

The camera UV mapping creates a Planar UV mapping. The current camera view plane is used as 

the plane for the planar projection. 

 

7.3 UV Texture Editor 
 

The UV Texture Editor lets you interactively edit UV texture coordinates for polygons and 

subdivision surfaces. You can select, move, scale, and generally modify the UV topology for a 

surface. You can also view the image associated with the assigned texture map as a



 

 

backdrop within the UV Texture Editor and modify the UV layout to match as required. 

 

UV Toolbar 
 
 

UV Lattice Tool This tool is used to manipulate the lay out of UVs as a group by letting you 

create a lattice around the UVs for deformation purposes. 

 

Move UV Shell Tool 
 
 

Move UV Shell tool lets you select and reposition a UV shell by selecting a single UV on the shell. 

 

UV Smudge Tool 
 
 

UV Smudge Tool moves the position of selected UVs and their neighboring UVs. Select Shortest 

Edge Path Tool The Select Shortest Edge Path Tool determines the most direct path between 

any two selection points and selects the polygon edges in between. 

 

Flip U 

 

It flips the positions of the sele cted UVs in the U direction. 

 

Flip V 

 

It flips the positions of the sele cted UVs in the V direction. 

 

Rotate UVs counterclockwise 
 
 

It rotates the positions of the selected UVs by 45 degrees in a counterclockwise direction. 

 

Rotate UVs clockwise 

 

It rotates the positions of the select ed UVs by 45 degrees in a clockwise direction. 

 

Cut UVs along selection



 

 

This tool separates UVs along t he selected edges, creating borders. 

 

Split UVs 
 
 

This tool separates UVs from each other along the edges connected to the selected UV points, 

creating borders. 

 

Sew UVs 
 
 

Attaches UVs along the selected borders, but does not move them together in the texture editor 

view. 

 

Move and Sew UVs 
 
 

Attaches UVs along the selected borders, and moves them together in the texture editor view. 

 

Layout 

 

This tool attempts to arrange the UVs into a cleaner layout. 
 
 

Grid UVs This tool moves every selected UV to its nearest grid intersection in editor window. 

 

Unfold 
 
 

Unfold unwraps the selected UV mesh while attempting to ensure that the UVs do not overlap. 

 

Relax 

 

Relax spreads out the selected UV mesh to make it easier to work with. 

 

Align Min U 

 

This tool aligns the positions of the selected UVs to the minimum U value.



 

 

Align Max U 

 

This tool aligns the positions of the selected UVs to the maximum U value. 

 

Align Min V 

 

This tool aligns the positions of the selected UVs to the minimum V value. 

 

Align Max V 

 

This tool aligns the positions of the selected UVs to the maximum V value. 

 

Toggle Isolate Select Mode 

 

This tool switches between showi ng all UVs and only the isolated UVs. 

 

Add selected to isolation 

 

This tool adds the selected UVs to the set of isolated UVs. 

 

Remove selected from isolation 

 

This tool removes the selected UVs from the set of isolated UVs. 

 

Remove all 

 

This tool clears the isolated subset. 

 

Display Image 

 

Display Image tool shows or hides the texture image in the editor window. 

 

Toggle Filtered Image 
 
 

This tool switches the background im age between hardware texture filtering and sharply 

defined pixels.



 

 

Dim Image 

 

This tool reduces the brightness of the currently displayed background image. 

 

View Grid 

 

View Grid option displays or removes the grid. 

 

Pixel Snap 

 

If this is on, UVs automatica lly snap to pixel boundaries. 

 

Shade UVs 
 
 

This tool shades selected UV shells in a semi‐transparent fashion so you can determine areas 

where UVs overlap. 

 

Toggle Texture Borders 

 

This option toggles the display of texture borders on UV shells. 

 

Display RGB Channels 

 

This option displays the RGB channel s of the selected texture. 

 

Display Alpha Channel 

 

This option displays the Alpha channel of the selected texture. 

 

UV Texture Editor Baking 

 

This option bakes the texture and stores it in memory. 

 

Update PSD Networks 

 

This option updates or refreshes the PSD textures currently in use for the scene.



 

 

Force editor texture rebake 

 

This option rebakes the texture after you make changes to the textures. Use Image Ratio 

 

If this is on, the texture will be shown in its aspect ratio. 

 

7.4 Create UVs 
 

Creates UV texture coordinates for the selected object based on the current camera view as a planar 

projection. T hat is, the camera view becomes the plane of projection. 

 

Best Plane Texturing Tool 
 
 

Assigns UVs to the faces you select based on a plane computed from vertices you specify. 

 

Assign Shader to each Projection 
 
 

When Assign Shader to each Projection is turned on, a shader with a checkerboard texture is 

assigned to the selected mesh as you project UV texture coordinates. This aids in determining t 

he alignment of the UVs by providing a known visual reference. The default setting is off. 

 

Create Empty UV set 
 
 

Creates a new, empty UV set on the current object. You can then create the UVs in the set using 

one of the mapping/proj ection methods. This feature is also available for use from the Polygons 

menu in the UV Texture Editor. 

 

Copy UVs to UV set 
 
 

Creates a new UV set based on an existing UV layout or transfers a UV layout from one set to 

another. This feature is also available for use from the Polygons menu in the UV Texture Editor. 

 

Set Current UV set



 

 

Lets you specify which UV set you want to use for a particular polygon mesh. You specify which 

set you want by typing t he name of the UV set in the text field that appears. This feature is also 

available for use from the Polygons menu in the UV Texture Editor. 

 

Rename Current UV set 
 
 

Lets you rename the currently selected UV set. This feature is also available for use from the 

Polygons menu in the UV Texture Editor. 

 

Delete Current UV set 
 
 

Deletes the currently selected UV set. This feature is also available for use fromthe Polygons 

menu in the UV Texture Editor. 

 
 

 

7.5 Summary 
 

In chapter we covered UVs and UV textrure editor. 
 

7.13 Self Assessment Test 
 

1. What is Mapping ? 
 
2. What is uv texture editor? 
 
 

 

Short notes 
 

1. Automatic Mapping 
 
2. Camera UV Mapping 
 
3. unfold 
 
4. relax 
 
5. Update PSd network



 

 

7.14 Further Reading 
 

1. Introducing Autodesk Maya 2013 Dariush Derakhshani 
 
2. Learning Autodesk Maya 2009 Foundation: Official Autodesk Training .Autodesk 

Maya Press, Marc‐André Guindon



 

 

Unit 8 LIGHTING 
 
 
 

 

Learning Outcome 
 

After going through this unit, you will learn: 
 

• Light 
 
• Light linking 

 
• Maya software Rendering  
 
 
 
 
 
 
 

 

Time Required to Complete the unit 
 

 

The time required to study thus Unit is broken as follows 
 

1. 1
st

 Reading: It will need 2 Hrs for reading a unit 
 
2. 2

nd
 Reading with understanding: It will need 3 Hrs for reading and understanding a unit 

 
3. Self Assessment: It will need 3 Hrs for reading and understanding a unit 
 
4. Revision and Further Reading: It is continuous process  
 
 
 
 
 
 
 

 

Content Map 
 

8.1 Creating lights 
 

8.2 Lighting Types 
 

Create > Lights 
 

Setting up for lighting 
 

8.3 Concept of three point lights 
 

8.4 Light Linking 



 

 

8.5 Light Baking 
 

8.6 Indirect Illumination 
 

8.7 Shadows 
 

8.8 Maya Software Rendering 
 

8.9 Maya Hardware Rendering 
 

8.10 Summary 
 

8.11 Assessment 
 

8.12 Further Reading  
 
 
 
 
 
 
 

8.1 Creating Lights 
 

Maya’s light nodes are designed to work just like lighting in the real world. This allows a 

traditional lighting designer to begin using Maya quickly, because the tools have familiar names 

and behaviors.Traditionally, lights serve two main purposes in film and still photography. The 

first is, obviously, to illuminate the scene being photographed. 

 

Without light there would be no color—the printed film would be nothing but black. The other 

purpose for lighting is to add a dramatic effect or mood to a scene.In fact, lighting may be one of 

the first visual effects ever used. Heroic characters are traditionally well lit, even shining, 

whereas villains lurk in shadows or arebacklit. Just as it is important to do research and collect 

references on your modelsand textures, it is important to take notice of lighting, both in the 

natural world and in the movies. 

 
 

 

8.2 Lighting Types 
 

Maya’s light nodes are designed to work just like lighting in the real world. This allows a 

traditional lighting designer to begin using Maya quickly, because the tools have familiar names 

and behaviors.Traditionally, lights serve two main purposes in film and still photography. The 

first is, obviously, to illuminate the scene being photographed.



 

 

Types of Lights 
 

Maya has sixdifferent types of lights: ambient, area, directional, point, spot, and volume. 
 

All these lights can be created from the mainCreate|Lights menu or in the Create Lights menu in 

the Hypershade. The different types of lights (shown in fig below) 
 

create the following effects: 
 

• Ambient light simulates diffused lighting in all directions. Use this light as a fill light 

to brighten the dark areas of the scene or to even out the lighting entirely. 
 

Directional 
 

Point 
 

Spot 
 

Volume 
 

• An area light is a 2D rectangular light source. The size of the light, which can be 

determined using the standard scale tools, has a direct effect on the distribution ofthe light in 

the scene. Sunlight coming through a window is a common example: the light can be caled to fit 

the window shape while the reflection of the light on, say, the floor is brightest closest to the 

window and falls off farther away from the window. 

 
• Directional light shines evenly in one direction only, such that the rays are emitted 

parallel to each other from an infinitely large plane. Use this light to simulate a light source such 

as the sun. Maya uses a directional light as the default light in the scene. 

 
• A point light shines evenly in all directions from the location of the light. Use a point light 

to simulate an incandescent light bulb. 

 
• A spot light shines evenly within a narrow range of directions (defined by a cone) from 

the location of the light. 

 

Use a spot light to create a beam of light that gradually becomes wider—for example, a 

flashlight or car headlight. 

 

• A volume light illuminates objects within a finite region defined by a primitive shape: 

sphere, box, cylinder, or cone. The direction of the light can be set to outward, inward, or down, 

making a volume light capable of simulating many of the other light types in Maya.



 

 

Another advantage of using a volume light is that its total decay distance is indicated by its icon 

in the view window, so precise placement is easily achieved without having to do numerous test 

renders. The color range is also controllable through a ramp interface. This allows you to control 

the color of the light at any point along its volume decay. It can also be used to control the 

falloff. 

 
 
 

 

8.3  Concept of three point lights 
 

 

The Three Point Lighting Technique is a standard method used in visual media such as video, 

film, still photography and computer‐generated imagery. It is a simple but versatile system 

which forms the basis of most lighting. Once you understand three point lighting you are well 

on the way to understanding all lighting. 

 

The technique uses three lights called the key light, fill light and back light. Naturally you will 

need three lights to utilise the technique fully, but the principles are still important even if you 

only use one or two lights. As a rule: 
 

• If you only have one light, it becomes the key. 
 

• If you have 2 lights, one is the key and the other is either the fill or the backlight.  
 
 

 

Key Light 
 
 

This is the main light. It is usually the strongest and has the most influence on the look of the 

scene. It is placed to one side of the camera/subject so that this side is well lit and the other 

side has some shadow.



 

 

 

Fill Light 
 
 

This is the secondary light and is placed on the opposite side of the key light. It is used to fill the 

shadows created by the key. The fill will usually be softer and less bright than the key. To acheive 

this, you could move the light further away or use some spun. You might also want to set the fill 

light to more of a flood than the key. 
 
 
 

 

Back Light 
 
 

The back light is placed behind the subject and lights it from the rear. Rather than providing 

direct lighting (like the key and fill), its purpose is to provide definition and subtle highlights 

around the subject's outlines. This helps separate the subject from the background and 

provide a three‐dimensional look. 

 
 
 
 

If you have a fourth light, you could use it to light the background of the entire scene. 
 

 

8.4 Light Linking 
 

With the help of light linking you can link lights with the nodes in the scene. When you link the 

light to a specific node, the light will affect that node only. Light linking is done using Relations 

hip editor. Two type of light linking are available: 

 

light centric in which you c onnect light to the illuminated objects and other one is object centric 

in which a specific obj ect (node) is connected to the lights.



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

8.5 Iight Baking 
 
 

 

This process is also called Light Mapping. 
 
 

Light Baking is a method of sampling an object before rendering, and storing the results for later 

on uses. 

 

It is the most common application that samples illumination for each point of a texture image 

wrapped around to the object and stores that illumination in the texture. Here the Illumination 

is effectively frozen into the texture and later it can be mapped onto an object in the 

conventional way. 

 

Light Baking was introduced with mental ray 3.0. It is very flexible and user friendly to use as it is 

given in ment al ray. Here Lightmap Shaders are very supportable with this option here. When 

you attach Lightmap Shader to the material then the Light Baking gets on for the object on 

which you have applied the same material. 

 

The advantage of Light Baking is that rendering can obtain illumination quickly from the frozen 

illumin ation, instead of computing it at rendering time which takes a long time as per the file 

size and t he calculation of the bounced lights. It is especially valuable for indi rect illumination 

which take s more time to compute than direct illumination. So, it is very useful in gaming. 

 

8.6 Indirect Illumination



 

 

 
 
 

 

Indirect Illumination is also called Global Illumination. 
 

Indirect Illumination is the technique used to capture indirect illumination, the natural 

phenomenon wher e light gets bounced off anything in its path until it is completely absorbed in 

the environment. Illumination is the calculation of the bounced light. Direct Illumination is the 

light which falls on the object directly and gets bounced from the object and the object is visible. 

Indi rect Illumination is the light which is already bounced by the object and is spread in the 

environment. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Here the objects in the place where the light is not falling they are also becoming visible to 
 

our eyes. For exam ple – If the light enters in a dark closed room from a small window then 
 

also all the area and objects are becoming visible to our eyes. They are not very bright to 
 

see but you can see each of them at least. This happens due to the light which gets 
 

bounced by the object on which it falls. Here the intensity and material of the object which 
 

bounces the light is also very 
 

important.  
 
 
 
 
 

8.7 Shadows 
 

 

Shadows are the darkened areas which appear on a surface as an object gets in the path of a light 

source. Shadows fall onto the area of a surface that doesn’t directly receive light and



 

 

which is opposite to the light. Shadows ground the objects in your scene and help in defining 

their three‐dimensional appearance. Shadows make your scene real looking. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

8.8 Maya Software Rendering 
 

Software Rendering 
 

Software rendering produces images of t he highest quality, letting you achieve the most 

sophisticated results. Maya has the following software renderers: 

 

1. The Maya software renderer: Maya’s software renderer is an advanced, multi‐threaded 

renderer. It is a hybrid renderer, of fering true raytracing plus the speed advantages of a scan‐line 

renderer. The Maya software renderer supports all of the various entity types found within Maya 

including particles, various geometr y and paint effects and fluid effects. 

 

The Maya software renderer features IPR, a tool designed to allow you to make interactive 

adjustments to t he final rendered image, and which greatly enhances rendering productivity. Most 

importantly, the nature of Maya's integrated architecture allows complex interconnections, like 

procedural textures and ramps that govern particl e emission and other unpredictable relationships 

that are capable of pr oducing stunning visual effects. 

 

2. mental images mental ray for Maya : mental ray for Maya offers all the features 

traditionally expected of photorealistic rendering and includes functionality not found in most 

renderi ng software. mental ray for Maya allows interactive and batch mental ray rendering 

from within the Maya user interface.



 

 

8.9 Maya Hardware Rendering 
 

Hardware rendering uses the computer's video card and drivers installed on the machine to 

render images to disk. Hardware rendering is generally faster than software rendering, but 

typically produces images of lower quality compared to software rendering. Hardware rendering 

cannot produce some of the most sophisticated effects, such as some advanced shadows, 

reflections, and post‐process effects. To produce these kind of effects, you must use software 

rendering. 
 

8.9 Summary 
 

In this chapter, you learned about the different types of lights and their properties. The techniques 

shown in the tutorials outlined some very useful procedures you can use to create some very 

realistic lighting effects without using any physically accurate rendering schemes. As you will see in 

the next chapter, while these new rendering schemes produce very realistic lighting conditions, they 

come at a cost of rendering time. 

 
 

 

8.10 Self Assessment test 
 

1. What is light? 
 
2. Explain Types of lighting 
 

Short Notes 
 

1. Volume light 
 
2. Maya Hardware Render 
 
3. Maya Software Render 
 
4. Shadow 
 
5. Light Baking 
 
 

 

8.11 Further Reading 
 

1. Introducing Autodesk Maya 2013 Dariush Derakhshani



 

 

2. Learning Autodesk Maya 2009 Foundation: Official Autodesk Training .Autodesk
 

Maya Press, Marc‐André Guindon



 

 

Unit 9 RENDERING AND CAMERA 
 
 
 

 

Learning Outcome 
 

After going through this unit, you will learn: 
 

• Cameras 
 
• DOF 

 
• Motion blur  
 
 
 
 
 
 
 

 

Time Required to Complete the unit 
 

 

The time required to study thus Unit is broken as follows 
 

1. 1
st

 Reading: It will need 2 Hrs for reading a unit 
 
2. 2

nd
 Reading with understanding: It will need 3 Hrs for reading and understanding a unit 

 
3. Self Assessment: It will need 3 Hrs for reading and understanding a unit 
 
4. Revision and Further Reading: It is continuous process  
 
 
 
 

 

Content Map 
 

9.1 CAMERAS 
 

9.2 Explain Camera and its uses. 
 

9.3 Creating And Animating Cameras 
 

9.4 To Create a new camera 
 

9.5 Create > 
 

9.5 Camera Attributes and Effects 
 

9.6 Batch Rendering 



 

 

9.7 Depth Of Field 
 

9.8 Motion Blur 
 

9.9 Summary 
 

9.10 Assessment 
 

9.11 Further Reading  
 
 
 
 
 
 

 

9.1 Cameras 
 

In Maya, two types of cameras are available: Perspective and Orthographic. By default, you have 

three orthographic cameras, Top, Front and Side and one perspective camera Perspective 

(preps). For rendering, you must use custom (user) cameras 

 
 

 

9.2 Explaing Cameras and it uses 
 
 

The . You can place custom cameras anywhere in the scene; even inside a very small thing as well as 

you can animate custom cameras. You have three types of custom cameras: 

 

a) Camera: You can use camera for static scenes or simple animation. 
 
b) Camera and Aim: You can use camera and aim to create little complex animations 

where camera should focus on something like a randomly flying insect 

 
c) Camera, Aim and Up: You can use camera, aim and up in such animation where you 

want to control the up axis of the camera too. 

 
 

 

9.3 Creating And Animating Cameras 
 

When you first begin animating the camera, it helps to follow the rules of videography, such as 

avoiding jarring camera motions—rapid pans, zooms, or rotations of the camera. In addition, you 

should usually give the camera the impression of having mass. The virtual



 

 

camera, by default, starts and stops moving instantly, which looks unrealistic and abrupt to 

viewers. To avoid this problem, adjust the tangents for the camera position's start and stop keys 

in the Graph Editor so that motion begins and ends gradually . Do the same for the camera's aim 

point keys and any other animated camera attributes 

 
 

 

9.4 To Create a new camera 
 

Create > Cameras > Camera 

 

There are three types of perspective cameras in Maya. As with Maya's lights, you can change a 
camera to any other camera type in the Attribute Editor. 
 

Camera  

 

With this camera type, you see only the camera icon. In general, because this camera freely 
rotates and loses track of its "up" vector, you should use it only when you're linking the camera 
to another object for movement and animation, or when you're placing a camera in one fixed 
spot. 
 

Camera and Aim  

 

This camera includes a camera target and an aim handle for adjusting the camera target. In 
addition, this camera automatically stays level in relation to the horizon, so it's the one you'll 
use most often. You can make this camera roll if you want, but by default, it stays level except at 
extreme straight‐up or straight‐down orientations. 
 

Camera, Aim and Up  

 

This camera type includes two handles: the aim handle, described for Camera and Aim, and an 
up handle for banking (leveling) the camera. This camera type is useful when you want to bank 
the camera during your animation. 
 
 
 
 
 
 
 
 

 

9.5 Camera Attributes and Effects



 

 

A camera’s exposure settings determine depth of field (the region of sharp focus), and whether or 

not subject matter is crisp or blurred by motion. In real‐world photography, together the fStop and 

shutter speed determine how much light is exposed to film. However, fSt op and shutter speed also 

determine what is in focus. The length of time light is allowed to pass through the camera lens to the 

film is determined by the shutter speed. The higher the s peed, the shorter the exposure time, the 

less light exposed to the film. The amount of light that is allowed to pass through the camera lens to 

the film is determined by the camera’s aperture setting (also known as the fStop). The wider the 

aperture, the 

 

more light exposed to the film. 
 

Major Attributes of the camera are: 
 

Angle of view/Focal Length 
 

The focal length of a lens is the distance from the center of the lens to the film plane. The 

shorter the focal length, the closer the focal plane is to the back of the lens. Increasing the Focal 

Length zooms the camera in and increases the size of objects in the camera’s view. Decreasing 

the Focal Length zooms the camera out and decreases the size of objects in the camera’s view. 

Lenses are identified by their focal length. Focal leng th is expressed in millimeters. 
 

Camera scale 
 

Scales the size of the camera relative to the scene. If camera Scale is 0.5, the camera’s view 

covers an area half as large, but objects in the camera’s view are twice as large. 
 

Auto Render Clip Plane 
 

If this is on, the near and far clipping planes are automatically set so they enclose all objects 

within the camera’s view. Th is option works only with Maya software renderer. If off, the near 

and far clipping planes are set to the Near Clip Plane and Far Clip Plane attribute values. 

 

Film Back 
 

The Film Back attributes control the basic properties of a camera. 
 

1. Film Gate: Film Gate lets you select a preset camera type.



 

 

2. Camera Aperture: The height and width of the camera’s Film Gate setting, measured in 

inches. 
 
3. Film Aspect Ratio: The ratio of the camera aperture’s width to its height. 
 
4. Lens Squeeze Ratio : The amount the camera’s lens compresses the image horizontally. 

Some cameras, anamorphic cameras, compress the image horizontally to record a large aspect 

ratio image onto a square area on film. 

 
5. Fit Resolution Gate: Fit resolution gate controls the size of the resolution gate relative to 

the film gate. 

 
6. Film Fit Offset : Film fit offset offsets the reso lution gate relative to the film gate either 

vertically or horizontally. 

 
7. Film Offset: Film offset offsets vertically and horizontally the resolution gate and the film 

gate relative to the scene. 
 
8. Pre Scale: This value indicates the artificial 2D camera zoom. 
 
9. Film Translate: The Film Translate value in dicates the artificial 2D 
 

camera pan. 
 

10. Film Roll Pivot: The Film pivot point is used to rotate from the center of the film back. 
 
11. Film Roll Value: This specifies the amount of rotation around the film back. 
 
12. Film Roll Order : Film Roll order specifies how the roll is applied with respect to the 

pivot value. 
 

Output Settings 
 

Output settings controls whether the camera generates an image during rendering, and what 

types of images the camera renders. 

 

1. Renderable: If on, the camera can create an image file, mask file, and, or depth file 

during rendering. 
 
2. Image : If on, the camera creates an image file during rendering. 
 
3. Mask: If on, the camera creat es a mask during rendering.



 

 

4. Depth : If on, the camera creates a depth file during renderin g. A depth file is a type of 

data file that represent s the distance of objects from the camera. 

 
5. Depth Type: This option determines how to compute the depth of each pixel. 

Environment 

 
Environment control the appearance of the scene’s background as seen from the camera. 
 
1. Background Color : This is the color of t he scene’s background when it is rendered. 
 

2. Image Plane : You can not apply texture to background color. For textures, you can 

create an Image plane and then apply texture on the plane. 
 

Shutter Angle \ 
 

The Shutter Angle influences the blurrines s of objects of motion blurred objects. 
 

The larger the Shutter angle setting, the more blurry objects. Shutter Angle is measured in 

degrees. 

 
 

 

9.6 Batch Rendering 
 

Generally Maya renders only the current frame. If you want to render number of frames 

(animation), you have to use batch render. You can give the batch render command from the 

Maya and you can also batch render from the command prompt. Before giving the command, 

make the following changes in the render options: 
 

1. Set the filename. 
 
2. Set the Frame/Animation extension for the file. 
 
3. Set the Image format, for example single file like avi or you can generate sequence of 

images. 
 
4. Set the video compression. 
 
5. Set the starting and ending frames. 
 
6. Set the camera through which you want to render. 
 
7. Set the Image size in which you want to render.



 

 

8. In Maya Software tab set Anti‐ali asing quality to Production quality. 
 
9. If Reflection and Refraction is used then Activate Raytracing. 
 
10. Then go to Rendering menu set, R ender Menu and choose batch render. In the batch 

render option box you can s pecify whether to you all the available 

 

processors or you can enter number of processes. These work only on multi‐processor 

machines. You can continue us ing the Maya or you can close Maya and start working on 

different application while batch rendering is going. 

 
 

 

9.7 Depth of Field 
 

Depth of field is the region of sharp focus in a photograph. Depth of field is determined by the 

camera’s aperture se tting. At wide aperture settings, the depth of field is shallow. At narrow 

aperture settings, the depth of field is deep, and more of the foreground and background is in 

focus. 

 

9.8  Motion Blur 
 

Motion blur gives the feeling of motion. Motion blur is determined by the shutter speed. Fast 

motion appears motion blurred at slower shutter speeds. Motion blur can be turned on and off 

on a per‐object basis. 
 

9.9 Summary 
 

In this chapter, you learn how to Render a preview quality for test renders and how to render 

final output, Film Quality with the software renderer. You also learn how to apply Motion blur 

and environment fog to the scene. In the next chapter you will learn Mental ray rendering. 

 
 

 

9.10 Self Assessment Test 
 

1. Explain Types of Camera. 
 
2. Explain Depth of Field.



 

 

 

Short notes 

 

1. Shutter angle 
 
2. Film Gate 
 
3. Angle of view/Focal Length 
 
4. Motion Blur 
 
5. Camera and aim 
 
 

 

9.11 Further Reading 
 

1. Introducing Autodesk Maya 2013 Dariush Derakhshani 
 
2. Learning Autodesk Maya 2009 Foundation: Official Autodesk Training .Autodesk 

Maya Press, Marc-André Guindon



 

 

 

 

Unit 10 MENTAL RAY RENDERER 
 
 
 
 

Learning Outcome 
 

After going through this unit, you will learn: 
 

• Mental Ray 

 

• HDRI 
 
• Caustic 

 
• GI  
 
 
 
 
 
 
 

 

Time Required to Complete the unit 
 

 

The time required to study thus Unit is broken as follows 
 

1. 1
st

 Reading: It will need 2 Hrs for reading a unit 
 
2. 2

nd
 Reading with understanding: It will need 3 Hrs for reading and understanding a unit 

 
3. Self Assessment: It will need 3 Hrs for reading and understanding a unit 
 
4. Revision and Further Reading: It is continuous process  
 
 
 
 
 
 
 

 

Content Map 
 

10.1 Final Gather 
 

10.2 Global Illumination with Photons 
 

10.3 HDRI 
 

10.4 Caustics 



 

 

10.5 Summary 
 

10.6Self Assessment Test 
 

10.7 Further Reading  
 
 
 
 
 
 

 

10.1 FINAL GATHER 
 

 

Final gather is a method of global illumination to create very diffuse scenes where the indirect 

illumination changes slowly. Final gathering is a technique for estimating global illumination for 

a given point by either sampling a number of directions in the hemisphere over that point, or by 

averaging a number of final gather points nearby since final gather points are too expensive to 

compute for every illuminated point. Without final gather ing, the global illumination on a 

diffuse surface is computed by estimating the photon density near that point. 

 

With final gathering, many new rays are sent out to sample the hemisphere above the point to 

determine the incident illu mination. Final gathering is useful in scenes where the indirect 

illumination varies slowly, such as purely diffuse scenes. For such scenes, final gathering 

eliminates photon map artifacts such as low frequency noise and dark corners. 

 

If you want to use Final Gather, you hav e to enable the Final Gather from the render setting for 

mental ray for Maya renderer. The options available are: 

 

1. Final Gather : Use this setting to turn Fina l gathering for global illumination on or off. 
 
 
2. Precompute Photon Lookup: This option causes photon tracing to compute and store an 

estimate of t he local irradiance at every photon location. This means that far fewer final 

gathering points are required because the photon map carried a good appro ximation of the 

irradiance in the scene—mental ray for Maya can estimate irradiance with a single lookup, 

instead of many photons. In this case, photon tracing takes longer than before and requires 

slightly more memory, but rendering is faster.



 

 

3. Final Gather Rays: This setting controls how many rays are shot in each final gathering 

step to compute the indirect illumination. 

 
4. Min Radius, Max Radius: Max Radius and Min Radius control the size of the sampling region 

within which Final Gather rays search for irradiance information from other surfaces. 

 
5. View (Radii in Pixel Size): This option causes the Min Radius and Max Radius of final 

gather rays to be calculated in pixel size , rather than in object space. This allows you to set the 

visual quality in pixel size, without knowing the object or scene bounds. 

 
6. Final Gather Scale: The Scale value allows you to easily control the intensity and color of 

the final gather contribution on a global scene level. 

 
 
 

 

10.2 Global Illumination with Photons 
 

Global Illumination works by shooting photons from lights and creates a photon map according 

to their distribution in the scene. The way that these photons are distributed is based on the 

absorption, reflectivity, and refractivity of an object. The effects of this type of rendering are 

most noticeable in the color bleeding between objects and soft diffusion of light across 

scene.Render the image with the Maya software renderer. The result is shown in Figure as per 

given below. You can save this image and use it for comparison with the Global Illumination 

rendering we are about to perform. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Now to enable Mental Ray. In the Render Settings window, choose Mental Rayfrom the



 

 

Render Using pull‐down menu. Select the Mental Ray tab. You should now be able to view the 

settings for Mental Ray, shown next. 

 

Choose Preview Global Illum for the Quality Presets setting. This turns on Global Illumination 

and sets the Sampling Quality attributes to a medium setting for faster renders. You can verify 

that Global Illumination is turned on by scrolling down to the Caustics and Global Illumination 

folder in the Render Settings window and making sure the box next to Global Illumination is 

checked. 

 

If you were to render the scene right now, it would not look different from the last image we 

rendered with the Maya software renderer. This is because the lights in the scene have to be set 

up to emit photons in order for the Global Illumination to be calculated. 

 

Select the point light in the scene (this is the only light used). In the Attribute Editor, scroll down 

and find the section named Mental Ray. In this section, click the box next to Emit Photons, as 

shown here. 

 

The Photon Intensity attribute here controls the brightness of the emitted photons. If you click 

the Render button and don’t see any Global Illumination effect, try increasing the Photon 

Intensity attribute value. 

 

The Global Illum Photons attribute sets the number of photons that will be emitted from the 

light so that Mental Ray can render the Global Illumination effect.Because the number of 

emitted photons has an impact on render times, it is best to keep this as low as possible. 

Remember that the number of photons needed to create a quality render depends on the scale, 

in Maya units, of the scene being rendered. If the scene is small, it may not take too many 

photons to fill the area being rendered. Therefore, the correct number of photons will vary 

greatly from scene to scene. 



 

 

Set the Global Illum Photons attribute to 1000. This will be enough to cover the scene with 

photons, but they will not be so finely distributed that they can’t be recognized. At this point, 

you have enabled enough controls for the renderer to make a Global Illumination calculation. 

Do a test render and view the results. 

 

Figure given below shows the teapot rendered with these settings. Notice the big, circular‐ 

shaped spots of color all over the scene. By setting the Global Illume Photons value low, the 

photons are easy to see and should give you some idea of what they are doing to bleed the 

color throughout the scene. 

 

To blend these photons in the rendered image, we will go back to the Render Settings window 

and adjust some more settings. The two attributes we will concentrate on in this step are Global 

Illum Accuracy and Global Illum Radius, shown and described here: 

 

Global Illum Accuracy 
 
 

Represents the number of photons that Mental Ray looks for within the area represented by the 

Global Illum Radius setting. It then composites what it finds, and the result is the Global 

Illumination effect. Low Global Illum Accuracy values yield grainy images, and high values give 

you smoother, more precise results but take more time to render. If you set the Accuracy value 

higher than the number of photons emitted by all the lights in the scene, your image will never 

render because the photon calculation won’t finish. 



 

 

Global Illum Radius 
 
 

The size (in Maya units) of the effect that the photon produces when it hits an object. Larger 

numbers produce bigger effects but usually less accurate results. High Radius values combined with 

low Accuracy values can give you a good approximation of what your scene will look like and are 

great for test renders. Low Radius values combined with high Accuracy values provide the most 

accurate representation of the final image but take much longer to render. A value of 0 for either of 

these attributes tells the renderer to make its best guess. In the Render Settings window, begin 

adjusting the Global Illum Accuracy attribute. Set it to 1 and notice the effect. The photons are not 

sharing any space at all. You want to increase this value until it has little or no effect—this means 

that no more photons fall within that radius. For the accuracy to have any more effect, the number 

of photons emitted from the light must be increased. A value of around 60 works well for Global 

Illum Accuracy in this scene. Adjust the Global Illum Radius attribute. Increase it until the photons 

are big enough to cover the areas evenly but are not so spotty. A value of 4.5 is good. Return to the 

light’s Attribute Editor and adjust the values for the Photon Intensity, Exponent, and the number of 

emitted photons. Increase the number of photons until they blend enough so that you can no longer 

make them out. Increase the Global Illum Photons attribute to 4500. 

 

To determine how bright the overall effect will be, use the Photon Intensity attribute. A value of 

7000 gives the walls a nice bleed from the green teapot. The scene was set up to use regular 

depth map shadows, but we need to turn shadows on in the Mental Ray Render Settings 

windows for them to render. Set the Shadow Maps to On. Figure given below shows the final 

rendered image for this scene. 



 

 

10.3 HDRI 
 

HDR Images with Final Gather 
 
 

The term “image‐based rendering” has become popular recently. It describes a type of 

rendering that uses images from the real world to calculate lighting. 

 

When we start thinking about these concepts in terms of Final Gather, image‐based rendering 

can mean that we use photographs from the real world to control the Incandescence attribute 

of our dome or irradiating surface’s material for the Final Gather render. The problem is, 

however, that a regular photograph does not have all of the information we need. We would 

need a file format that does not just record colors that are dark and bright, but one that 

understands overexposure as well. 

 

Thanks to the work and research of Paul Debevec, we have an image format that encompasses 

all of this information into a single file. This file format is called the HDRI file format. 

 

Paul Debevec’s website, at www.debevec.org/, offers a program called HDR Shop that allows 

you to create images in this file format. Images are also available on the site for download that 

can be used in Final Gather. This is what we will be working with in this section. 

 

HDRI stands for high dynamic range imagery: a normal 24‐bit image can represent brightness as only 

one of 256 levels—this means that a pixel with a brightness value of 256 (that is, white) is exactly 

twice as bright as mid‐gray (brightness of 128). While color space represents a printed image fine, it 

bears no relation to reality, where the bright sky outside your window is, in fact, many thousands of 

times brighter than the mid‐gray page in front of you, and the spot where the sun shines is probably 

millions of times brighter. By using a 32‐bit floating point number (floating point numbers are 

capable of representing enormous ranges by moving their decimal points around) to represent each 

pixel brightness for R, G, and B instead of a limited 8‐bit integer (a whole number limited to a range 

from 1 to 256), HDR images can truly represent the range of brightness found in real



 

 

life. 
 
 

This is important if you want to re‐create realistic lighting accurately using a rendering 

technique such as Final Gather. 

 

In the Render Settings window, choose Render Using Mental Ray. You should now see the 

Mental Ray Render Settings tab. Set the Quality Presets attribute to PreviewFinalGather. Scroll 

down the list of attributes and turn off Global Illumination. Then, in the Final Gather section, 

check to make sure that Final Gather is enabled. 

 

Select the light in the scene and turn its Intensity attribute all of the way down to 0. With Final 

Gather, we do not need to use any lights. Turning this down will keep Mental Ray from using the 

default lighting in the absence of any other lights .We could create a sphere, as we did in the 

previous tutorial, and then map the HDRI image to it, but instead we will use an image‐based 

lighting node. This will create a spherical environment similar to an environment sphere that we 

have used in past tutorials, except the image based lighting node has specific attributes that let 

you control the lighting in the scene when using Final Gather. To create the image‐ based 

lighting node, find the Image Based Lighting section and click the Create button. The image‐

based lighting attributes are shown in Figure given below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Open the Attribute Editor to view the attributes for the image‐based lighting node.You’ll see an 

attribute called Image Name. Click the File Browser button to browse and open any 
 
.hdri image: In the Render Settings window, find the Final Gather Rays attribute in the Final Gather 

section and set this to 200. This should provide you with a low‐quality render that is



 

 

reasonably fast. You can adjust the brightness levels of the HDR image in the Attribute Editor by 

editing the Color Gain and Color Offset attributes. You can make any adjustments to the object’s 

materials to control how they interact with the Final Gather rendering by going into each 

material’s attributes and adjusting the Irradiance Color in the Mental Ray section.. 

 
 

 

10.4 Caustics 
 

Mental ray can render with Caustics, the light effects that caused by specular reflected or 

refracted light. Examples of caustics are: 

 

• The light patterns created on the bottom of a swimming pool as light is refracted by the 

water surface and refl ected by the diffuse pool bottom. 

 
• Light being focused by a glass of water onto a diffuse table cloth. Caustics cannot be 

simulated efficiently using standard ray marching since predicting the potential specular paths 

to a light source from any given surface is a difficult task. To overcome this problem mental ray 

uses a photon map. The photon map is generated in a preprocessing step in which photons are 

emitted from the light sources and traced thr ough the scene using photon tracing. A photon 

leaving the light source can be re flected or transmitted specularly by objects. The photon is trac 

ed through the scene until it either hits a diffuse surface or until it has been reflected or 

transmitted a maximum number of times as indicated by the photon trace depth. When a 

caustic photon hits a diffuse object it is stored in a caustic pho ton map and not traced any 

further. 

 

If you want to use Caustics, you have to enable the Caustics from the render setting for mental 

ray for Maya renderer. The options available are: 

 

1. Caustics: This setting turns caustics on or off. Caustics are produced only by light 

sources for which photon emission is enabled. The material shader, which must have a non‐zero 

diffuse component, which receives the caustics, must be set to receive caustics. 

 
2. Caustic Accuracy: This setting controls the number of photons used to estimate the



 

 

caustic brightness. 
 
 

3. Caustic Radius: This setting controls the maximum distance at which mental ray for 

Maya considers photons for caustics. 

 
4. Caustic Filter Type: This setting controls the sharpness of the caustics. Filtering increases 

the we ight of photons that are close to the point of interest, and reduces the amount of blur at 

the edges of a caustic. 

 

a. Box : Box filter setting gener ally makes caustics looks sharper. It is faster, but less precise. 

 

b. Cone: Cone filter setting generally makes caustics looks smoother. It is more precise, but 

slower. 

 

5. Caustic Filter Kernel : The bigger the kernel, t he softer the caustic. 
 
 
6. Caustic Scale : Use this setting to control the influence of indirect illumination effects for 

caustics. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

10.5 Summary 
 

This chapter provided an overview of the major rendering features and workflows available to 

you in Maya. Raytracing, Global Illumination, and Final Gather can help you produce realistic 

imagery when needed. As you’ve seen here, most of these options can be enabled and 

controlled in the Render Settings window.



 

 

10.12 Self Assessment Test 
 

1. Explain HDRI 
 
2. Explain Caustic 

 

Short notes 

 

1. Global Illumnation 
 
2. Final Gather 
 
3. Caustic Radius 
 
4. GI. Photons 
 
5. Mental Ray 
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